
™ 

U
se

r’s
 G

u
id

e 
- G

SM
 D

ra
ft

Dolphin® 9500/9550 Mobile Computer
Windows® Powered Pocket PC 2002



Trademarks

Dolphin, HomeBase, Mobile Base, and QuadCharger are trademarks or registered trademarks of Hand Held Products, Inc.

Microsoft Pocket PC 2002, Windows, Windows NT, Windows 2000, Windows ME, Windows XP, ActiveSync, Outlook, and the 
Windows logo are trademarks or registered trademarks of Microsoft Corporation.

Intel is a registered trademark of Intel Corporation.  

Chapter 7 (pages 7-1–7-11) contains copyrighted information from SyChip, Inc.

Chapter 7 (pages 7-12–7-25) contains copyrighted information from Meetinghouse Corporation. Meetinghouse, the 
Meetinghouse logo, and all other Meetinghouse trademarks/service marks contained herein are trademarks or registered 
trademarks of Meetinghouse.

The Bluetooth trademarks are owned by Bluetooth SIG, Inc., U.S.A. and licensed to HHP. Chapter 8 is copyrighted information 
used by permission from Bluetooth SIG, Inc.

Information appears in Chapter 9 (9-3–9-15 and 9-17–9-22) with permission from INTRINSYC Software, Inc. 

Other product names mentioned in this manual may be trademarks or registered trademarks of their respective companies and 
are hereby acknowledged.

Disclaimer
Hand Held Products, Inc. d/b/a HHP (“HHP”) reserves the right to make changes in specifications and other information contained 
in this document without prior notice, and the reader should in all cases consult HHP to determine whether any such changes 
have been made. The information in this publication does not represent a commitment on the part of HHP.
HHP shall not be liable for technical or editorial errors or omissions contained herein; nor for incidental or consequential damages 
resulting from the furnishing, performance, or use of this material.
This document contains proprietary information that is protected by copyright. All rights are reserved. No part of this document 
may be photocopied, reproduced, or translated into another language without the prior written consent of HHP.
 2000-2003 Hand Held Products, Inc. All rights reserved.

Web Address: www.hhp.com

http://www.hhp.com
http://dcd.welchallyn.com
http://www.handheld.com


Table of Contents
Chapter 1 - Introduction

Required Safety Labels ....................................................................................................................... 1-2
Location........................................................................................................................................ 1-2
Dolphin 9500/9550 Batch Terminal............................................................................................. 1-2

Regulatory and Safety Approvals for all Dolphin 9500/9550 Terminals .......................................... 1-3
Dolphin 9500/9550 WLAN or WPAN Radio .............................................................................. 1-4
Dolphin 9500 WWAN Radio ....................................................................................................... 1-5

FCC Compliance................................................................................................................................. 1-6
Dolphin 9500/9550 Batch Terminal............................................................................................. 1-6
Dolphin 9500/9550 RF Terminal with 802.11b, Bluetooth, and/or GSM Radios ....................... 1-6
Dolphin 9500/9550 802.11b, GSM, and/or Bluetooth R&TTE Compliance Statement.............. 1-7
Pacemakers, Hearing Aids and Other Electrically Powered Devices .......................................... 1-7
Microwaves .................................................................................................................................. 1-7

Care and Cleaning of the Dolphin 9500/9550 .................................................................................... 1-7

Chapter 2 - Getting Started

Overview............................................................................................................................................. 2-1
Dolphin 9500/9550 Models and Options............................................................................................ 2-2

Image Engine Options .................................................................................................................. 2-2
Dolphin 9500/9550 Peripherals .......................................................................................................... 2-3
Dolphin 9500/9550 Accessories ......................................................................................................... 2-4
Bar Code Symbologies Supported ..................................................................................................... 2-5
Using the Dolphin 9500/9550 for the First Time................................................................................ 2-6
Resetting the Terminal...................................................................................................................... 2-12

Soft Reset (Warm Boot) ............................................................................................................. 2-12
Hard Reset (Cold Boot).............................................................................................................. 2-12

Suspend Mode................................................................................................................................... 2-12

Chapter 3 - Dolphin 9500/9550 Overview

System Features .................................................................................................................................. 3-1
Front Panel Features ........................................................................................................................... 3-2
Back Panel Features............................................................................................................................ 3-4

Dolphin 9500................................................................................................................................ 3-4
Dolphin 9550................................................................................................................................ 3-6

Side Panel Features ............................................................................................................................. 3-8
Bottom Panel Features ........................................................................................................................ 3-9

Mechanical Connector.................................................................................................................. 3-9
Dolphin® 9500/9550 Mobile Computer User’s Guide - GSM Draft  iii



Batteries ............................................................................................................................................ 3-10
Main Battery Pack ...................................................................................................................... 3-10
The Li-ion battery pack requires four hours to charge completely. ........................................... 3-10
Internal Backup Battery.............................................................................................................. 3-10
Managing Battery Power............................................................................................................ 3-11
Default Critical and Low Battery Points .................................................................................... 3-11
Setting Critical and Low Battery Points..................................................................................... 3-11
Checking Battery Power............................................................................................................. 3-12
Storing Batteries ......................................................................................................................... 3-12
Guidelines for Battery Use and Disposal ................................................................................... 3-12

Dolphin 9500/9550 Technical Specifications ................................................................................... 3-13

Chapter 4 - Using the Dolphin 9500/9550 Mobile Computer

Entering Data ...................................................................................................................................... 4-1
Today Screen ...................................................................................................................................... 4-2
Navigation Bar .................................................................................................................................... 4-3

Command Bar............................................................................................................................... 4-3
Pop-Up Menus .................................................................................................................................... 4-4
Selecting Programs ............................................................................................................................. 4-5
Imager ................................................................................................................................................. 4-6

Decoding a Bar Code ................................................................................................................... 4-6
Capturing Images ......................................................................................................................... 4-8

Using the Keyboards........................................................................................................................... 4-9
35-Key Numeric/Alpha Keyboard ............................................................................................. 4-12
43-Key Numeric/Alpha Keyboard ............................................................................................. 4-13
56-Key Alpha/Numeric Keyboard ............................................................................................. 4-14
Key Combinations ...................................................................................................................... 4-14

Adjusting the Backlight .................................................................................................................... 4-15
Color Display ............................................................................................................................. 4-15
Monochrome Display ................................................................................................................. 4-15

Communication Media Options ........................................................................................................ 4-17
Software Communication Programs .......................................................................................... 4-17

Radio Options ................................................................................................................................... 4-18
Available Radio Combinations .................................................................................................. 4-18
Radio Driver Installation ............................................................................................................ 4-18
The Radio Manager .................................................................................................................... 4-18
Powering Up a Radio ................................................................................................................. 4-19

Entering Text Using the Input Panel................................................................................................. 4-20
Using the SIP.............................................................................................................................. 4-20
Using the Letter Recognizer....................................................................................................... 4-20
Using the Block Recognizer....................................................................................................... 4-21
Selecting Text............................................................................................................................. 4-21
Input Panel Options .................................................................................................................... 4-22

Writing on the Screen ....................................................................................................................... 4-23
To Select Writing ....................................................................................................................... 4-23

Drawing on the Screen...................................................................................................................... 4-24
Selecting a Drawing ................................................................................................................... 4-24

Status Icons ....................................................................................................................................... 4-25
iv Dolphin® 9500/9550 Mobile Computer User’s Guide - GSM Draft



Notifications...................................................................................................................................... 4-25
Finding and Organizing Information ................................................................................................ 4-26

Chapter 5 - Settings

Overview............................................................................................................................................. 5-1
Personal Tab........................................................................................................................................ 5-2

Adding a Program to the Start Menu............................................................................................ 5-3
System Tab.......................................................................................................................................... 5-5

About ............................................................................................................................................ 5-5
Backlight ...................................................................................................................................... 5-6
Clock ............................................................................................................................................ 5-6
CPU Speed ................................................................................................................................... 5-6
HHP WLAN Settings ................................................................................................................... 5-7
IrDA Config ................................................................................................................................. 5-7
Memory ........................................................................................................................................ 5-8
Power.......................................................................................................................................... 5-11
Radio Manager ........................................................................................................................... 5-11
Regional Settings........................................................................................................................ 5-11
Remove Programs ...................................................................................................................... 5-13
Screen ......................................................................................................................................... 5-15

Connection Settings .......................................................................................................................... 5-16
Connections Tab......................................................................................................................... 5-17
Deleting Connections ................................................................................................................. 5-24
Creating a Custom Connection................................................................................................... 5-24
Connecting.................................................................................................................................. 5-26
Network Card Connections ........................................................................................................ 5-27

Network Adapters ............................................................................................................................. 5-28
Editing Properties ....................................................................................................................... 5-29

Chapter 6 - Communications

Overview............................................................................................................................................. 6-1
Help on Connecting...................................................................................................................... 6-1
Installing Additional Software ..................................................................................................... 6-1

Using ActiveSync ............................................................................................................................... 6-2
Capabilities ................................................................................................................................... 6-2
Requirements................................................................................................................................ 6-2
Setting Up Your Desktop Computer ............................................................................................ 6-2
Synchronizing from Your Desktop Computer ............................................................................. 6-2
Synchronizing from Your Device ................................................................................................ 6-3
Adding Programs to the Terminal Using ActiveSync.................................................................. 6-3

Using Infrared ..................................................................................................................................... 6-5
Verify That the IrDA Port is Enabled .......................................................................................... 6-5
Verify That Beam Settings Are Set to Receive ............................................................................ 6-6
Sending and Receiving Information............................................................................................. 6-6
Troubleshooting............................................................................................................................ 6-7

Using an ISP ....................................................................................................................................... 6-8
Adding Programs Directly from the Internet ............................................................................... 6-8
Dolphin® 9500/9550 Mobile Computer User’s Guide - GSM Draft  v



Chapter 7 - Wireless LAN Communications with 802.11b

Overview............................................................................................................................................. 7-1
Powering Up the 802.11b Radio Driver ....................................................................................... 7-1

Configuring the 802.11b Radio........................................................................................................... 7-2
Accessing the Configuration Utility............................................................................................. 7-2
The Configuration Utility ............................................................................................................. 7-2
Status Tab ..................................................................................................................................... 7-2
Config Tab.................................................................................................................................... 7-4
Advanced Tab............................................................................................................................... 7-9
About Tab................................................................................................................................... 7-10
The Status Icon........................................................................................................................... 7-10

Wireless Security Supplement .......................................................................................................... 7-12
Installing the AEGIS Client Software ........................................................................................ 7-12
Configuring the Pocket PC Client .............................................................................................. 7-16
Running AEGIS Client............................................................................................................... 7-17
Configuring the AEGIS Client Software.................................................................................... 7-18
Port Setting Menus ..................................................................................................................... 7-22
Port Setting Parameters .............................................................................................................. 7-24
Certificate Management ............................................................................................................. 7-25

Chapter 8 - Wireless PAN Communications with Bluetooth

Overview............................................................................................................................................. 8-1
Powering Up the Bluetooth Radio Driver .................................................................................... 8-1
Setting Up Your Bluetooth Card .................................................................................................. 8-1

Assign COM Ports .............................................................................................................................. 8-2
Discover Bluetooth Device(s)............................................................................................................. 8-3

Bond With Discovered Device(s)................................................................................................. 8-3
View Device Properties................................................................................................................ 8-5
Set Up Your Favorite Device ....................................................................................................... 8-6
Change Views............................................................................................................................... 8-6
Delete a Device From the Folder ................................................................................................. 8-7

Turn Radio Transmitter ON/OFF ....................................................................................................... 8-8
Bluetooth ActiveSync ......................................................................................................................... 8-9
Bluetooth LAN Access ..................................................................................................................... 8-11
OBEX................................................................................................................................................ 8-14

Exchange Business Cards........................................................................................................... 8-14
Send a Contact............................................................................................................................ 8-15
Send a File .................................................................................................................................. 8-16
Browse Remote Device .............................................................................................................. 8-18
 Receive Contact or File ............................................................................................................. 8-22
Enable File Sharing .................................................................................................................... 8-22

Using the Dialer ................................................................................................................................ 8-24
Get Connected Wizard ...................................................................................................................... 8-26
Dial-up to Your Network .................................................................................................................. 8-29
vi Dolphin® 9500/9550 Mobile Computer User’s Guide - GSM Draft



Chapter 9 - Wireless WAN Communications with GSM/GPRS

Overview............................................................................................................................................. 9-1
Powering Up the GSM/GPRS Radio Driver ................................................................................ 9-1
Capabilities ................................................................................................................................... 9-1
Tri-Band Antenna......................................................................................................................... 9-1
Requirements................................................................................................................................ 9-1

SIM Card Installation.......................................................................................................................... 9-2
Using uPhone ...................................................................................................................................... 9-3

Accessing uPhone......................................................................................................................... 9-3
Phone Status ................................................................................................................................. 9-3
Bubble Dialogs ............................................................................................................................. 9-4

Using the Dialler ................................................................................................................................. 9-5
Making a Call ............................................................................................................................... 9-5
Receiving a Call ........................................................................................................................... 9-6
Ending a Call ................................................................................................................................ 9-6
Touchtones ................................................................................................................................... 9-7
Volume Control ............................................................................................................................ 9-7
Tools Menu................................................................................................................................... 9-7
Settings Menu............................................................................................................................... 9-8

Audio Modes....................................................................................................................................... 9-9
Handset ......................................................................................................................................... 9-9
Headset ......................................................................................................................................... 9-9
Hands-Free ................................................................................................................................... 9-9

Ringtone Configuration .................................................................................................................... 9-10
Accessing Ringtone Configuration ............................................................................................ 9-10
WAV Files.................................................................................................................................. 9-10
Previewing Tones ....................................................................................................................... 9-10

Call Log ............................................................................................................................................ 9-11
Opening the Call Log ................................................................................................................. 9-11
Call Log Options ........................................................................................................................ 9-12
Tools Menu................................................................................................................................. 9-12

SMS Manager ................................................................................................................................... 9-13
Opening the SMS Manager ........................................................................................................ 9-13
Sending an SMS Message .......................................................................................................... 9-14

Online Help ....................................................................................................................................... 9-15
GPRS Settings................................................................................................................................... 9-16

To Select Pre-Configured GPRS Settings .................................................................................. 9-16
To Add a GPRS Setting.............................................................................................................. 9-17
GPRS Connection....................................................................................................................... 9-17

Establishing GPRS Internet Settings ................................................................................................ 9-19
Dolphin® 9500/9550 Mobile Computer User’s Guide - GSM Draft  vii



Chapter 10 - Applications

Calendar: Scheduling Appointments and Meetings.......................................................................... 10-1
Using the Summary Screen ........................................................................................................ 10-3
Creating Meeting Requests ........................................................................................................ 10-3

Contacts............................................................................................................................................. 10-4
Using the Summary Screen ........................................................................................................ 10-6

Tasks ................................................................................................................................................. 10-7
Using the Summary Screen ........................................................................................................ 10-9

Notes ............................................................................................................................................... 10-10
Inbox ............................................................................................................................................... 10-12

Synchronizing E-mail Messages .............................................................................................. 10-12
Connecting Directly to an E-mail Server ................................................................................. 10-12
Using the Message List ............................................................................................................ 10-13
Composing Messages ............................................................................................................... 10-15
Managing E-mail Messages and Folders.................................................................................. 10-15
Folder Behavior with a Direct Connection to an E-mail Server .............................................. 10-16

Pocket Internet Explorer ................................................................................................................. 10-17
Accessing Pocket Internet Explorer ......................................................................................... 10-17
Browse the Internet on Your Terminal..................................................................................... 10-17
The Mobile Favorites Folder .................................................................................................... 10-18
Creating and Synchronizing Mobile Favorites......................................................................... 10-18
Using AvantGo® Channels ....................................................................................................... 10-19

Companion Programs...................................................................................................................... 10-21
Pocket Word.................................................................................................................................... 10-21

Using Pocket Word .................................................................................................................. 10-21
Typing Mode ............................................................................................................................ 10-22
Writing Mode ........................................................................................................................... 10-23
Drawing Mode.......................................................................................................................... 10-24

Pocket Excel.................................................................................................................................... 10-25
Tips for Working in Pocket Excel ............................................................................................ 10-25

Chapter 11 - Dolphin 9500/9550 HomeBase

Overview........................................................................................................................................... 11-1
Dolphin 9500/9550 HomeBase Parts and Functions ........................................................................ 11-2

Front Panel ................................................................................................................................ 11-2
Rear Panel .................................................................................................................................. 11-4

HomeBase Serial Connector ............................................................................................................. 11-5
Powering the HomeBase................................................................................................................... 11-6
Charging the Main Battery................................................................................................................ 11-7

To Power a Terminal and Charge its Main Battery.................................................................... 11-7
Charging a Spare Battery Using the Auxiliary Battery Well ..................................................... 11-7
viii Dolphin® 9500/9550 Mobile Computer User’s Guide - GSM Draft



Communications ............................................................................................................................... 11-8
Communications Types .............................................................................................................. 11-8
Equipment Requirements ........................................................................................................... 11-8
Setting up the HomeBase for RS-232 Communications ............................................................ 11-8
Setting up the HomeBase for USB Communication ................................................................ 11-10
Communicating with the Dolphin 9500/9550 Terminal .......................................................... 11-12
Verifying Communication........................................................................................................ 11-12
Verifying Data Transfer ........................................................................................................... 11-12

Mounting the HomeBase ................................................................................................................ 11-13
Desk Mounting ......................................................................................................................... 11-13
Wall Mounting ......................................................................................................................... 11-14

Chapter 12 - Dolphin 9500/9550 Mobile Base

Overview........................................................................................................................................... 12-1
Mobile Base Parts and Functions...................................................................................................... 12-2

Front Panel ................................................................................................................................. 12-2
Bottom Panel .............................................................................................................................. 12-3

Powering the Dolphin Terminal........................................................................................................ 12-4
Charging the Dolphin Terminal ................................................................................................. 12-4

Installing the Dolphin Mobile Base .................................................................................................. 12-5
Mounting the Mobile Base ......................................................................................................... 12-5
Powering the Dolphin Mobile Base ........................................................................................... 12-6

Setting the Mobile Base Up for Communications ............................................................................ 12-7
Connecting the Cables................................................................................................................ 12-7
Mobile Base Serial Connector.................................................................................................... 12-8
Configuring the Dolphin Terminal............................................................................................. 12-8

Chapter 13 - Dolphin 9500/9550 ChargeBase

Overview........................................................................................................................................... 13-1
Dolphin ChargeBase Parts and Functions......................................................................................... 13-2

Front Panel ................................................................................................................................ 13-2
Back Panel .................................................................................................................................. 13-2
Power Supply ............................................................................................................................. 13-3

Supplying Power to the ChargeBase................................................................................................. 13-3
Inserting and Removing Terminals................................................................................................... 13-4

Inserting...................................................................................................................................... 13-4
Removing ................................................................................................................................... 13-4

Charging Terminals in the ChargeBase ............................................................................................ 13-5
Mounting the ChargeBase................................................................................................................. 13-6

Bottom Panel .............................................................................................................................. 13-6
Using the DIN Rail..................................................................................................................... 13-6
Using the Mounting Brackets..................................................................................................... 13-8
Dolphin® 9500/9550 Mobile Computer User’s Guide - GSM Draft  ix



Chapter 14 - Dolphin 9500/9550 QuadCharger

Overview........................................................................................................................................... 14-1
Dolphin QuadCharger Parts and Functions ...................................................................................... 14-1

Front Panel ................................................................................................................................ 14-1
Rear Panel................................................................................................................................... 14-2

Supplying Power to the QuadCharger .............................................................................................. 14-3
Inserting and Removing Battery Packs............................................................................................. 14-3

Storing Batteries ......................................................................................................................... 14-3
Charging Batteries in the QuadCharger ............................................................................................ 14-3
Using the Battery Analyzer............................................................................................................... 14-4

To Analyze a Battery.................................................................................................................. 14-4
Mounting the QuadCharger .............................................................................................................. 14-5
Troubleshooting ................................................................................................................................ 14-6

Chapter 15 - Warranty, Support, and Service

Limited Warranty.............................................................................................................................. 15-1
How to Extend Your Warranty .................................................................................................. 15-1

Return Information............................................................................................................................ 15-2
Calling for an RMA Number...................................................................................................... 15-2
Service and Repair Locations..................................................................................................... 15-2
Shipping...................................................................................................................................... 15-2
Repair ......................................................................................................................................... 15-2

Technical Assistance......................................................................................................................... 15-3
Assistance Online ....................................................................................................................... 15-3
FTP Server.................................................................................................................................. 15-3

 Appendix A - Keyboards 

Overview............................................................................................................................................ A-1
General Windows Keyboard Shortcuts ....................................................................................... A-1

43-Key Alpha/Numeric Keyboard   .................................................................................................. A-2
Blue Key Functions and Characters ............................................................................................ A-2
Red Key Functions and Characters ............................................................................................. A-3
Key Combinations ....................................................................................................................... A-3

35 Key Numeric/Alpha Keyboard ..................................................................................................... A-5
Blue Key Functions and Characters  .......................................................................................... A-5
Key Combinations ....................................................................................................................... A-6

56 Key Full Alpha Numeric............................................................................................................... A-7
Key Combinations ....................................................................................................................... A-9

Com Port Assignment Table ........................................................................................................... A-10
x Dolphin® 9500/9550 Mobile Computer User’s Guide - GSM Draft



1

D

Introduction
Congratulations on the Purchase of Your New Dolphin 9500 or Dolphin 9550 Mobile Computer! 

You have made a wise choice in selecting the Dolphin, a device known worldwide for its ergonomic form factor, light-weight, 
rugged design and single-handed data collection capabilities. 

Ergonomics 

The patented shape of the Dolphin 9500 fits into either hand comfortably with major function keys that are easy to access. The 
hand strap on the back panel ensures a secure grip enabling true, one-handed operation. The integrated pistol-grip handle on 
the Dolphin 9550 provides intuitive point-and-shoot scanning over extended periods of use. 

Rugged Design

Dolphin 9500/9550 terminals are the most durable mobile computers on the market. Their rugged design can withstand repeated 
five-foot drops onto a concrete floor, extreme temperatures, and high humidity, moisture, and dust conditions. The terminals are 
independently 

 to meet IP64 specifications.

Mobile Computing

Built to last, the Dolphin’s durably built case houses 

• A low-power, high-resolution digital image engine for omni-directional and auto-discrimination decoding of linear bar codes

• Co-located and integrated 802.11b and BluetoothTM wireless radios for real-time data collection applications (optional)

• An Intel® X-Scale 400MHz RISC microprocessor for fast processing

• A Microsoft® Windows® for Pocket PC platform that is easily programmable with standard programming tools
• 64 MB RAM and 32 MB FLASH memory configuration for ample and secure data storage
• An optional Secure Digital (SD) memory interface for additional memory capabilities 

You can also install custom software applications, making the Dolphin 9500/9550 the ultimate mobile data collection solution for 
your enterprise needs.

Additional Features

The Dolphin 9500/9550 features: 

• Long-lasting Lithium Ion (Li-ion) batteries
• A large, easy-to-read 1/4 VGA (240 x 320) color or monochrome backlit touch screen that can display text or graphics 
• Three keyboard options 
• An industrial connector that supports both serial and USB communications as well as power out to peripheral devices
• A full suite of compatible peripheral devices
• Decoding of stacked linear and matrix codes
• Digital picture capability
• Optical Character Recognition (OCR) functionality

Application Development Tools

• Dolphin SDK for Pocket PC 2002 with embedded VB or C++
• Dolphin.NET SDK for Pocket PC 2002 with Visual Studio.NET 2003

This User’s Guide

The Dolphin 9500/9550 Mobile Computer User’s Guide is designed to provide you with the information you need to make the 
most of your Dolphin terminal. Sections on the basics, safety, battery use, accessories, and service make this guide a complete 
source of information.
olphin® 9500/9550 Mobile Computer User’s Guide - GSM Draft 1 - 1
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Required Safety Labels

The Dolphin 9500/9550 mobile computer meets or exceeds the requirements of all applicable standards organizations for safe 
operation. However, as with any electrical equipment, the best way to ensure safe operation is to operate them according to the  
agency guidelines that follow. Please read these guidelines carefully before using your Dolphin mobile computer.

Location
Safety labels appear on the back panel of both terminals. On the Dolphin 9500 units, the required information is contained in the 
label. On the Dolphin 9550, some required information is embedded in the plastic and the rest is in the label. 

Dolphin 9500/9550 Batch Terminal 
The following are the required safety labels for batch terminals that appear on the back panel: 

Dolphin 9500 Dolphin 9550

Dolphin 9500 Dolphin 9550

Safety labels appear here. Safety information is   
embedded in the plastic 

Safety labels 
appear here.

 DRAWINGS AND SPECIFICATIONS ARE THE PROPERTY AND CONFIDENTIAL
IAL OF HAND HELD PRODUCTS, INC. AND SHALL NOT BE
DUCED, OR COPIED, OR USED AS A BASIS FOR MANUFACTURE OR SALE
IPMENT OR DEVICES WITHOUT WRITTEN PERMISSION.  c REV# REV DESCRIP

Tested to Comply With FCC Standards
This Class B Digital apparatus complies with 

FOR HOME OR OFFICE USE

Canadian ICES-003. Cet appariel numerique de la 
Classe B est conforme a la norme NMB-003 du Canada.

N10410

Hand Held Products, Inc.
Skaneateles Falls, NY                

Made in USA of US & imported parts.

No user serviceable parts.

Opening Voids Warranty.

www.hhp.com

THESE DRAWINGS AND SPECIFICATIONS ARE THE PROPERTY AND CONFIDE
MATERIAL OF HAND HELD PRODUCTS, INC. AND SHALL NOT BE
REPRODUCED, OR COPIED, OR USED AS A BASIS FOR MANUFACTURE OR SAL
OF EQUIPMENT OR DEVICES WITHOUT WRITTEN PERMISSION.  c 

N10410
Hand Held Products, Inc.      www.hhp.com
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Regulatory and Safety Approvals for all Dolphin 9500/9550 Terminals 

The CE Mark on the product indicates that the system has been tested to and conforms with the provisions noted within 
the 89/336/EEC Electromagnetic Compatibility Directive and the 73/23/EEC Low Voltage Directive.

For further information, please contact:

Hand Held Products, Inc.
Nijverheidsweg 9
5627 BT Eindhoven
The Netherlands

HHP shall not be liable for use of our product with equipment (i.e., power supplies, personal computers, etc.) that is not CE 
marked and does not comply with the Low Voltage Directive.

Parameter Specification

U.S.A
Canada
European Community

FCC Part 15, Class B
ICES-003
EN 55022 (CISPR 22) Class B
EN60950
EN60825-1
EN55024: 1998
Dolphin® 9500/9550 Mobile Computer User’s Guide - GSM Draft 1 - 3
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Dolphin 9500/9550 WLAN or WPAN Radio
The Dolphin® 9500/9550 RF terminal is designed to comply with the most current applicable standards on safe levels of RF 
energy developed by the Institute of Electrical and Electronics Engineers (IEEE) and the American National Standards Institute 
(ANSI) and has been recommended for adoption by the Federal Communications Commission (FCC). 

802.11b

The following is the required safety label that appears on the back panel of Dolphin RF terminals equipped with an 802.11b radio: 

Bluetooth

The following is the required safety label that appears on the back panel of Dolphin RF terminals equipped with a Bluetooth radio: 

802.11b and Bluetooth

The following is the required safety label that appears on the back panel of the RF terminals equipped with an 802.11b and a 
Bluetooth radio combination: 

Dolphin 9500 Dolphin 9550

Dolphin 9500 Dolphin 9550

Dolphin 9500 Dolphin 9550
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Tested to Comply With FCC Standards
This Class B Digital apparatus complies with 

FOR HOME OR OFFICE USE

Canadian ICES-003. Cet appariel numerique de la
Classe B est conforme a la norme NMB-003 du Canada.

Hand Held Products, Inc.           www.hhp.com

Made in USA of US & 
imported parts.

No user serviceable parts.

Opening Voids Warranty.0681 !

Canada: 1693B9503

FCC ID: HD5950003

!
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Tested to Comply With FCC Standards
This Class B Digital apparatus complies with Canadian

FOR HOME OR OFFICE USE

ICES-003. Cet appariel numerique de la Classe B est conforme a la 
norme NMB-003 du Canada.

Hand Held Products, Inc.

Made in USA of US & imported parts.

No user serviceable parts. Opening Voids Warranty.
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Tested to Comply With FCC Standards
This Class B Digital apparatus complies with 

FOR HOME OR OFFICE USE

Canadian ICES-003. Cet appariel numerique de la
Classe B est conforme a la norme NMB-003 du Canada.

Hand Held Products, Inc.

Made in USA
of US &
imported parts.

No user
serviceable
parts.

Opening Voids 
Warranty.
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FCC ID: HD5950006

www.hhp.com

THESE DRAWINGS AND SPECIFICATIONS ARE THE PROPERTY AND CONFIDE
MATERIAL OF HAND HELD PRODUCTS, INC. AND SHALL NOT BE
REPRODUCED, OR COPIED, OR USED AS A BASIS FOR MANUFACTURE OR SAL
OF EQUIPMENT OR DEVICES WITHOUT WRITTEN PERMISSION.  c 

Canada: 1693B9506FCC ID: HD5950006    

!0681
N10410 Hand Held Products, Inc.

www.hhp.com
1 - 4 Dolphin® 9500/9550 Mobile Computer User’s Guide - GSM Draft

 

  
 

ARTWORK 

LEVEL 

  TITLE:

 

A
DRAWING NO:   REV

  
SCALE  

DO NOT SCALE       SHEET 1  OF 1

ARTWORK 

LEVEL 

A
DRAWING NO:   REV

  
SCALE  

DO NOT SCALE       SHEET 1  OF 1

 

  
 

DESIGNED BY                DATE

ARTWORK 

LEVEL 

  TITLE:

 

A
DRAWING NO:   REV

  
SCALE  

DO NOT SCALE       SHEET 1  OF 1

!
DESIGNED BY                DATE

ARTWORK 

LEVEL 

  TITLE:

 

A
DRAWING NO:   REV

  
SCALE  

DO NOT SCALE       SHEET 1  OF 1

!



 

  
 

 
REV# REV DESCRIPTION

DESIGNED BY                DATE

ARTWORK 

LEVEL 

  TITLE:

 

A
DRAWING NO:   REV

  
SCALE  

DO NOT SCALE       SHEET 1  OF 1

DRAWING NO.         

DATE        

 
ECN#

 

 
REV# REV DESCRIPTION

DESIGNED BY                DATE

  TITLE:

 

DRAWING NO.         

DATE        

 
ECN#

 
REV# REV DESCRIPTION

DRAWING NO.         

DATE        

 
ECN#

 
REV# REV DESCRIPTION

DRAWING NO.         

DATE        

 
ECN#
Dolphin 9500 WWAN Radio
The Dolphin 9500 RF terminal is designed to comply with the most current applicable standards on safe levels of RF energy 
developed by the Institute of Electrical and Electronics Engineers (IEEE) and the American National Standards Institute (ANSI) 
and has been recommended for adoption by the Federal Communications Commission (FCC).

GSM

The following is the required safety label that appears on the back panel of Dolphin 9500 terminals equipped with a GSM radio: 

GSM and 802.11b

The following is the required safety label that appears on the back panel of Dolphin 9500 terminals equipped with a GSM and 
802.11b radio combination:

GSM and Bluetooth

The following is the required safety label that appears on the back panel of Dolphin 9500 terminals equipped with a GSM  and 
Bluetooth radio combination: 

GSM, Bluetooth, and 802.11b

The following is the required safety label that appears on the back panel of Dolphin 9500 terminals equipped with a GSM, 
Bluetooth, and 802.11b radio combination:

THESE DRAWINGS AND SPECIFICATIONS ARE THE PROPERTY AND CONFIDENTIAL
MATERIAL OF HAND HELD PRODUCTS, INC. AND SHALL NOT BE
REPRODUCED, OR COPIED, OR USED AS A BASIS FOR MANUFACTURE OR SALE
OF EQUIPMENT OR DEVICES WITHOUT WRITTEN PERMISSION.  c 

N10410

Tested to Comply With FCC Standards
This Class B Digital apparatus complies with 

FOR HOME OR OFFICE USE

Canadian ICES-003. Cet appariel numerique de la
Classe B est conforme a la norme NMB-003 du Canada.

Hand Held Products, Inc.           www.hhp.com

Made in USA of US & 
imported parts.

No user serviceable parts.

Opening Voids Warranty.0168
Canada: 1693B9505

FCC ID: HD5950005
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REPRODUCED, OR COPIED, OR USED AS A BASIS FOR MANUFACTURE OR SALE
OF EQUIPMENT OR DEVICES WITHOUT WRITTEN PERMISSION.  c 

N10410

Tested to Comply With FCC Standards
This Class B Digital apparatus complies with 

FOR HOME OR OFFICE USE

Canadian ICES-003. Cet appariel numerique de la
Classe B est conforme a la norme NMB-003 du Canada.

Hand Held Products, Inc.           www.hhp.com

Made in USA of US & 
imported parts.

No user serviceable parts.

Opening Voids Warranty.0168 !

Canada: 1693B9507

FCC ID: HD5950007
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N10410

Tested to Comply With FCC Standards
This Class B Digital apparatus complies with 

FOR HOME OR OFFICE USE

Canadian ICES-003. Cet appariel numerique de la
Classe B est conforme a la norme NMB-003 du Canada.

Hand Held Products, Inc.

Made in USA
of US &
imported parts.

No user
serviceable
parts.

Opening Voids 
Warranty.
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Canada: 1693B9508

FCC ID: HD5950008
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N10410

Tested to Comply With FCC Standards
This Class B Digital apparatus complies with 

FOR HOME OR OFFICE USE

Canadian ICES-003. Cet appariel numerique de la
Classe B est conforme a la norme NMB-003 du Canada.

Hand Held Products, Inc.

Made in USA
of US &
imported parts.

No user
serviceable
parts.

Opening Voids 
Warranty.

0168 !

Canada: 1693B9509

FCC ID: HD5950009
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FCC Compliance 

Dolphin mobile computers meet or exceed all applicable standards and have been manufactured to the highest level of quality.

Dolphin 9500/9550 Batch Terminal
Dolphin 9500/9550 Batch terminals comply with part 15 of the FCC rules. Operation is subject to the following two conditions:

1. This device may not cause harmful interference.

2. This device must accept any interference received, including interference that may cause undesired operation.

Dolphin 9500/9550 RF Terminal with 802.11b, Bluetooth, and/or GSM Radios
This device complies with Part 15 of the FCC Rules. Operation is subject to the following two conditions: 

1. This device may not cause harmful interference.

2. This device must accept any interference received, including interference that may cause undesired operation.

This equipment has been tested and found to comply with the limits for a Class B digital device pursuant to Part 15 of the FCC 
Rules. These limits are designed to provide reasonable protection against harmful interference in a residential installation. This 
equipment generates, uses, and can radiate radio frequency energy and, if not installed and used in accordance with the 
instructions, may cause harmful interference to radio communications. If this equipment does cause harmful interference to radio 
or television reception, which can be determined by turning the equipment off and on, the user is encouraged to try to correct the 
interference by one or more of the following measures:

• Reorient or relocate the receiving antenna.
• Increase the separation between the equipment and receiver.
• Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
• Consult the dealer or an experienced radio/TV technician for help.

If necessary, the user should consult the dealer or an experienced radio/television technician for additional suggestions. The user 
may find the following booklet helpful: “Something About Interference.” This is available at FCC local regional offices. Our 
company is not responsible for any radio or television interference caused by unauthorized modifications of this equipment or the 
substitution or attachment of connecting cables and equipment other than those specified by our company. The correction is the 
responsibility of the user. Use only shielded data cables with this system.

In accordance with FCC 15.21, changes or modifications not expressly approved by the party responsible for compliance could 
void the user’s authority to operate the equipment.

Note: Dolphin 9550 terminals do not support GSM radios.

This device and its antenna must not be co-located or operating in conjunction with any other antenna or 
transmitter. To maintain compliance with FCC RF exposure guidelines for body-worn operation, do not use 
accessories that contain metallic components and ensure that the terminal is at least 15mm (0.6 inches) from 
the body. 

Canadian Compliance
This Class B digital apparatus complies with Canadian ICES-003. Operation is subject to the following two conditions: 

1. This device may not cause harmful interference. 

2. This device must accept any interference received, including interference that may cause undesired operation. 

To prevent radio interference to the licensed service, this device is intended to be operated indoors and away from windows to 
provide maximum shielding. Equipment (or its transmit antenna) that is installed outdoors is subject to licensing.

Cet appareil numérique de la Classe B est conforme à la norme NMB-003 du Canada.

!
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RF, Regulatory, and Safety Agency Approvals 

Dolphin 9500/9550 802.11b, GSM, and/or Bluetooth R&TTE Compliance Statement
The HHP Dolphin 9500RF and Dolphin 9550RF are in conformity with all essential requirements of the R&TTE Directive (1999/
5/EC). This equipment has been assessed to the following standards:

This product is marked with   in accordance with the Class II product requirements specified in the R&TTE 
Directive, 1999/5/EC.

The equipment is intended for use throughout the European Community. Its authorization for use in France is restricted as 
follows:

PAN European Frequency Range: 2.402 - 2.480 GHz

Restricted Frequency Range for use in France: 2.448 - 2.480 GHz

Note: Dolphin 9550 terminals do not support GSM radios.

Pacemakers, Hearing Aids and Other Electrically Powered Devices
Most manufacturers of medical devices adhere to the IEC 601-1-2 standard. This standard requires devices to operate properly 
in an EM Field with a strength of 3V/m over a frequency range of 26 to 1000MHz. 

The maximum allowable field strength emitted by the Dolphin is 0.3V/m according to Subpart B of Part 1 of the FCC rules. 
Therefore, the Dolphin RF has no effect on medical devices that meet the IEC specification. 

Microwaves
The radio in the Dolphin RF terminal operates on the same frequency band as a microwave oven. Therefore, if you use a 
microwave within range of the Dolphin RF terminal you may notice performance degradation in your wireless network. However, 
both your microwave and your wireless network will continue to function.

The Dolphin Batch terminal does not contain a radio, and therefore, is not affected by microwave ovens.

Care and Cleaning of the Dolphin 9500/9550

When needed, clean the image engine window and the LCD display with a clean, non-abrasive, lint-free cloth. The terminal can 
be cleaned with a damp cloth.

Parameter Specification

RF Approvals

U.S.A
Canada
Europe
Mexico

FCC Part 15.247
RSS 210 
ETS 300 328 
Telecom RCPHAD002-485

Parameter Specification

R&TTE EN 300 328-2:2000
EN 301 489-1 (August 2000)
EN 301 489-17 (Sept. 2000)
EN 60950: 1992 Incl Amdt 1-4,11
EN 50361: 2001
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Getting Started
Overview

The Dolphin 9500/9550 mobile computer is designed for easy, single-handed mobile data collection. Each mobile computer is 
equipped with a PXA255 400MHz RISC processor built to run the Pocket PC platform.

Dolphin 9500/9550 computers are available with different types of 2D imagers and wireless radios to meet most any enterprise 
mobile data collection requirement. There are three keyboard options and a 240 x 320 pixel, backlit 1/4 VGA display available in 
color or monochrome. 

The Dolphin 9500/9550 platform contains an integrated imager that can take digital images such as shipping manifests and 
recipient signatures in addition to decoding standard linear and two-dimensional symbologies. 

Adapting the Dolphin to Your environment

The Dolphin 9500/9550 comprises one element of an enterprise data collection system that includes various models, peripherals, 
and accessories that you can combine to suit your exact needs. 
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Dolphin 9500/9550 Models and Options

HHP’s family of Dolphin 9500/9550 mobile data collection terminals includes these models:

The Dolphin 9500 Batch  

This is a Pocket PC mobile computer with a unique, ergonomic shape designed for single-handed use. The standard Dolphin 
9500 is available with 64 MB RAM and 32 MB non-volatile Flash and integrated digital imager. An optional Secure Digital (SD) 
memory interface offers additional memory. The industrial, mechanical connector supports serial RS-232 up to 115 Kbps and 
USB communications at 12 Mbps. It also features an IrDA infrared port to communicate data to portable printers and IrDA 
compliant devices.

The Dolphin 9550 Batch 

This mobile computer offers the same enhanced productivity features of the Dolphin 9500 terminal with the added convenience 
of an integrated pistol grip-style form factor for high volume scanning applications. 

The Dolphin 9500/9550 WLAN (802.11b)

These terminals integrate the basic functionality of the Batch terminals with the choice of an integrated 802.11b direct sequence 
radio that allows the terminal to communicate with a host computer through a wireless local area network (WLAN).

The Dolphin 9500/9550 WPAN (Bluetooth)

This terminal allows Bluetooth communications to Bluetooth enabled devices such as printers, mobile phones, access points, 
Bluetooth-enabled PCs, etc. 

The Dolphin 9500/9550 WLAN and WPAN (802.11b and Bluetooth)

This terminal features the capabilities of both 802.11b and Bluetooth configurations.

Image Engine Options 
Dolphin 9500/9550 terminals may be equipped with one of the following: 

• IMAGETEAM™ 4100SR: red or green aimer option scans from 2.5 to 12.5 in. (6.3 to 32 cm.) 
• IMAGETEAM™ 4100SF: red or green aimer option scans from 2.1 to 8.9 in. (5 to 22.6 cm.)   

Specifications are for 100% UPC Code.
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Dolphin 9500/9550 Peripherals 

Each of the following items is sold separately to enhance your Dolphin 9500/9550 terminals capabilities. 

Dolphin HomeBase™

The Dolphin HomeBase charging and communication cradle supports both RS-232 and USB communications, which 
enable it to interface with the majority of PC-based enterprise systems. When a terminal is seated in the HomeBase, its 
main battery pack charges in less that four hours. In addition, the HomeBase contains an auxiliary battery well that 
charges a spare Li-ion battery. 

For more information, see Dolphin 9500/9550 HomeBase on page 11-1.

Dolphin Mobile Base 

The Dolphin Mobile Base charging and communication cradle is designed specifically for in-premise and in-transit data 
collection applications. It features a flexible mounting bracket, a cigarette lighter adapter, and power cable to adapt it to 
your environment. 

When a terminal is seated in the Mobile Base, its main battery pack charges in less that four hours. The serial connector 
supports RS-232 communication and power out to peripheral devices, such as hand held scanners.

For more information, see Dolphin 9500/9550 Mobile Base on page 12-1.

Dolphin ChargeBase

The Dolphin ChargeBase is a four-slot charging cradle that holds, powers, and charges a terminal in each slot.

For more information, see Dolphin 9500/9550 ChargeBase on page 13-1.

Dolphin Net Base

The Dolphin Net Base is a four-slot charging/communication cradle that holds, powers, charges, and communicates 
with the terminal in each slot. Communications occurs via Ethernet and dynamically-assigned IP addresses. 

For more information about the Dolphin Net Base, please consult the Dolphin 9500/9550 Net Base Quick Start Guide. 

Dolphin QuadCharger™ 

The Dolphin QuadCharger is a four-slot charging station for Dolphin Li-ion battery packs. It can charge each battery in 
less than four hours. The fourth slot features a battery analyzer that completely resets and re-calibrates a battery and 
displays its resulting capacity.

For more information, see Dolphin 9500/9550 QuadCharger on page 14-1. 
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Dolphin 9500/9550 Accessories

Each of the following items is sold separately to enhance your Dolphin 9500/9550 terminals capabilities.

Charging/Communication Cables  

USB and serial cables connect the Dolphin 9500/9550 directly to both a peripheral device for communication and a 
power source for charging.

Dolphin Mobile Charger  

This charging cable plugs the terminal directly into a vehicle cigarette lighter/power port to power the terminal and 
charge the battery pack. This accessory converts the 12 Volts out of the vehicle to the 9 Volts required by the terminal.

Protective Enclosure

This enclosure wraps around the terminal to protect it from wear and tear.

Protective Holster

The protective holster secures the terminal for mobile use.

Dolphin Mobile Mount

The Dolphin Mobile Mount solution secures the Dolphin 9500 computers in place in the cab of any vehicle. Used in 
conjunction with the Mobile Charger, Dolphin terminals can be adapted to almost any in-transit environment.

Li-ion Battery Pack  

The 7.4v, 14.8 watt hour Li-ion rechargeable battery pack provides the main power supply for Dolphin 9500/9550 
terminals. 
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Bar Code Symbologies Supported 
Symbology type Symbologies supported

1D Symbologies Codabar 

Code 3 of 9

Code 11

Code 32 Pharmaceutical (PARAF) 

Code 93 

Code 128 

EAN with Add-On and EAN with Extended Coupon Code 

EAN-13 

Interleaved 2 or 5 

Matrix 2 of 5 

Plessey 

PosiCode

RSS 

Straight 2 of 5 IATA

Straight 2 of 5 Industrial

Telepen 

Trioptic Code

UCC/EAN-128

UPC and UPC-A

2D Symbologies Aztec

Code 16K

Composite

Data Matrix

MaxiCode

OCR

PDF417

QR

RSS 

Composite Codes Aztec Mesa

Codablock F

EAN·UCC

RSS-14

OCR Codes OCR A and OCR B

Postal Codes Postnet and most international 4 state codes 

Australian Post

British Post

Canadian Post

China Post 

Japanese Post

KIX (Netherlands) Post 

Korea Post

Planet Code
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Using the Dolphin 9500/9550 for the First Time

Step 1. Unpack the Carton and Verify its Contents
Verify that the carton contains the following items: 

• Dolphin 9500/9550 mobile computer (the terminal)
• Main battery pack (7.4v Li-Ion)
• Microsoft Companion CD
• Dolphin 9500 Quick Start Guide

Be sure to keep the original packaging in the event that the Dolphin terminal should need to be returned for service. For details, 
see Return Information on page 15-2. 

Each order includes a Dolphin Software Development Kit and User’s Guide CD; verify that you received this CD with your order. 
If you ordered accessories for your terminals, verify that they are also included with the order.

The Dolphin 9500 Handstrap
The Dolphin 9500 ships with the handstrap installed and fastened with a clip on the bottom 
panel; see Bottom Panel Features on page 3-9. To install the battery pack, you must 
detach the handstrap.

To detach the handstrap, push the clip of the handstrap down and away from the terminal. 
Move the strap up and away from the bottom panel.

To re-attach the handstrap, slide the clip back into place on the bottom panel.

Step 2. Install the Main Battery Pack
Use only the Li-ion battery packs provided by HHP. The use of any battery 
pack not sold/manufactured by HHP in the Dolphin 9500/9550 terminal will 
void your warranty and may result in damage to the Dolphin terminal or 
battery. 

1. Unpack the Li-ion battery pack. Hold the terminal with the front panel (keyboard) 
facing down. On the Dolphin 9500, detach the handstrap.

2. Take the battery and insert the end without the locking tab into the top of the battery 
well and push down with a hinging motion until the locking tab snaps. 

3. On the Dolphin 9500, re-attach the handstrap. 

To Remove the Main Battery Pack 

1. Detach the handstrap (on the 9500).

2. Press the locking tab on the battery pack away from the bottom panel, and pull the 
battery pack up with a hinging motion.

Step 3. Charge the Main and Backup Batteries
The power supply for the Dolphin mobile computer consists of two types of battery power: the main battery pack installed on the 
back panel and the backup battery that resides inside the terminal. 

The main battery powers the terminal. The internal backup battery charges off the main battery and maintains the application 
data stored in RAM and system clock for up to 30 minutes when the terminal’s main battery pack is completely discharged or 
removed. 

Before initial use - The terminals are shipped with both batteries discharged of all power. Charge the main battery pack for a 
minimum of four hours before initial use. 

When installed in the terminal, the battery pack can be charged in the HomeBase, Mobile Base, or with the appropriate charging 
cable. When not installed in the terminal, battery packs can be charged in the QuadCharger or the auxiliary well of the 
HomeBase.

Time to Charge - Four hours for the main battery pack, eight hours for the internal backup battery the first time.

Clip

Handstrap

!
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Use only Dolphin 9500 series peripherals, power cables, and power adapters. Use of peripherals, cables, or power 
adapters not sold/manufactured by HHP will void the warranty and may damage the terminal. 

Using the Dolphin HomeBase

1. Connect the HomeBase to the power supply provided by HHP.

2. Slide the terminal (with installed battery pack) into the terminal well until the Dock LED 
lights solid green to indicate that the terminal is properly seated.

3. The battery pack begins charging. 

Using the Mobile Base

1. Connect the Mobile Base to the appropriate power source using an HHP cable.

2. Slide the terminal (with installed battery pack) into the terminal well until the Dock LED 
lights solid green to indicate that the terminal is properly seated.

3. The battery pack begins charging.

Other Charging Options
When the Li-ion battery is installed in the terminal, connect a charging/communication 
cable to the 17-pin connector and plug the cable into a power outlet.

When the Li-ion battery is not installed in the terminal, place the battery pack in the Dolphin 
QuadCharger.

!
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Charging a Spare Battery Pack

The HomeBase features an 
auxiliary battery well. Insert a spare 
battery pack into this well and the 
battery charges in four hours. The 
auxiliary battery well charges 
batteries independently of the 
terminal well.

DOCK

COMM
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Step 4. Initialize the Mobile Computer

1. When power is applied from a newly installed battery, the decode LED lights and the scan LED blinks for approximately three 
seconds. Do NOT press any keys while the terminal is booting up.

2. The terminal initializes and the HHP splash screen displays for a few seconds. The Build numbers indicate the software 
version number.  

3. The system performs a hard reset. When the display activates again, follow the instructions that appear.

Step 5. Align the Screen 
You are prompted to align the screen by tapping the target five times. Use the stylus provided by HHP. 

• Alignment should always be performed with a stylus designed for touch screen applications. The small point is required for 
accurate calibration.

• Press the stylus firmly into the center of the cross-hair target once and release. Do not “double-tap” the target. 
• You can re-align the screen at any time by going to Start > Settings > System tab > Screen.  

Step 6. Complete the Screens
After aligning the screen, follow the directions on the screen which take you through a simple exercise showing how to use the 
stylus and pop-up menus.

Build: 5.XX/5.XX/5.XX

Bootloader

Kernel

Keyboard

Tap the target firmly and accurately at 
each location on the screen. The target 
will continue to move until the screen is 
aligned.
2 - 8 Dolphin® 9500/9550 Mobile Computer User’s Guide - GSM Draft



Note: HHP recommends using screen protectors for Dolphin 9500/9550 terminals; especially for those terminals used within 
applications that require high-volume interfacing with the touch screen. Screen protectors help prevent damage to the 
touch screen and are easily installed. Screen protectors can be purchased at any major computer retail store or directly 
from HHP, Inc. Please contact HHP directly for part numbers and pricing.

Step 7. Set the Time Zone
After screen alignment is completed, the Location screen shown below displays.  

Use the drop-down list to select your time zone, and tap Next. This does not necessarily set the correct time; only the time zone. 
You set the time and date manually. See Setting the Time and Date on page -10.

After setting the time zone, you are finished with the initial setup of your Dolphin mobile computer. The system begins 
autoinstalling.
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Step 8. Autoinstall
For each program that loads, a status bar indicates that the program is loading. Autoinstall occurs after each hard reset. Do NOT 
touch the keyboard or the screen while programs are loading. 

All configurations of the Dolphin 9500/9550 install HHP Demos and HHP Utilities. If the terminal is configured with a wireless 
radio, the appropriate radio drivers (*.cabs) and utilities for each radio install.

After Autoinstall is complete, the terminal performs a soft reset automatically. When it finishes booting up after the soft reset, the 
Today screen appears; see Today Screen on page 4-2.

Setting the Time and Date
You need to re-set the time and date after every hard reset of the terminal. It is a good idea to set the time and date now before 
you begin using the device.

To set the time and date, go to Start > Settings > Systems tab > Clock to set the date and time.

Step 9. Verifying Operations with HHP Demos
The Dolphin 9500/9550 mobile computer comes loaded with HHP Demos you can use to verify imaging and decoding. 

Verify Imaging
The Image Demo enables you to use the imager to capture an image.

1. Go to Start > HHP Demos > Image Demo. The image demo opens.

2. Point the terminal at an object and press the SCAN key. A preview of the object appears on the terminal screen. 

3. Release the SCAN key. The image is captured. By default, the image saves to the My Device folder as “imagedemo.jpg.” To 
save to a different location, go to File > Save As and select a new location.

4. Press the ESC key to close the demo. 

For more information about taking an image, see Imager on page 4-6.
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Verify Decoding
The Scan Demo enables you to decode a sample bar code.

1. Go to Start > HHP Demos > Scan Demo.

2. Aim the terminal at a bar code and press the SCAN key. The decode LED flashes red, the scan LED lights red, and a green 
aimer beam projects out from the scanner.

3. When a good scan is obtained, the decode LED lights solid green and the terminal beeps. The bar code readout appears on 
the screen.  

4. Press the ESC key to close the demo.

Sample Bar Codes

You can use the following bar codes to verify decoding:

For more information, see Decoding a Bar Code on page 4-6.

Sample 128 Sample PDF417

Code 128 PDF417 Test Message
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Resetting the Terminal

Soft Reset (Warm Boot)
You would perform a soft reset if the terminal fails to respond. The soft reset re-boots the device without losing RAM data.

1. Press and hold the Control (CTRL) and the Shift (SFT) keys for approximately five seconds. 

2. The decode and scan LEDs flash for approximately three seconds as the terminal resets. 

3. When the reset is complete, the Today screen displays.

Hard Reset (Cold Boot)
A hard reset resets the operating system, restores the terminal back to factory defaults, and resets the terminal after a bootloader, 
keyboard, and kernel upgrade.

A hard reset erases all of the data stored in RAM memory and all RAM installed applications.

1. Press and hold the Control (CTRL) and the Escape (ESC) keys for approximately five seconds.

2. The decode and scan LEDs light for approximately three seconds. 

3.  The terminal re-initializes (see page 2-8 for details).

Suspend Mode 

To put the Dolphin terminal into suspend mode manually, press and hold the POWER key. The terminal goes into suspend mode 
automatically when the terminal is inactive for a programmed period of time. For more information, see Power on page 5-11.

To wake the Dolphin terminal from suspend mode, press the Power or SCAN key.

The Dolphin terminal also goes into suspend mode if you remove the main battery pack while the terminal is powered on. To 
wake the Dolphin terminal from suspend mode, simply install a fully charged battery. The terminal powers on. 

If the main battery and back-up battery are ever fully discharged of power, the terminal performs a hard reset when power 
is restored. The terminal will be restored to its original state. All data stored in RAM memory will be lost. 

!

!
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Dolphin 9500/9550 Overview
System Features

Processor

The Dolphin 9500/9550 terminal is equipped with an Intel X-Scale 400MHz RISC microprocessor that runs on a 100 MHz RAM 
BUS, making it one of the most powerful Pocket PC platforms on the market.

Operating System

The Pocket PC platform is a compact, highly efficient, scalable operating system. Its open architecture facilitates development 
of applications for energy-efficient data collection devices like the Dolphin 9500/9550 terminal. 

Memory

Main Board - The memory configuration for the Dolphin 9500/9550 terminals is 64 MB RAM and 32 MB non-volatile FLASH.

Secure Digital Card (SD) - Dolphin 9500/9550 terminals contain one Secure Digital (SD) memory interface for additional 
application and data storage. Additional secure digital upgrades of 64 MB, 128 MB, and 256 MB are available. The secure digital 
card socket is user accessible while preserving the terminal’s environmental rating. 

Wireless Radio Options

For more information, see Radio Options on page 4-18.
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Front Panel Features

This section describes features on the Dolphin 9500/9550 terminal front panel. 

LEDs

The two light emitting diodes (LEDs) located at the top of the LCD display flash and illuminate during resets and 
scanning/imaging. Both can be programmed by various software applications.

Scan LED - Located in the upper right corner, this LED lights red when you press the SCAN key.

Decode LED - Located in the upper left corner, this LED lights green when a scanned bar code is successfully decoded.

Display

The Dolphin 9500/9550 terminals feature a 3.5” liquid crystal display (LCD) touch screen and is covered with an 
industrial, protective lens. The video graphic array (VGA) resolution is 1/4 (240 X 320 pixel). The touch screen is 
activated with the stylus (included with the terminal) or a finger. The LCD display is available in monochrome and color.

Color - The color LCD is 16 bits/pixel and uses active display or thin film transistor (TFT) technology. The backlight for 
the display illuminates when the screen is touched, but not when the Backlight key is pressed.

DOL PHIN 9500
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Decode LED Scan LED

Display

Navigation keys

SCAN key

Keyboard

Magnesium top cover
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Monochrome - The monochrome LCD is grayscale and 4 bits/pixel. The backlight illuminates when the touch screen 
or the Backlight key is pressed. Monochrome units contain an addition contrast setting to enhance readability.

For more information about the Backlight, see Adjusting the Backlight on page 4-15.

SCAN Key

The SCAN key is centrally located for easy access with the right or left hand. When pressed, the SCAN key activates 
the scanner/imager. The SCAN key also functions as an on or system wakeup control for the terminal.

Navigation Keys

The centrally-located navigation keys enable you to move and position the cursor through software programs. The up 
and down arrows are programmed to perform specific functions when pressed in combination with the Blue and Red 
modifier keys.

Keyboard

The Dolphin 9500/9550 series features three keyboard options: 35-key numeric/alpha keyboard, 43-key numeric/alpha 
keyboard, and 56-key alpha/numeric keyboard. Each keyboard is backlit for easy viewing in various lighting conditions 
and contains centrally located keys for both right- and left-hand operation. The silver background of both the keys and 
the overlay enhances the readability of each.

The overlay of all three keyboards are color-coded to indicate the functions performed or characters typed when the 
color-coded key is pressed immediately after the Red or Blue Modifier key at the bottom of the keyboard. 

For a complete overview of each keyboard, see Using the Keyboards on page 4-9.
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Back Panel Features

Because the back panel of the Dolphin 9500 and the Dolphin 9550 are different, each is featured in its own section.

Dolphin 9500
The following graphic describes features on the back panel of the Dolphin 9500 terminal.

Image Engine Window

Dolphin 9500/9550 terminals come equipped with an image engine that reads and decodes linear, stacked linear 
(PDF417), and 2D matrix bar code symbologies. With the latest CMOS-based technology, the engine works like a digital 
camera and enables digital image capture, signature capture, and reading of OCR characters. 

Digital images taken with the Dolphin 9500/9550 terminal have a maximum image size of 640 x 480 pixels and may 
have up to a 256 grayscale image definition. Files formats supported for image storage include Bitmap (.bmp), JPEG 
(.jpg) and Portable Network Graphics (.png).

For a frontal view of the Image Engine Window,  see Image Engine Window on page 3-6.

Battery Well
(underneath the battery)

Battery

Image Engine
Window

Stylus (in slot) Speaker

Microphone
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Speaker

The Dolphin 9500/9550 terminal has an integrated speaker that sounds audio signals as you scan bar code labels and 
enter data. The operating frequency range is 500Hz at 71 dB up to 80 dB. The speaker can also be used for playing 
sounds (e.g., WAV files).

Hand Strap 

The Dolphin 9500 has an integrated elastic hand strap to provide a comfortable, secure grip on the terminal. It is 
attached to the terminal with a clip on the bottom panel; see Hand strap clip on page 3-9. If desired, the strap may be 
adjusted or removed. 

Microphone

Dolphin 9500/9550 terminals feature an integrated microphone that provides audio input to the terminal.

Battery/Battery Well

The Battery Well is a recessed area on the back of the Dolphin that holds the Li-Ion battery pack. For more information, 
see Batteries on page 3-10.

Stylus

The stylus is used to operate the touch screen. The back panel features this storage slot to hold the stylus when not in 
use. 
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Dolphin 9550
This section describes the back panel of the Dolphin 9550. It contains the same features as the Dolphin 9500 described in the 
previous section with the additions of 

• a pistol-grip handle to hold and maneuver the terminal with greater ease,
• a scanner/imager trigger on the handle that activates the scan, and
• rubber bumpers that enable the terminal to rest safely and securely when not in use.

The following is a graphic of the 9550 back panel. 

Rubber Bumpers

See Rubber Bumpers on page 3-7.

Image Engine Window

This is the front view of the window. For more information, see Image Engine Window on page 3-4.

Scan Trigger

The scan trigger provides comfortable scan activation.

Pistol Grip Handle

The comfortable, ergonomic handle is integrated into the back panel to enhance the terminals durability in rugged, real-
world settings. The handle was designed specifically for use in rapid, high-volume scanning applications and features 
rubber surface details to improve handle grip, comfort, and shock absorption.

Rubber
Bumpers

Pistol-Grip Handle

Scan Trigger

Rubber Bumper

Image Engine
Window
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Rubber Bumpers

The rubber bumpers enable the Dolphin 9550 to rest in a stable, nose-down position when the unit is set on a flat 
surface. The following graphic shows the Dolphin 9550 in a nose-down position, resting on its rubber bumpers. 

Stylus

The stylus is used to operate the touch screen display. The Dolphin 9550 stores the stylus inside the pistol-grip handle.

Rubber Bumpers Stylus - inside the handle
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Side Panel Features

The following graphic shows the left, side panel.

IrDA Port

The Infrared Data Association or IrDA port communicates with IrDA-enabled devices such as PC’s, printers, modems, 
or other Dolphin 9500/9550 terminals. The maximum speed is 115kbps.

Secure Digital Memory Interface

Dolphin 9500/9550 terminals have an industry standard Secure Digital (SD) memory interface. The Secure Digital 
Access Door seals the memory interface from moisture and particle intrusion and provides secure storage for read/write 
data. However, the user can open the access door manually to gain access to the SD.

Terminals can be custom-configured with SD memory of 64MB, 128MB, or 256MB. 

Audio Jack

Dolphin 9500/9550 terminals contain a 2.5mm audio jack for stereo audio playback. This jack serves as both a headset 
interface or as a microphone to make sound recordings. In both cases, you must use a 2.5mm plug.

DO
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N

95
00

IrDA Port Audio Jack  (2.5mm)Access Door to the Secure Digital 
(SD) memory interface 
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Bottom Panel Features

This following graphics describe the bottom panel of the Dolphin 9500/9550.

Mechanical Connector
The bottom panel of the Dolphin 9500/9550 features a custom, industrial-grade connector with 17 pins. When seated in a Dolphin 
9500 series peripheral, the terminal is powered, the main battery charged, and communication occurs via this connector. All 
Dolphin 9500 series peripherals are designed to work exclusively with this connector.

The 17-pin connector can communicate with Dolphin 9500 series peripherals via RS-232 or USB. For RS-232, the maximum 
communication speed is 115 Kbps with a seven baud rate setting. For USB, the communication speed is 12 Mbps. If the 
peripheral unit is connected to a PC, this connector also transmits data. This serial port is designated as COM port 1 on the PC. 

The mechanical connector also provides power out (to peripheral devices) 5V at 500mA. This means that, with the proper HHP 
cable, the terminal can power another device. 

Pin #        Description

 1                     +USB
 2                      PWR
 3                      N / C
 4                      N / C
 5                      N / C
 6                      N / C
 7                      GND
 8                      5V OUT
 9                      DTR
 10                    -USB 
 11                    USB DET 
 12                    RI
 13                    DSR
 14                    RXD
 15                    RTS
 16                    TXD  
 17                    CTS

1

10

2

11

3

12

4

13

5

14

6

15

7

16

8

17

9

Mechanical Connector

Hand strap clip

Note:  Signals referenced are for a DTE device.
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Batteries

The Dolphin 9500/9550 features intelligent battery technology. It is comprised of two types of battery power: the main battery 
pack installed in the back panel and the backup battery located inside the terminal. They are designed to work together to prevent 
data loss when the terminal is in use over long periods.

Both must be completely charged before using the Dolphin 9500/9550 for the first time. 

Main Battery Pack
Use only the Li-ion battery packs provided by HHP. The use of any battery pack not sold/manufactured by HHP in the 
Dolphin 9500/9550 terminal will void your warranty and may result in damage to the Dolphin terminal or battery.

The 7.4V, 14.8 watt hour Li-Ion battery pack is the primary power source for the Dolphin. The Li-Ion battery is designed to operate 
in a temperature range of -10 to 50°C (14 to 122°F). They can be stored between -30 to 80°C (-22 to 176°F).

For the location of the Li-Ion battery on the terminal, see Battery/Battery Well on page 3-5. 

Charging Options

When the Li-ion battery is installed in the terminal:

• Place the terminal in a HomeBase (page 11-7) or Mobile Base (page 12-4) that is connected to an appropriate power supply.
• Connect a charging/communication cable to the mechanical connector, plug the cable into the AC adapter, and plug the 

adapter cable into a power outlet.

When the Li-ion battery is not installed in the terminal:

• Place the battery pack in the Dolphin QuadCharger - see Charging Batteries in the QuadCharger on page 14-3.
• Place the battery pack in the auxiliary battery well of the HomeBase - see page 11-7. 

Charging Time

The Li-ion battery pack requires four hours to charge completely.

Internal Backup Battery
Located inside the terminal, the backup battery is a 3.6 Volt nickel metal hydride (NiMH) battery. The internal backup battery must 
be replaced by HHP. 

Purpose

The internal backup battery prevents the terminal from being reset if you need to remove and replace the main battery pack. It 
retains RAM data and allows the real-time clock to remain operational for up to 30 minutes when the main battery pack is 
removed.

Charging

The internal backup battery is powered by the main battery pack. Therefore, charging the internal backup battery requires that 
the main battery pack be installed in the terminal and the terminal be connected to a charging device.

The internal backup battery must be fully charged before using the terminal for the first time. The initial charge cycle takes 
approximately eight hours. After that, if the internal backup battery becomes fully discharged of power, it requires a minimum of 
10 hours of charging time to function normally.

If the terminal is left without the main battery pack for more than 30 minutes, the internal backup battery needs to be recharged 
to function according to its specifications. 

Note: Data and programs stored in flash memory are not lost even if the internal backup battery fails. However, you must reset 
the real-time clock using the Pocket PC time and date function; see Setting the Time and Date on page 2-10.

Guidelines

Follow these guidelines to maximize the life of the Dolphin’s backup battery:

• Keep a charged Li-Ion battery pack in the Dolphin. The internal battery prematurely discharges if there is not at least a partially 
charged battery in the terminal.

• Put the Dolphin in the HomeBase connected to power when the terminal is not in use. 

!
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Managing Battery Power
Data and files saved on the Dolphin 9500/9550 terminal may be stored in RAM, so it is important to maintain a continuous power 
supply to the terminal. When the main battery pack becomes low, the Low Battery Charge icon appears in the notification tray at 
the top of the screen. The Critical icon appears when the battery is critically low. There is also a Low Battery icon that appears 
when the backup battery is low. For details about these icons, see Status Icons on page 4-25.

Letting the backup battery become fully discharged causes the terminal to lose all data in RAM. Therefore, you should keep a 
charged battery pack in the Dolphin at all times. The internal battery discharges prematurely if there is not at least a partially 
charged battery in the terminal. When you remove a battery pack, insert another charged battery pack in the Dolphin. 

The battery status indicator displays in the notification tray when the battery is low or critically low. If there is no indicator, the 
battery is adequately charged.

If the main battery is low and the terminal is in suspend mode, pressing the SCAN or Power button does not wake the Dolphin 
9500/9550 terminal; you must replace the discharged battery with a fully charged battery.

Default Critical and Low Battery Points
The Dolphin 9500/9550 is programmed to display warnings when the battery reaches critical and low battery points. There are 
two entries defined in the registry:

[HKEY_LOCAL_MACHINE\System\CurrentControlSet\Control\Power]

“CriticalBatt”=dword:a 

“LowBatt”=dword:19

“CriticalBatt”=dword:a 

This sets the Critical Battery point to 10 percent (a hex = 10 decimal). The critical battery setting is the point at which the customer 
is warned that the battery charge is very low. This warning is posted every 3 minutes until the situation is corrected.

“LowBatt”=dword:19

This sets the Low battery point to 25 percent (19 hex = 25 decimal). The low battery setting is the point at which the user is notified 
that the battery is low. The user is notified only once for a low battery.

Setting Critical and Low Battery Points
Developers can reset these parameters in the registry from 0 (no warning) to 99 (would nearly always warn). Warnings do not 
appear when the terminal is on external power.
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Checking Battery Power

1. Go to Start > Settings > System tab > Power. The power settings screen appears displaying the charge status of both the 
installed Li-ion battery pack and the NiMH backup battery inside the terminal. This screen also displays the Suspend Mode 
settings for the terminal.   

2. Select your time-out preferences from the drop-down lists. You can have both battery power and external power settings 
simultaneously.

3. Tap OK to save the changes and exit. 

Storing Batteries
To maintain optimal battery performance, follow the guidelines below when storing:

• Avoid storing batteries outside the specified range of -4 to 104° F (-20 to 40°C) or in extremely high humidity.
• For prolonged storage, do not keep batteries stored in a charger that is connected to a power source. 

Guidelines for Battery Use and Disposal
The following are general guidelines for the safe use and disposal of batteries:

• Use only the battery supplied, recommended, or approved by HHP. 
• Replace a defective batteries immediately as it could damage the Dolphin terminal.
• Never throw a used battery in the trash. It contains heavy metals and should be recycled according to local guidelines. 
• Don’t short-circuit a battery or throw it into a fire. It can explode and cause severe personal injury.
• Excessive discharge damages a battery. Recharge the battery when your terminal indicates low battery power.
• Although your battery can be recharged many times, it will eventually be depleted. Replace it after the battery is unable to 

hold an adequate charge.
• If you are not sure the battery or charger is working properly, please send it to HHP or an authorized HHP service center, for 

inspection.
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Dolphin 9500/9550 Technical Specifications
System  Architecture

Processor: Intel X-Scale PXA255 400MHz 

Development 
Environment:

Dolphin SDK for Pocket PC 2002 supports Embedded VB or C++

Dolphin .NET SDK for Pocket PC 2002 supports Visual Studio.NET(VB.NET and C#.NET)

Operating Platform: Pocket PC 2002 Professional Edition 

Third-Party Software: Support for Connect Terminal Emulation software (TNVT, 3270, 5250) and Java Virtual Machine 
(JVM) runtime

Memory: 64MB RAM x 32MB non-volatile Flash 

Data Inputs

Imager/Scanner: See Image Engine Options on page 2-2.

1D Symbologies: See Bar Code Symbologies Supported on page 2-5.

2D Symbologies: See Bar Code Symbologies Supported on page 2-5.

Composite Codes See Bar Code Symbologies Supported on page 2-5.

OCR Fonts: See Bar Code Symbologies Supported on page 2-5.

Three Keyboard Options: 35-key numeric-shifted alpha, 43-key alpha-shifted numeric, and 56-key full alpha/numeric

See Using the Keyboards on page 4-9.

Data Outputs

Display: See Display on page 3-2.

I/O Ports: Custom, industrial-grade, mechanical connector supports 

• USB communications at 12Mbps
• Serial RS-232 communication up to 115Kbps 
• Charging via peripheral cradles 

AC adapter cables

Integrated IrDA port

Integrated audio jack that acts as a speaker and a microphone

Mass Storage: User-accessible Secure Digital (SD) memory interface

Wireless Radio Options

WLAN: IEEE 802.11b DSSS    Authentication Methodologies:  LEAP, MD5, TLS, TTLS,  and PEAP

WWAN: (9500 only) GSM/GPRS Tri-band (900, 1800, 1900 MHz) radio with accessible SIM card interface

WPAN: Bluetooth radio

Physical 

Dimensions: 9.6"L x 3.45"W x 1.66"D at display (24.53 x 8.76 x 4.23 cm), 2.7"W x 1.5"D at grip (6.9 x 3.8 cm)
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Weight: 9500 Terminal –

Batch: 19.7 oz. (558 gm)

WLAN:  20.2 oz. (573 gm)

WPAN:  20 oz. (567 gm)

WLAN/WPAN: 20.3 oz. (576 gm)

9550 Terminal –

Batch:  23.4 oz. (663 gm)

WLAN:  23.9 oz. (677.5 gm)

Operating Temperature:  14 to 122°F (-10°C to 55°C)

The terminal can operate in temperatures lower than -20°C with potential degradation in 
performance depending on the application

Storage Temperature:  -22 to 176°F (-30°C to 80°C)

Humidity:  95% humidity, non-condensing

Electrical Static 
Discharge:

15 kv on all surfaces

Impact Resistance: Withstands multiple 5ft. (1.5m) drops onto concrete 

Environmental 
Resistance:

Independently certified to meet IP64 standards for moisture and particle resistance

Power: Lithium-Ion battery technology – 7.4V, 14.8 watt-hour main battery with hot-swappable design 
for fast replacement in the field

Other: Integrated stylus with optional tether and removable hand strap 

Peripherals/Accessories

Dolphin HomeBase Charging/communications cradle with auxiliary battery well. Data transfer via RS-232 serial or 
USB ports. 

Dolphin Mobile Base Mobile charging/communication cradle. Data transfer via RS-232 serial. Power out 5 volts for 
peripheral devices.

Dolphin QuadCharger Four-slot battery charger that charges four batteries in under four hours. One slot doubles as a 
battery analyzer.

Dolphin Mobile Charger  Charges a Dolphin terminal by plugging into a vehicle cigarette lighter/power port.

Dolphin Net Base Four-slot charging/communication cradle designed for Ethernet-based communications.

Dolphin ChargeBase Four-slot charging cradle that holds, powers, and charges a terminal in each slot.

Charging/Communication 
cables

USB or serial cables that charge and communicate with the terminal directly–without a cradle. 

Li-Ion Battery Pack   7.4V, 14.8 watt hour Li-ion rechargeable main battery for the Dolphin.

Regulatory Approvals

FCC-CE-Radio Country:  US/Canada, R&TTE

Dolphin 9500/9550 Technical Specifications
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Using the Dolphin 9500/9550 Mobile Computer
Entering Data

To enter data, you may: 

• Use the 35-key, 43-key, or 56-key keyboards
• Capture images or scan bar code data into data fields
• Use the Soft Input Panel (SIP) to enter text
• Write directly on the screen
• Draw pictures on the screen

• Use Microsoft® ActiveSync® to synchronize or copy information from your desktop computer. For more information on 
ActiveSync, see ActiveSync Help on your desktop computer. For information on communicating with ActiveSync, see Using 
ActiveSync on page 6-2.

Touch Screen 

HHP recommends using screen protectors to protect the touch screen; especially when used with applications that require high-
volume interfacing with the touch screen. Screen protectors help prevent damage to the touch screen display and are easily 
installed. Screen protectors can be purchased at any major computer retail store or directly from HHP.

For touch screen input, use the included stylus or your finger. The method you choose depends on which one is 
appropriate for your application. While there is a great deal of variation in different applications, for buttons or icons that 
are close together, you generally achieve greater accuracy with the stylus. Use of other objects, such as paper clips, 
pencils, or ink pens can damage the input panel and will void the warranty.

!
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Today Screen

When you turn on your device for the first time, you see the Today screen. You can also display it by tapping Start and then 
Today. On the Today screen, you can see at a glance important information for the day.

Your day at a glance.

Tap to create a new item.

Tap to switch
to a program.

Tap to view notification messages.

Tap to view connection status.

Tap to change date and time.

Tap to open an item.

Tap to change volume or mute all sounds.
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Navigation Bar 

The navigation bar is located at the top of the screen. It displays the active program and current time, and allows you to switch 
to programs and close screens. 

Command Bar
Use the command bar at the bottom of the screen to perform tasks in programs. The command bar includes menu names, 
buttons, and the Input Panel button. To create a new item in the current program, tap New. To see the name of a button, tap and 
hold the stylus on the button. Drag the stylus off the button so that the command is not carried out.

Tap to select a program.

Tap to change volume or mute the device.

Tap to see additional programs.

Tap to customize the device.

Tap to quickly select a program
you have recently used.

New button.

Menu
names.

Buttons.

Input panel button.
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Pop-Up Menus

With pop-up menus, you can quickly choose an action for an item. For example, you can use the pop-up menu in the contact list 
to quickly delete a contact, make a copy of a contact, or send an e-mail message to a contact. The actions in the pop-up menus 
vary from program to program. To access a pop-up menu, tap and hold the stylus on the item name of the action you want to 
perform the action. When the menu appears, lift the stylus, and tap the action you want to perform. Or tap anywhere outside the 
menu to close the menu without performing an action.

Tap and hold to display
the pop-up menu.

Lift the stylus and tap
the action you want.

Tap outside the menu
to close it without performing
an action.
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Selecting Programs

To select a program, tap Start > Programs, then the program name. 

Note: Some programs have abbreviated labels for check boxes and drop-down lists. To see the full spelling of an abbreviated 
label, tap and hold the stylus on the label. Drag the stylus off the label so that the command is not carried out. 
Dolphin® 9500/9550 Mobile Computer User’s Guide - GSM Draft 4 - 5



Imager

The terminal houses a compact image engine that instantly reads all popular 1D and 2D bar codes. It also supports omni-
directional aiming and decoding for greater flexibility in handling the device in real-world settings. The imager can also capture 
digital images, such as signatures and pictures of damaged inventory. Images are saved in industry-standard file formats.

The terminal supports two types of image decoding for use in various bar code reading and imaging applications: full-area 
imaging and Advanced Linear Decoding (ALD).

Full-area Imaging

Full-area imaging provides omni-directional reading of linear and non-linear 1D and 2D bar codes, OCR, signature capture, and 
picture taking. When reading all bar code types using full-area imaging, a positive read can be obtained from most any position. 
To achieve the best read, the aiming beam should be centered horizontally across the bar code. 

ALD

ALD provides fast reading of linear and stacked linear bar codes. To achieve a positive read when reading linear 1D and PDF417 
bar codes, the green aiming beam should be centered horizontally across the bar code. When ALD is enabled, the reader does 
not read matrix or postal codes.

Decoding a Bar Code 

1. Point the Dolphin 9500/9550 terminal directly at the bar code. The imager faces straight out the top panel. The aiming beam 
should be oriented in line with the bar code to achieve optimal decoding. A range of 4-10 inches (10-25 cm) from the bar 
code is recommended. 

2. Project the imager’s green aiming beam by:

• Pressing and holding the SCAN key on both the 9500 and 9550. 
• Pressing and holding the Scan Trigger on the 9550.

3. The decode LED flashes red, and the scan LED lights red. 

4. Center the aiming beam over the bar code.

5. When the bar code is successfully decoded, the decode LED lights green and the terminal beeps.

6. The bar code information is entered into the application in use.

DOLPHIN 9500

Scan LEDDecode LED
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Scanning Position Options 

The aiming beam is smaller when the terminal is held closer to the code and larger when it is farther from the code. Symbologies 
with smaller bars or elements (mil size) should be read closer to the unit. Symbologies with larger bars or elements (mil size) 
should be read farther from the unit.

The following chart displays the imager’s aiming positions:

Linear bar code 2D Matrix symbol
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Capturing Images
The image-capture process is an intuitive, split-second operation for experienced users. By following the basic guidelines, new 
users can easily develop their own technique and, with practice, quickly learn to adapt it to different application environments. 

Image Preview

When the imaging process is initiated, the Dolphin 9500/9550 touch screen displays a preview of the object. This is a live video 
image of what the imager is currently viewing. It has a slightly degraded appearance compared to the captured image. This is 
normal.

The Scan Key 

The Scan key captures images on both the Dolphin 9500 and the Dolphin 9550 terminals. It is the only way to capture an image 
on the 9500, while on the 9550, you can also use the scan trigger on the pistol-grip handle.  

Image Quality and File Size

The terminal is capable of saving images in a number of industry-standard file formats such as *.bmp, *.jpg and *.png. The default 
file format for images is a grayscale *.jpg. 

The image quality and related file size are determined by the data compression method used by the software application in use 
when you take images. The average size of the image file is approximately 4-8K. However, the size of the image depends on the 
content of the image–the more complex the content, the larger the file size. 

For the highest quality, take grayscale images.

Taking an Image
The following steps are basic guidelines for taking images:

1. Point the Dolphin 9500/9550 terminal directly at the object. The imager points straight out the top panel.

2. To preview the image:

• Press and hold the SCAN key on both the 9500 and 9550. 
• Press and hold the Scan Trigger on the 9550.

3. The touch screen displays a preview of the object, and the decode and scan LEDs light red.

4. Adjust the terminal’s position until the object appears on the screen the way you want it to appear in the image.

5. Hold the terminal still and release the SCAN key or Scan Trigger. The scan and decode LEDs flash red, the touch screen 
flashes, and the captured image appears on the screen. 

6. Unless otherwise specified by the application in use, the image is saved to the My Device folder (Start > Programs > File 
Explorer > My Device). From here, the image file can be uploaded to a host PC using Microsoft ActiveSync  and a Dolphin 
communication peripheral.
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Using the Keyboards

The Dolphin 9500/9550 series features three keyboard options: 35-key numeric/alpha keyboard, 43-key numeric/alpha 
keyboard, and 56-key alpha/numeric keyboard. Each keyboard is backlit for easy viewing in various lighting conditions and 
contains centrally located keys for both right- and left-hand operation. The silver background of both the keys and the overlay 
enhances the readability of each.

The overlay of all three keyboards are color-coded to indicate the functions performed or characters typed when the color-coded 
key is pressed immediately after the Red or Blue Modifier key at the bottom of the keyboard. In addition to the alpha and numeric 
keys, each keyboard contains function, navigation and modifier keys.

43-key numeric/alpha keyboard35-key numeric/alpha keyboard 56-key alpha/numeric keyboard
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Using the Function Keys

Using the Navigation Keys

Located in the center of each keyboard for easy access with either hand, the navigation keys enable you to navigate the cursor 
through an application screen.  

Name Key Function

Backlight By default, the Backlight key turns the keyboard backlight on and off. See Adjusting the 
Backlight on page 4-15.

Backspace 
(BKSP)

This key appears on both the 35- and 56-key keyboards.

The BKSP key moves the cursor back one space each time the key is pressed. If you are 
typing text, it deletes the previous character each time it is pressed.

On the 43-key keyboard, the backspace is a shifted function; press SFT + SP to backspace. 
To delete a single character, press Red key + SP. To delete multiple characters, press Red key 
+ SP and hold down the SP key.

Delete 
(DEL)

This key appears on both the 35- and 56-keyboard. The Delete key deletes the next character 
forward each time the key is pressed. 

On the 43-key keyboard, delete is a shifted function; press SFT + the Backlight key to delete.

Enter (ENT) The Enter key confirms data entry.

Escape 
(ESC)

The Escape key performs a cancel action.

Power Key The Power key puts the terminal into and wakes the terminal from suspend mode.

SCAN Key The SCAN key activates the scan on both Dolphin 9500/9550 terminals. It also “wakes” the 
terminals from sleep mode. Its position allows convenient one-handed image-taking and/or 
bar code decoding. 

Space (SP) The Space key moves the cursor one space.

Tab The Tab key moves the cursor to the next tab stop or the next control (on a form). 

Press To …

Move the cursor up one row or line.

Move the cursor down one row or line.

Move the cursor one character to the right.

Move the cursor one character to the left.
4 - 10 Dolphin® 9500/9550 Mobile Computer User’s Guide - GSM Draft



The up and down arrows can also be used for volume control when pressed in combination with the blue modifier key. They can 
also be used for page up and page down commands when pressed in combination with the red modifier key. Other functionality 
varies according to the application in use.

Using the Modifier Keys

All three versions of the Dolphin 9500/9550 keyboard feature the standard PC keyboard modifier keys, Shift (SFT), Alt, and 
Control (CTRL) as well as Blue and Red modifier keys. 

Name & Key Function

Shift (SFT) The SFT key modifies only the next key pressed; it must be pressed before each key 
you wish to modify. SFT toggles the keyboard between uppercase alphabet mode and 
lowercase alphabet mode. Use SFT toggle Caps Lock on and off by double-tapping it 
or by pressing SFT + the Red modifier key. When Caps Lock is toggled on, characters 
are uppercase; when toggled off, characters are lowercase. 

 The CTRL, ALT, and Blue and Red Modifier keys are located along the bottom of each 
keyboard.   

CTRL and ALT Functions of the ALT and CTRL keys depend on the software application in use and 
the keys pressed in combination with each. 

Blue and Red The blue and red keys are used in combination with other keys to type special 
characters and perform system functions. Each key modifies only the next key pressed.

The overlay of each keyboard is color-coded to indicate the character typed or function 
performed when specific keys are pressed immediately after the blue or red modifier 
key. 

RedBlue
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35-Key Numeric/Alpha Keyboard
The following graphic displays the 35-key numeric/alpha keyboard.

Alpha Lock Key (ALPHA) 

Because the 35-key keyboard defaults to numeric mode, the Alpha Lock key appears only on the 35-key keyboard. The Alpha 
Lock key enables you to toggle between the numeric and alpha modes. Numeric mode is when you type numbers with the 
number keys. Alpha mode is when you type letters with the number keys.

The letters on the overlay above specific number keys indicate what letter will be typed when you press that key in alpha mode.

Enter key

Backlight key

Alpha Lock key

Shift key

Navigation keys

Tab key

CTRL, Blue, Red, ALT Modifier keys

SCAN key

Power key

Backspace key

Function keys

Space key

Escape key

Delete key

Alpha Lock Indicators
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43-Key Numeric/Alpha Keyboard
The following graphic displays the 43-key numeric/alpha keyboard.

Number Lock (NUM)  

Because the 43-key keyboard defaults to alpha mode, the Number Lock key appears only on the 43-key keyboard. The Number 
Lock key enables you to toggle between the alpha and numeric modes. alpha mode is when you type letters with the letter keys. 
Numeric mode is when you type numbers with the letter keys. 

The numbers on the overlay above specific letter keys indicate what number will be typed when you press that key in Numeric 
mode.

Backlight key (use with SFT to delete)

SCAN key

Space key (use with SFT to backspace)

CTRL, Blue, Red, ALT Modifier keys

Enter key

Tab key

Escape key

Number Lock key

Shift key

Navigation keys

Power key

Number Lock
Indicators
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56-Key Alpha/Numeric Keyboard
The following graphic displays the 56-key numeric/alpha keyboard.

Key Combinations 
There are keyboard combinations for specific functions and special characters on each keyboard. For charts of the key 
combinations associated with each keyboard layout, see the Appendix A of the Dolphin 9500/9550 User’s Guide.

Shift key

Navigation keys

SCAN key

Power key

Backspace key

Space key

Delete key

Backlight key

Insert key

CTRL, Blue, Red, ALT Modifier keys

Enter key

Tab key

Escape key
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Adjusting the Backlight

Both the keyboard and the display are backlit to enable better viewing in low-light conditions. All keyboards contains a Backlight 
key that toggles the backlight on and off; see Backlight on page 4-10.

Keyboard By default, the Backlight key turns the keyboard backlight on and off for both color display and 
monochrome terminals. 

Display Backlight functionality differs for color and monochrome displays.  

Monochrome Display
The backlight for monochrome displays turns on and off when you press the Backlight key, but not when you tap the screen. You 
can adjust the contrast using the keyboard or the system settings.

Using the Keyboard 

Press and hold the 

• Red Modifier key + ESC to decrease the contrast
• Red Modifier key + TAB to increase the contrast

Color Display
The backlight for the color display is user-defined.

Go to Start > Settings > System tab > Backlight. 
The Backlight screen appears.

The graphic on the right displays the default 
backlight settings for color displays. 

Adjust the settings as needed with the options 
available. Use the slider to adjust intensity.

 

Click OK to save any changes.

The display backlight functions according to the 
settings saved here.

All three keyboards have red 
indicators over each key to indicate 
which key to press in combination with 
the red modifier key to adjust the 
contrast.
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Using the System Settings  

Tap Start > Settings > System tab > Contrast. 
The current settings are displayed.

Use the slider to adjust the contrast to the desired 
setting.

Tap OK to save adjustments.
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Communication Media Options

Via the Mechanical Connector

The 17-pin, industrial-grade, mechanical connector on the bottom panel is designed to work only with HHP sold/manufactured 
communication and charging peripherals. Via these peripherals, the connector supports USB and RS-232 communications, 
enabling the user to connect the Dolphin 9500/9550 terminal to external devices such as scanners and printers. The connector 
also provides power out 5V at 500mA, which means that, with the proper HHP cable, the terminal can power another device.

For more information about the connector, see Mechanical Connector on page 3-9.

Via the IrDA Port

The IrDA port enables the Dolphin 9500/9550 to transmit data via pulses of light to and from other IrDA-compliant devices, such 
as printers and PCs or to other Dolphin 9500/9550 terminals. 

Via the 802.11b Radio

The Dolphin 9500/9550 may be equipped with a WiFi®-compliant, interoperable 2.4 GHz 802.11b direct sequence spread 
spectrum wireless local area network (WLAN) radio.

Via Bluetooth Radio

The Dolphin 9500/9550 may be equipped with a Bluetooth wireless personal area network (WPAN) radio.

Software Communication Programs

Microsoft® ActiveSync v3.7®

Microsoft ActiveSync is a tool that enables Pocket PC devices, such as the Dolphin 9500/9550, to exchange and synchronize 
application data with a desktop computer.

For more information, see Communications on page 6-1.

RAS

Short for Remote Access Services, RAS is a feature built into Windows NT that enables users to log into an NT-based LAN using 
a modem, X.25 connection or WAN link. RAS is fully supported and allows the use of PPP or SLIP connections for network 
connectivity.
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Radio Options

Dolphin 9500/9550 terminals can be configured with one or a combination of the following radios:

• 802.11b
• Bluetooth 
• GSM/GPRS (9500 only)

Please note that the 9550 supports all radio options and configurations EXCEPT FOR GSM/GPRS.

Available Radio Combinations
Dolphin 9500/9550 terminals can be configured with more than one radio. 

Co-located Radios

Some combinations are co-located, which means that you can use only one radio at a time. In this case, you can have both radios 
installed but need to power one up and the other down before operation.

• 802.11b and GSM/GPRS 

Co-operational Radios

 Some combinations are co-operational, which means that you can power up and operate both radios simultaneously.

• Bluetooth and 802.11b 

• Bluetooth and GSM/GPRS 

Radio Driver Installation
Radio drivers install during the autoinstall whenever the mobile computer is initialized; when first turned on or after a hard reset. 
Only the appropriate drivers for your terminal’s radio configuration install. For example, if your terminal is configured only with an 
802.11b radio, only the driver for that radio installs. For more information, see Autoinstall on page 2-10.

When a single radio installs, its radio driver is powered up automatically after initialization is complete. In general, when more 
than one radio installs, the terminal powers up the 802.11b radio. However, if a GSM radio is installed, the terminal powers up 
the GSM radio.

The Radio Manager
The Radio Manager is a control panel applet through which the radio power driver controls the radio state. It enables you to 
choose which radios on the terminal are powered up. When powered up, the radio is transmitting, when powered down, the radio 
is not transmitting. 

Single Radio Configuration

If your terminal contains a single radio module and its associated driver is installed, operates by itself without any special 
configuration made to the device. 

Multiple Radio Configuration

Configuration of simultaneous radio operation is done during the manufacturing process according to FCC regulations. If multiple 
radio modules are installed in your terminal, simultaneous operation must be configured on the device before the radio power 
driver allows it. In other words, verify which radio or radios are powered up or down. 

Multiple Radio Operation

GSM and 802.11b are mutually exclusive. While they may both be present, they cannot be allowed to operate simultaneously. If 
you have modules and drivers for both radios installed on your terminal, you must ensure that one radio is powered down before 
using the other.

The Bluetooth radio is allowed to operate by itself or simultaneously with either of the GSM or 802.11b radios.
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Powering Up a Radio

Requirements

To successfully power up a radio, both the hardware module and the software driver must be installed on the terminal. If the 
module is present, the radio appears in the Radio Manager. However if the driver is not installed, you cannot successfully power 
up the radio. Attempting to do so produces an error in the Status field that tells you that the driver is not installed.

To Power Up a Radio or Radio Combination

1. Open the Radio Manager by going to Start > Settings > System tab > Radio Manager. The Radio Manager appears 
identifying which radio modules are allowed on the terminal. The highlighted entry is the radio mode that is currently enabled; 
its Status should be Ready.   

Radio Modes box The Radio Modes box displays the radio hardware modules currently installed on the terminal. For 
example, if a working Bluetooth module is installed, the box contains the line Bluetooth Only whether 
or not that radio is currently powered up. 

Status field The Status field provides feedback on the state of the radio. When it reads “Ready,” the radio selected 
in the Radio Modes box is powered up. The Status field displays error messages when a radio cannot 
be enabled.

2. Select the radio in the Radio Modes list and tap Apply. 

The radio drivers are powered down and powered up in the proper sequence. For example, if the radio powered up is Bluetooth 
Only and you try to switch to 802.11b Only, after Apply is tapped, the Radio Manager powers down the Bluetooth radio first, then 
powers up the 802.11b radio.

If an error occurs during this process, the radio mode change is abandoned. The resulting radio state is the status of the radios 
at the time the error occurred. 

To Power Down Radios

Radio drivers are automatically powered down if the radio or radio combination that is currently powered up requires it. To power 
down all radios, select None and tap Apply.

For more information about 802.11b radios, see Wireless LAN Communications with 802.11b on page 7-1.

For more information about Bluetooth radios, see Wireless PAN Communications with Bluetooth on page 8-1.
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Entering Text Using the Input Panel 

Use the input panel to enter information in any program on the Dolphin mobile computer. You can either type on the soft keyboard 
or write on the touch screen using Letter Recognizer or Block Recognizer. In either case, the characters appear as typed text on 
the screen. 

To show or hide the input panel, tap the Input Panel button. Tap the arrow next to the Input Panel button to see your choices.

Note: The Transcriber tool is located on the Dolphin 9500/9550 Microsoft Companion CD and must be installed separately.

When you use the input panel, your terminal anticipates the word you are typing or writing and displays it above the input panel. 
When you tap the displayed word, it is inserted into your text at the insertion point. The more you use your Dolphin 9500/9550 
terminal, the more words it learns to anticipate.

To change word suggestion options, such as the number of words suggested at one time, tap Start> Settings>Personal 
>Input> Word Completion tab.

Using the SIP

1. Tap the arrow next to the Input Panel button and select Keyboard.

2. On the soft keyboard that is displayed, tap the keys with your stylus.

Using the Letter Recognizer
With Letter Recognizer you can write letters using the stylus just as you would on paper.

1. Tap the arrow next to the Input Panel button and then Letter Recognizer.

Input Panel button.

Select an input method.

Tap to see your choices.

Tap here if this
is the right word.
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2. Write a letter in the box.

When you write a letter, it is converted to typed text that appears on the screen. For specific instructions on using Letter 

Recognizer, with Letter Recognizer open, tap the question mark next to the writing area .

Using the Block Recognizer
With Block Recognizer you can input character strokes using the stylus that are similar to those used on other devices.

1. Tap the arrow next to the Input Panel button and then Block Recognizer.

2. Write a letter in the box.

When you write a letter, it is converted to typed text that appears on the screen. For specific instructions on using Block 
Recognizer, with Block Recognizer open, tap the question mark next to the writing area.

Selecting Text
To edit or format typed text, select it by dragging the stylus across the text. You can cut, copy, and paste text by tapping and 
holding the selected words and then tapping an editing command on the pop-up menu, or by tapping the command on the Edit 
menu.
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Input Panel Options
You can set input options by going to Start > Settings > Personal tab > Input.The following graphics are the tab windows where 
you can customize the input panel to your preferences:

Input Method tab Word Completion tab Options tab
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Writing on the Screen

In any program that accepts writing, such as the Notes program, and in the Notes tab in Calendar, Contacts, and Tasks, you can 
use your stylus to write directly on the screen as you would on paper. 

To write on the screen, tap the Pen button to switch to writing mode. This action displays lines on the screen to help you write.

Note: Some programs that accept writing may not have the Pen button. See the documentation for that program to find out how 
to switch to writing mode.

To Select Writing
If you want to edit or format writing, you must select it first.

1. Tap and hold the stylus next to the text you want to select until the insertion point appears.

2. Without lifting, drag the stylus across the text you want to select.

If you accidentally write on the screen, tap Tools, then Undo and try again. You can also select text by tapping the Pen button 
to deselect it and then dragging the stylus across the screen.

You can cut, copy, and paste written text in the same way you work with typed text: tap and hold the selected words and then 
tap an editing command on the pop-up menu, or tap the command on the Edit menu.

Tap the Pen button and use
your stylus like a pen.
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Drawing on the Screen

Drawing on the screen is similar to writing on the screen. The difference between writing and drawing on the screen is how you 
select items and how they can be edited. 

To create a drawing, cross three ruled lines on your first stroke. A drawing box appears. Subsequent strokes in or touching the 
drawing box become part of the drawing. Drawings that do not cross three ruled lines will be treated as writing.

For example, selected drawings can be resized, while writing cannot.

Note: You may want to change the zoom level so that you can more easily work on or view your drawing. Tap Tools and then 
a zoom level.

Selecting a Drawing
To edit or format a drawing, tap and hold the stylus on the drawing until the selection handle appears. To select multiple drawings, 
deselect the Pen button and then drag to select the drawings you want.

You can cut, copy, and paste selected drawings by tapping and holding the selected drawing and then tapping an editing 
command on the pop-up menu, or by tapping the command on the Edit menu. To resize a drawing, make sure the Pen button 
is not selected, and drag a selection handle.

The drawing box indicates
the boundaries of the drawing.

Pen button.
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Status Icons

Note: The Notification icon  displays if more notification icons need to be displayed than there is room to display them. Tap 
the icon to view all notification icons.

Notifications

Your device reminds you in a variety of ways when you have something to do. For example, if you’ve set up an appointment in 
Calendar, a task with a due date in Tasks, or an alarm in Clock, you’ll be notified in any of the following ways:

• A message box appears on the screen.
• A sound, which you can specify, is played.
• A light flashes on your device. 

To choose reminder types and sounds for your device, tap Start > Settings > Personal tab > Sounds & Notifications. The 
options you choose here apply throughout the device.

Status Icon Meaning

Turns all sounds on and off 

Backup battery is low 

Main batteries are charging 

Main batteries are low 

Main batteries are very low 

Main batteries are full

Synchronization is beginning or ending

Notification that one or more e-mail 
messages were received
Dolphin® 9500/9550 Mobile Computer User’s Guide - GSM Draft 4 - 25



Finding and Organizing Information

The Find feature on your Dolphin mobile computer helps you quickly locate information. On the Start menu, tap Find. Enter the 
text you want to find, select a data type, and then tap Go to start the search.

To quickly find information that is taking up storage space on your device, select Larger than 64 KB in Type.

You can also use the File Explorer to find files on your device and to organize these files into folders. On the Start menu, tap 
Programs, and then File Explorer.

You can move files in File Explorer by tapping and holding the item you want to move, and then tapping Cut or Copy and Paste 
on the pop-up menu.

Tap the folder name
to open it.

Tap and hold to create
a new folder.

Select the sort order
for the list.

Tap to change folders.
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5

D

Settings
Overview

System settings are available off the Start menu. Go to Start > Settings and the system settings screen opens displaying the 
Personal tab. System settings are comprised of the following three tabs:

Personal tab Enables you to customize buttons, input methods, menus, etc. - see Personal Tab on page 5-2.

System tab Enables you to adjust system settings - see System Tab on page 5-5.

Connections tab Enables you to establish network and connection settings - see Connection Settings on page 5-16. 

Personal tab System tab Connections tab
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Personal Tab

To access the Personal tab, go to Start > Settings. The screen opens displaying the Personal tab.

Button Name Tapping this icon enables you to …

Buttons Customize buttons to perform functions. 

To use this setting, the HotKeys HHP Utility must be initialized. Tap Start > HHP Utils > HotKeys 
(the icon is the same). The HotKeys utility initializes. Return to the Personal tab and tap the Buttons 
icon.

Input Customize the input panel. For details, see Input Panel Options on page 4-22.

Menus Customize what appears on the Start menu, and to enable a pop-up menu from the New button. 

Owner Information Enter your contact information.

Password Password protect the terminal to limit access to your device. 

Sounds & Notifications Set the sound volume, enable and disable sounds for specific actions, and set sound parameters for 
system notifications.

Today Customize the look and the information that is displayed on the Today screen

Note: Personal settings are stored in RAM memory. They are replaced by system defaults after each hard reset. For more 
information about resets, see Soft Reset (Warm Boot) on page 2-12.
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Adding a Program to the Start Menu
You can add existing programs you use often, such as File Explorer, to the Start menu for faster access. You are not installing 
the program, just re-routing access to it.

Using System Settings

1. Tap Start >  Settings > Personal tab > Menus >  Start Menu tab.  

2. Tap the check box for the program you want to add and tap OK to save.

3. Tap the Start menu.

4. Verify that the program appears.

Using File Explorer

If you do not see the program listed, you can either use File Explorer on the device to move the program or ActiveSync on the 
desktop computer to create a shortcut to the program and place the shortcut in the Start Menu folder.

Note: We recommend that you Copy and Paste Shortcut so that you do not alter your program configurations by accident. Using 
Copy and Paste Shortcut (as opposed to Cut and Paste) ensures that the program files remain where they need to be for 
the system to find them to perform system functions.

1. Tap Start > Programs > File Explorer, and navigate to the program.
File Explorer opens to My Documents by default; to see a list of all folders, tap the folder name and then My Device. 

2. Tap and hold on the program, then tap Copy on the pop-up menu. 
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3. Navigate to the Windows folder and open the Start Menu (My Device > Windows > Start Menu), tap and hold a blank area 
of the window, and tap Paste Shortcut on the pop-up menu. 

4. Tap the Start menu.

5. Verify that the program now appears.

Using ActiveSync on the Desktop Computer

Here, you are performing the same basic process as on the terminal, except that you are using the Explore (Windows Explorer) 
utility to cut and paste.

1. Open ActiveSync > Explore.

2. Navigate to the program.

3. Right-click on the program and select Create Shortcut. 

4. Select the shortcut, right-click, and select Cut.

5. Navigate to the Start Menu folder (Windows > Start Menu).

6. Right-click on an empty area and select Paste. 

7. On the terminal, tap the Start menu.

8. Verify that program appears. 

For more information, see ActiveSync Help.
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System Tab

The System tab enables you to verify and sometimes alter system parameters. To access the System tab, go to Start > Settings 
> System tab. Tap the appropriate icon to open that system setting.    

About
The About system setting displays specific information about what is loaded on the terminal. It contains three tabs:

Version tab Displays the information about the software, operating system, and processor of the terminal.
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Device ID Displays the information the device uses to identify itself to other computers. It can be important to 
know this information if the Dolphin terminal is going to be part of a networked system of devices.

The name or description can be changed according to the parameters on the screen. The first time 
this screen is opened, it displays the system’s default name and description for the device. The 
Device name is the name used for ActiveSync connection.

Copyrights tab Displays important copyright information.

Backlight
The Backlight system setting enables you to customize backlight functionality for the display. For more information, see Adjusting 
the Backlight on page 4-15.

Clock
This setting sets the system clock. Appointments, scheduled events, and any function on a schedule runs off this setting. You 
need to set the time zone and time after each hard reset; see Setting the Time and Date on page 2-10.

CPU Speed
This system setting enables you to see and change the current speed of the Central Processing Unit (CPU). 

The default is High Speed at 400MHz. Low Speed is 200MHz.
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To change the default, select Low Speed and tap OK. A message appear confirming the changed and now current CPU speed.

Tap OK to save the change.

HHP WLAN Settings
This option  appears on the Settings tab only if an 802.11b radio is installed on the device. For more information, see The Status 
Icon on page 7-10.

IrDA Config
This system setting allows you to verify the IrDA port settings.

The IrDA com port can be disabled to free up a com port. This is useful if, for example, you are using a Bluetooth radio and want 
to connect the terminal to additional Bluetooth devices.

To Disable the IrDA Port

1. Tap Disable IrDA ports. 

2. You receive a message stating that you need to reset the terminal before the change takes effect. Tap OK.

3. Perform a soft reset; see Soft Reset (Warm Boot) on page 2-12.

4. Go to Start > Settings > System tab > IrDA and verify that the screen says “IrDA is now DISABLED.”

Always displays the current status 
of the IrDA port. Enabled is the 
default.
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Memory
The Memory system setting enables you to review and manage both RAM (volatile) and IPSM/Storage Card (non-volatile) 
memory. Access this system setting whenever you receive system messages about memory.

There are three tabs: Main, Storage Card, and Running Programs.

Main tab This tab displays current capacity and usage of the 64MB of on-board, volatile RAM memory. This is 
the memory used for running and storing programs as well as storing program data.  

Total main memory The total memory capacity of current RAM memory.

Storage The part of RAM memory used for storing programs and program data.

Program The part of RAM memory used to run programs.

Fields Under Storage and Memory

Allocated Displays the current MB of memory allocated for Storage and Program use.

In use Displays the total MB of that allocated memory being used in Storage and Program memory 
functions.

Free Displays the total MB of memory available for Storage and Programs use.

To Increase/Decrease RAM Memory

To increase Program or Storage memory, tap, hold, and drag the slider towards the kind of memory you want to increase. The 
three fields adjust automatically; Program memory decrease when you increase Storage memory and vice versa.
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Storage Card tab This tab displays the current capacity and usage statistics of the selected memory type; IPSM or 
Storage Card. Select the memory type from the drop-down list. IPSM is selected automatically.   

IPSM Short for Intel Persistent Storage Manager, this is14MB of on-board Flash memory that is non-
volatile. Because this memory is non-volatile, data or programs stored in IPSM are not affected when 
power is removed. Autoinstall programs, for example, are stored in IPSM so that they are always 
installed at cold-boot startup. 

When IPSM is selected in the drop-down list, the Storage Card tab displays the IPSM memory 
capacity and usage statistics. 

Storage Card You can install additional memory in Dolphin terminals - see Secure Digital Memory Interface on page 
3-8. If a storage card is installed in the terminal, a Storage Card entry appears in the drop-down list.  

Select Storage Card and the Storage Card tab displays the current capacity and usage statistics of 
the installed storage card.

Total storage 
card memory

The total MB of memory capacity of the selected memory.

In use The MB currently being used.

Free The MB that is still available for use. 
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Running Programs tab Displays the software programs currently using Storage memory. 

Check this tab when you are receiving out of memory errors or when the mobile computer is running slowly. 

You can 

• Select a program in the list and tap Stop to stop it from running (and therefore from using memory), or
• Tap Stop All to automatically stop all running programs.

Anytime you stop a running program, it frees up RAM memory. Be advised that, when you stop a program here, any 
unsaved data in that program is lost. To free up memory without risking data loss, return to the running program, save 
your data, and close the application.

Links at the Bottom of the Memory Tabs
At the bottom of all three Memory tabs are two links: 

Remove programs Opens the Remove Programs system setting. For details, see Remove Programs on page 5-13.

Find Enables you to search for large files using storage memory. It opens the Find screen with Larger than 
64KB already selected in the Type field. 

!
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Power
The Power system setting enables you to check the remaining charge of both the main and backup batteries. For more 
information, see Batteries on page 3-10. 

You can also set automatic turn-off times for the terminal to conserve power. When the device is “turned off,” that means that it 
goes into suspend mode. For more information on suspend mode, see Suspend Mode on page 2-12.

Radio Manager
The Radio Manager enables you to see which radios are powered up on the Dolphin terminal. In this system setting, you power 
up and power down radios loaded on the terminal. For details, see The Radio Manager on page 4-18.

Regional Settings
Regional Settings enables you to customize the appearance and formatting to your geographic region. Specifically, you can 
customize numbers (number of decimal places allowed, for example), currency (using the $ or € symbol, for example), time, and 
date. These specifications apply to all screens, including the Today screen.
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The Region tab displays an overview of the region selected in the drop-down list at the top. 

The terminal is loaded with a number of pre-programmed regional settings. Select one from the list. 
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The results appear below. 

To see specific settings or change a specific setting, tap on one of the tabs, make the change and tap OK to save it.

Remove Programs
The Remove Programs settings enables you to remove programs installed on the terminal. Use this setting to troubleshoot when 
you receive messages that the device is out of memory.

The programs removed are removed from RAM memory. Any program (usually *.cab or *.dll files) stored in the Autoinstall folder 
(My Device > IPSM > Autoinstall) will re-install after the next hard reset. 

For information about the Autoinstall process, see Autoinstall on page 2-10.

For information about the hard reset process, see Hard Reset (Cold Boot) on page 2-12.
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To Remove Programs:

1. Tap Remove Programs. In the list, select the program you want to remove. 

2. Tap Remove. The following message appears: 

3. Tap Yes. Wait while the program is removed. 

4. Verify that the program no longer appears in the list.

Memory

The Remove Programs screen displays the total storage memory available. It adjusts automatically when a program is removed 
for quick reference. For more detailed memory information, tap memory of “Adjust memory allocation.” along the bottom margin. 
It opens the Memory system setting. For information about memory settings, see Memory on page 5-8.
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Screen
The Screen setting enables you to re-align the screen at any time. You would need to re-align the screen if tapping buttons or 
icons with the stylus no longer seems to work appropriately. 

To align the screen, tap Align Screen, and follow the instructions. See Align the Screen on page 2-8.

ClearType

Dolphin 9500/9550 displays support ClearType font rendering. ClearType is a Microsoft technology that dramatically increases 
the readability of text on LCD displays. Select the Enable ClearType, tap OK, and perform a soft reset; see Soft Reset (Warm 
Boot) on page 2-12. 

For more information about ClearType font rendering for Pocket PC, visit: http://www.microsoft.com/typography/cleartype/
what.htm?fname=%20&fsize=

Input Options

Tapping input of “Adjust input options to improve speed and accuracy” opens the input panel settings; see Input Panel Options 
on page 4-22.
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Connection Settings

The Connections tab serves as a connections manager for the terminal that enables you to manage your network connections.     

There are three main components:

Beam Enables you to verify and adjust the infrared settings of the IrDA port. For details, see Using Infrared 
on page 6-5.

Connections Enables you to configure your network connections for internet and work, create new connections, 
and set default connections. 

Network Adapters Enables you to configure your network adapters.

Additions to this window

Other items appear on this window if your terminal is configured with specific network software and/or protocols. For terminals 
configured with a GSM/GPRS WWAN radio, this screen contains a link to your GPRS settings. For more information, see GPRS 
Settings on page 9-16.
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Connections Tab
The Connections screen enables you to manage internet, work, and network card connections that the terminal defaults to when 
connecting to the network.   

Internet Settings
When configuring internet settings, make sure that you are prepared with dial-up numbers and other necessary numbers from 
you office network or internet service provider (ISP).

There are two tabs for internet settings: Modem and General.

Modem tab This tab enables you to establish individual modem settings for each internet connection. It leads you 
through a series of screens and tabs that enable you to enter both basic and advanced network and 
dial-up information.

General tab This tab enables you to name or, rather, re-name “Internet Settings” to a name of your own choosing. 
If you enter a new name and tap OK, that name appears in drop-down lists instead of “Internet 
Settings.”  

When connecting to the 
internet, the system 
defaults to the setting 
selected here. The terminal 
is initially set to Internet 
Settings.

When connecting to the 
internet, the system 
defaults to the setting 
selected here. The terminal 
is initially set to Work 
Settings.

The network card connects 
to the setting selected here. 
The terminal is initially set 
to Work.
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To Configure Internet Settings

1. On the Connections tab, select Internet Settings in the first drop-down list, and tap Modify. The Internet Settings screen 
appears displaying the Modem tab. The list in the middle of the screen displays existing internet connections. If you have not 
yet established an internet connection, “New…” appears in the list.  

2. Tap New. The Make a New Connection screen appears.  

3. Complete the fields.

• Enter a name for the connection in the first field. “My Connection” is auto-filled by default. You can type over it with 
the SIP that appears or the using the keyboard. This name identifies this internet connection and  appears in the list 
on the Internet Settings screen.

• Select a modem from the drop-down list. This list displays available COM ports (including IrDA, if enabled).
• Select the appropriate Baud rate for both the modem and the network you’re using.
• (Tap Advanced to enter Port Settings, TCP/IP, and Name Servers; see Advanced Settings on page 5-19.)
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4. Tap Next to enter the phone number for the modem to dial. 

5. Enter the phone number and tap Next.  

6. Enter the parameters, including any extra dial-string modem commands, and tap Finish. You are returned to the Internet 
Settings screen where the new connection name and number appear in the list. You can tap on it any time to edit the 
settings.

Advanced Settings
When making a new connection (see page 5-18) or editing an existing connection, you can tap Advanced to open three tab 
windows that enable you to connect your terminal to an integrated network: Port Settings, TCP/IP, Name Servers.

You should not need to change advanced settings. If you do, verify with your network administrator that you have the correct 
information.
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Port Settings Advanced settings opens to this tab window. On it, enter the parameters for the port the terminal is 
using. 

TCP/IP settings Tap on this tab to configure TCP/IP settings. Server-assigned IP addresses use Dynamic Host 
Configuration Protocol (DHCP). 

Connection preferences

Data Bits • Can be set between 4 and 8

Parity • Can be set to None, Odd, Even, 
Mark, or Space

Stop Bits • Can be set to 1, 1.5, or 2

Flow Control • Can be set to Software, 
Hardware, or None

Terminal settings

Use terminal before connecting

Use terminal after connecting

Enter dialing commands manually

Tap OK to save settings.

You can

• Use the server-assigned IP address 
(recommended) or enter a specific IP address in 
the field provided

• Use Slip

• Use software compression

• Use IP header compression

Tap OK to save settings.
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Name Servers settings Tap on this tab to determine how the terminal connects to servers. Server-assigned IP addresses use 
DHCP.

Work Settings
When configuring work settings, make sure that you are prepared with dial-up numbers and other necessary numbers from you 
office network or internet service provider (ISP).

To access work settings, navigate to the Connections screen (Start > Settings > Connections tab > Connections), select Work 
Settings in the second drop-down list.

There are four tabs for work settings: General, Modem, VPN, and Proxy Settings.

General tab The General tab for Work Settings functions the same way it does for Internet Settings; for more 
information, see page 5-17.

Modem tab The Modem tab for Work Settings functions the same way it does for Internet Settings; for more 
information, see To Configure Internet Settings on page 5-18.

VPN tab The VPN tab enabled you to create virtual private network for your work settings.

Proxy Server tab The Proxy Server tab enables you to connect to the internet via a proxy server. 

You can

• Use the server-assigned IP address 
(recommended) OR 

• Enter a specific server address in the 
fields provided:

• DNS and Alt DNS - enter the 
domain name server address to 
locate the appropriate domain. If 
the domain can’t be found, the Alt 
DNS is tried automatically.

• WINS and Alt WINS - enter the 
appropriate IP address to locate 
the desired server on the 
windows network. If the server 
can’t be found, the Alt WINS 
address is tried automatically.

Tap OK to save settings.
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VPN Tab

1. After the Modem settings have been established, tap on the VPN tab. The Work Settings screen displays with a list of 
connections in the middle of the window. If no connections have been established, only New... appears. 

2. Tap New to make a new connection. 

3. Enter a name for the connection and type the desired IP address. Tap Advanced. The system processes the information and 
the TCP/IP and Name Servers tabs appear.

• See TCP/IP tab on page 5-20 for information about completing this tab.
• See Name Servers tab on page 5-21 for information about completing this tab.

4. Tap OK and you are returned to the VPN tab.
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5. Tap OK again and you are returned to the Work Settings screen, which now lists the new VPN connection. 

Proxy Settings

Proxy setting are most often used when your terminal is connected to a network with a firewall. In this case, you would connect 
to the internet via a proxy server.

To Connect Via Proxy Server

1. Open Work Settings and tap the Proxy Server tab. 

2. Check the first box, then check This network uses a proxy server to connect to the Internet.

3. Enter the Proxy server information in the field provided and tap Advanced. 

4. Complete the fields

• HTTP address and Port
• WAP and Port - enter the wireless access point identifier for the network
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• Socks and Port - if your network uses the circuit-level proxy server. If you enter an address here, the Type field 
activates and you need to select Socks 4 or Socks.

• The User ID and Password fields activate after you have entered the appropriate information. If the fields activate, 
you need to complete both.

5. Tap OK to save and you are returned to the Proxy Server tab.

6. Tap OK again and you are returned to the Work Settings screen, which now lists the new Proxy Server connection. 

Deleting Connections
To delete a connection at any time, you need to navigate to it from the Connections tab. On the Modem tab of either the Internet 
or Work Settings screen, tap and hold on the connection. A pop-up menu appears. 

Select Delete and the connection is deleted.

Creating a Custom Connection
The Dolphin 9500/9550 terminal comes loaded with Internet Settings and Works Settings as options in the drop-down lists on 
the Connections tab. You can create new settings of each type. After they are saved, custom settings appear in the drop-down 
lists on the Connections tab.
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Internet Settings

On the Connections tab, in the first field (for Internet Settings), select New in the drop-down list. The General tab opens so that 
you can name the connection. 

Tap the Modem tab. The Modem tab opens. From there, complete the rest of the process for internet settings. For more 
information, see Internet Settings on page 5-17.

You also have the option of tapping the Proxy Settings tab to have this connection go through a proxy server. For more 
information, see Proxy Settings on page 5-23.

Work Settings

On the Connections tab, in the second field (for Work Settings), select New in the drop-down list. The General tab opens so that 
you can name the connection. 

Tap the Modem tab. The Modem tab opens. From there, complete the rest of the process for setting up a work connection. For 
more information, see Work Settings on page 5-21.
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Connecting
You can test your connection settings on the Connections tab (see page 5-17) any time. In either of the first two drop-down lists 
(Internet and Work), select the desired setting. 

Tap Connect and the terminal begins connecting to the network.

Note: The Connect button is active only when the selected connection setting is valid.
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Network Card Connections
The third field on the Connections tab (see page 5-17) enables you to select the connection setting of your network card. You 
can have your network card use your internet or work settings. 

Tap OK to save settings.
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Network Adapters

On the Connections tab (see page 5-17), tapping Network Adapters enables you to review the adapters installed on the terminal 
and the properties associated with each. 

To see the IP addresses and Name Servers of a network adapter, select one in the list, and tap Properties. Server-assigned IP 
addresses use DHCP. 
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Editing Properties
Any time you open properties and tap OK, the system saves the settings. The following message appears after you tap OK: 

Tap OK again to save any changes.
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D

Communications
Overview 

You can exchange information between your Dolphin 9500/9550 and other mobile devices, a desktop computer, a network, or 
the Internet. You have the following connection options:

• Connect to your desktop computer and synchronize via Microsoft ActiveSync v3.7 or higher.
• Use the infrared (IrDA) port to send and receive files between two devices.
• Connect to your Internet Service Provider (ISP). 

Help on Connecting
More information on the procedures described here, as well as information on additional procedures, can be found in the following 
locations:

• ActiveSync Help on the desktop computer. In ActiveSync, click Help > Microsoft ActiveSync Help.
• See Inbox on page 10-12.
• Online Help on the device. Tap Start > Help > View menu > All Installed Help > Inbox or Connections.

For troubleshooting information, go to the Pocket PC website at: http://www.microsoft.com/windowsmobile/products/pocketpc/

Installing Additional Software
In addition to the default programs installed on your terminal when it is first booted up, you can install any program created for 
your device, as long as your device has enough memory to store it and the program has an  *.exe, *.cab, or *.dll extension. 

The most popular place to find software for your device is on the Pocket PC website (http://www.microsoft.com/mobile/pocketpc/ 

When selecting programs, verify that the program and version of the program are designed for the Pocket PC and your 
device processor type. Determine your device and processor type by tapping Start > Settings > System tab > About. On 
the Version tab, make a note of the information in the Processor field. 

!
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Using ActiveSync

Using Microsoft ActiveSync version 3.7 or higher, you can synchronize information on your desktop computer with your device 
and vice versa. Synchronization compares the data on the Dolphin mobile computer with your desktop computer and updates 
both with the most recent data. 

For example, you can:

• Update the information in Microsoft Pocket Outlook® on your device by synchronizing it with Microsoft Outlook on your desktop 
computer. 

• Synchronize Microsoft Word and Microsoft Excel files between your device and desktop computer. Your files are automatically 
converted to the correct format.

The most current version of ActiveSync can be downloaded from www.microsoft.com.

Capabilities
With ActiveSync, you can also:

• Back up and restore your device data. 
• Copy (rather than synchronize) files between your device and desktop computer.
• Control when synchronization occurs by selecting a synchronization mode. For example, you can synchronize continually 

while connected to your desktop computer or only when you choose the synchronize command.
• Select which information types are synchronized and control how much data is synchronized. For example, you can choose 

how many weeks of past appointments you want synchronized.

Note: By default, ActiveSync does not automatically synchronize all types of information. Use ActiveSync Options to specify the 
types of information you want to synchronize. The synchronization process makes the data (in the information types you 
select) identical on both your desktop computer and your device.

Requirements
To synchronize, ActiveSync version 3.7 or higher must be on both your desktop computer and your device. ActiveSync 3.7 is 
already installed on your device. Therefore, you must install ActiveSync 3.7 on your desktop computer from the Microsoft 
Companion CD that came with your terminal.    

To install ActiveSync on your desktop computer, insert the Microsoft Companion CD into the CD-ROM drive of your desktop 
computer. Click the yellow arrow, click Start Here, then follow the directions on your screen.

When communicating via ActiveSync, your terminal must be connected to the host PC with a peripheral device sold/
manufactured by HHP, such as the Dolphin HomeBase, Dolphin Mobile Base, Dolphin ChargeBase, Dolphin Net Base, 
or other Dolphin 9500 series charging/communication cable. Use of any peripheral not sold/manufactured by HHP may 
damage your terminal and will void the warranty.  

For more information about communication peripherals, see Dolphin 9500/9550 HomeBase on page 11-1 and Dolphin 9500/
9550 Mobile Base on page 12-1.

Setting Up Your Desktop Computer
When installation of ActiveSync is complete on your desktop computer, the ActiveSync Setup Wizard helps you 

• connect your device to your desktop computer, 
• set up a partnership so you can synchronize information between your device and your desktop computer, and 
• customize your synchronization settings. 

Synchronizing from Your Desktop Computer
Because ActiveSync is already installed on your device, your first synchronization process begins automatically when you finish 
setting up your desktop computer in the wizard and your terminal is connected to the host PC. 

After your first synchronization, look at Calendar, Contacts, and Tasks on your device. Notice that the same information from 
Microsoft Outlook on your desktop computer is now on your device, and you didn’t have to type a word. Simply disconnect your 
device from your computer and you’re ready to go!

For more information about using ActiveSync on your desktop computer, open ActiveSync, then open ActiveSync Help.

!
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Synchronizing from Your Device
ActiveSync must be setup on your desktop computer and the first synchronization process completed before you initiate 
synchronization from your device.

To initiate synchronization from your device, tap Start, then ActiveSync to begin the process. 

Note: If you have a wireless LAN card, you can synchronize remotely from your device.

Adding Programs to the Terminal Using ActiveSync
The software application must be stored or installed on the host PC. Some programs are installers and install on the PC and the 
terminal at the same time. Some programs designed for terminals cannot be installed on PCs. In those cases, the appropriate 
files must be stored on the host PC, transferred via ActiveSync, and installed on the terminal.

When selecting programs, verify that the program and version of the program are designed for the Pocket PC and your 
device processor type. Determine your device and processor type by tapping Start > Settings > System tab > About. On 
the Version tab, make a note of the information in the Processor field. 

1. Download the program to your desktop computer from either the Internet or the CD or disk that contains the program. You 
may see a single *.exe or setup.exe file, a *.cab file, or *.dll. There may also be several versions of files for different device 
types and processors.

2. Read any installation instructions, Read Me files, or documentation that comes with the program. Many programs provide 
special installation instructions.

3. Connect the terminal to the host PC via an HHP communication peripheral.

If the File is an Installer:

4. Double-click the *.exe or *.setup.exe file. The installation wizard begins. Follow the directions on the PC screen. The 
installation process includes transferring the software to the terminal. 

Tap to connect and synchronize.

View synchronization status.

Tap to synchronize via IR or
change synchronization settings.

View connection status.

Tap to stop synchronization.

!
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If the File is Not an Installer:

5. An error message appears stating that the program is valid but designed for a different type of computer. You need to 
manually transfer this file to the terminal. 

6. If you cannot find any installation instructions for the program in the Read Me file or documentation, open ActiveSync and 
click Explore.*

7. Navigate to the My Pocket PC folder and copy the program file or files to the Program Files folder on the terminal. 

• If you want the program to be part of the Autoinstall that occurs after every hard reset, place the program file in the 
Autoinstall folder (My Pocket PC > IPSM > Autoinstall).

8. Depending on the program, you may need to open File Explorer on the terminal, navigate to the folder where the program is 
located, and tap on the program file to install it.

• If you copied the file to the Autoinstall folder, you can either tap on the program inside the Autoinstall folder or perform 
a hard reset and the program will install as part of the regular Autoinstall; see Autoinstall on page 2-10. Remember, a 
hard reset erases RAM data! For more information, see Hard Reset (Cold Boot) on page 2-12.

After installation on the terminal is complete, tap Start > Programs and the program and its icon appears on the Programs 
screen. Tap it to open the program.
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Using Infrared

Dolphin 9500/9550 terminals contains infrared or IrDA ports on the left side panel (see IrDA Port on page 3-8). Using these ports, 
you can send and receive data between the terminal and other devices equipped with infrared. This can include, but is not limited 
to, Pocket PC information such as Contacts and Tasks, as well as software upgrades.

Verify That the IrDA Port is Enabled
The IrDA port must be enabled to transmit data. By default, the IrDA port is assigned to com port 6 and is enabled. It can be 
disabled to free up a com port. 

Verify that the IrDA port is enabled before attempting to transmit data via infrared. Go to Go to Start > Settings > System tab > 
IrDA Config.
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Verify That Beam Settings Are Set to Receive
The Beam Settings must be set to receive for the terminal to receive data from other infrared devices. To verify, tap Start > 
Settings > Connections tab > Beam. The Beam Settings window should appear as follows:   

Sending and Receiving Information

Sending:

1. Align the IR ports so that they are unobstructed and within a close range.

2. Open the program where you created the item you want to send and locate the item in the list.
You can also beam files, but not folders, from File Explorer. 

3. Tap and hold the item. A pop-up menu appears. 

4. Select Beam File.

Receiving:

1. Align the IR ports so that they are unobstructed and within a close range.

2. Have the owner of the other device send the information to you. Your device automatically receives it.

Selected item

Pop-up menu
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Troubleshooting
If the Beam Settings are not set to receive or you’ve aligned two IrDA ports and the terminal is still not receiving, go to Start > 
Programs > Infrared Receive. The terminal searches for the sending device. 

If the terminal cannot find the sending device, the following message appears:
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Using an ISP

The communication software for creating an ISP connection is already installed on your device. Your service provider should 
provide the software needed to install other services, such as paging and fax services.

After you are connected, you can send and receive e-mail messages by using Inbox and view Web or WAP pages by using  
Pocket Internet Explorer. For more information, see Inbox on page 10-12. You can also download software applications from the 
web.

Adding Programs Directly from the Internet
When selecting programs, verify that the program and version of the program are designed for the Pocket PC and your 
device processor type. Determine your device and processor type by tapping Start > Settings > System tab > About. On 
the Version tab, make a note of the information in the Processor field. 

1. Determine your device and processor type so that you know which version of the software to install. Go to Start > Settings > 
System tab > About. On the Version tab, make a note of the information in the Processor field.

2. Download the program to your device straight from the Internet using Pocket Internet Explorer. You may see a single *.exe or 
setup.exe file, or several versions of files for different device types and processors. 

3. Read any installation instructions, Read Me files, or documentation that comes with the program. Many programs provide 
special installation instructions.

4. Tap the file, such as an *.exe file. The installation wizard begins. Follow the directions on the screen.

For more information about working with Pocket Internet Explorer, see Pocket Internet Explorer on page 10-17.

!
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7

D

Wireless LAN Communications with 802.11b 
Overview

Dolphin 9500/9550 terminals are available with an on-board 2.4 GHz 802.11b (Wireless Local Area Network) WLAN radio that 
uses Direct Sequence Spread Spectrum (DSSS) technology to spread the signal continuously over a wide frequency band. It 
provides a data rate of up to 11 Mbps. In addition, the open software architecture makes the Dolphin 9500/9550 a complete 
solution for a variety of wireless mobile data collection applications.

The Dolphin 9500/9550 is interoperable with other 802.11b WiFi-compliant products including access points, printers, PCs via 
PC-card adapters and other wireless portable terminals.

Powering Up the 802.11b Radio Driver
When the mobile computer is first initialized, the radio driver for the 802.11b module is installed. Before using the radio, make 
sure that the 802.11b radio is powered up. For more information, see The Radio Manager on page 4-18.
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Configuring the 802.11b Radio

Dolphin 9500/9550 terminal loaded with an 802.11b radio contain a configuration utility that enables you to enter and save the 
optimal transmission settings.

Accessing the Configuration Utility
You can access the configuration utility two ways:

1. Tap Start > Settings > System tab > HHP WLAN Settings .
This icon appears on the System tab only if there is an 802.11b radio installed on the terminal.

2. Tap the Status icon  - see The Status Icon on page 7-10.

The Configuration Utility
The configuration utility consists of four tabs: Status, Config, Advanced, and About. Each tab is described in its own section in 
this chapter.

Status Tab
HHP WLAN Settings always opens to the Status tab, which displays the current WLAN settings for 802.11b. 

Current Channel Shows the RF channel currently used by the card.

Current TX Rate Shows the current transmit rate. This can be 1 Mbps, 2 Mbps, 5.5 Mbps, or 11 Mbps.

Link Quality Gives signal to noise ratio in both percentage and graphical display.

Strength Gives signal strength of the receiver in both percentage and graphical display.

Station IP Info IP Address - IP address of the radio. Check with your network administrator for IP configuration 
information. 

IBSS ID Shows the Network Name and the MAC address of:  

- the access point the card is associated with in AP mode, or 

- the creator of IBSS into which the card is joined in peer-to-peer (Ad-Hoc) mode.
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Disable/Enable Radio Tap this button to toggle to disable/enable the radio link from the card.

Rescan Tap this button to start a rescan process to search for an AP with a stronger signal in the network.

Renew IP Tap this button to reapply IP the address from the DHCP server when automatic DHCP is enabled. 

More Info Tap this button to display detailed TCP/IP info; as shown in the following screen: 

Ping Tap this button to open the Ping utility for WLAN.

Field Description

IP Address Displays the current IP address. You can enter another IP address to ping. 

Size (Bytes) Displays the current bytes size; 32 is the default. You can select up to 8192 
from the drop-down list.
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Config Tab
The Config tab provides a list of all access points and peer stations in range. Its configuration tool enables you to create and edit 
SSID profiles for access points that you want your station to associate with. 

Preferred Profiles A list of preferred profiles for access points (AP) in the network created by the user, or added from 
the Active SSIDs table is located at the top of the Config window. When the radio is turned on, it 
searches for the APs with which to associate in the order of the listed profiles. For each profile in the 
table, one can make changes by using the icon tools at top of the table: New, Edit, Delete, Up, and 
Down (- the creator of IBSS into which the card is joined in peer-to-peer (Ad-Hoc) mode. on page 7-
2). This table is blank after the initial HHP software installation. It can be kept blank with no automatic 
association preference.

Active SSIDs The Active SSIDs table lists all access points or peer stations (creator of IBSS) in the vicinity of the 
host. It displays only those SSIDs that accept broadcast associations.

Each record displays information in the following six fields (The screen may not display all the fields 
in the following table. Use horizontal scroll bar to check all): 

Timeout (ms) Displays the current timeout; 500 is the default. Increase or decrease it by 
tapping the up and down arrow buttons.

Clear Tap this button to clear IP Address input and the ping statistics field. 

Ping Tap this button to ping the IP address entered in the input field. 

Ping Statistics field: Shows the pinging IP address and the pinging results.

Column This column displays…

SSID The Network Name of the access point or peer station. An icon with signal 

strength  is also shown.

Signal  Strength in percentage for that SSID.

Mode
An icon shows whether it is an access point , or a peer station .

Field Description
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Apply Tap Apply to associate your station with the SSID you selected. 

This SSID can be either from the Preferred Profile table or from the Active SSIDs list. When applied, 
the Status tab window displays the status of the wireless connection. If the association failed, a 
search for another AP in the Preferred Profile list automatically takes place, and the radio attempts to 
associate with the station, in order of preference.

Refresh Tap Refresh to start a new search for all available access points or peer stations in the vicinity.

Adding an Active SSID Profile to the Preferred Profile Table

1. Select an SSID from the Active SSID list.

2. Tap Add.
If the SSID has WEP Key-On, the Settings window displays and prompts you to enter the WEP Method, Encryption Key, and 
Key ID. 

3. Tap OK in the Settings window after finishing the configuration. The SSID and its profile are added into the Preferred Profiles 
window. 
If adding an SSID with WEP Key Off, the Settings window does not display and the SSID is added directly to the Preferred 
Profile table when you tap the Add button. 

Channel The channel it uses and the WEP method it applies, if any. The icon  

stands for WEP Key-On, and  for WEP Key-Off.

SupRate Supported data rate of the access point or the peer station.

BSSID (MAC Addr) BSSID or MAC Address of the access point or the peer station.

Column This column displays…

SSID The Network Name of the access point or peer station. An icon with signal 

strength  is also shown.
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Preferred Profile Icons

You can complete a number of tasks to manage your Preferred Profiles using the five icons at the top of the window:    

To Create a New Profile

1. Tap the New button and the following screen displays:

2. Enter the values for the new profile in the information fields and tap OK.

Icon Name Tap this icon to…

New  Create a profile.

Edit  Modify a profile.

Delete Delete a selected profile.

Up Move the highlighted profile up to increase the automatic association priority.

Down Move the highlighted profile down to decrease the automatic association priority.
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To Modify a Profile

Select one and tap the Edit icon. The following screen displays:

SSID To enter an SSID, which is the Network Name. Check with your network administrator for Network 
Name (SSID).

Type Choose Peer-to-Peer or Access Point from the drop-down list. Peer-to-Peer mode is used for 
communication between two (or more) radio stations (cards) without an access point. Access Point 
mode is also called “Infrastructure” mode. 

TX Rate Choose the transmit rate from the drop-down list - 1MB, 2 MB, Auto 1/2 MB, 5.5 MB, 11 MB, or Fully 
Auto. The transmit rate is set to Fully Auto by default.  

Chan Scroll to select a channel for communication. 

WEP Parameters In this section, you configure the WEP Key for secure wireless communication. Within this block, you 
configure the WEP Method, Encryption Key, and Key ID. 

Use Manual Key Manually input the encryption code for the WEP Key. This is the default setting.

WEP Method The options in this drop-down list determine what characters can be used to create the Encryption 
Key. Select one of the following five: 

Encryption Key Character sets differ depending on the selected WEP method and key format.

Key ID Choose from the available options: Key 1 (Default), Key 2, Key 3, or Key 4. Check with your network 
administrator for the WEP Key and Key ID you need to use.

Cancel Tap this button to close the window without saving or modifying the profile.

OK Tap this button to make the change.

Note: The SSID, Type, TX Rate, and Channel fields are unchangeable in Access Point mode, whereas TX Rate and Channel 
fields can be changed in Peer-to-Peer mode.

Option This option means that …

Disabled WEP Key Off

64 bit (HEX) up to 10 characters are configurable in Hexadecimal for Encryption Key

64 bit (ASCII) up to 5 characters are configurable in ASCII for Encryption Key

128 bit (HEX) up to 26 characters are configurable in Hexadecimal for Encryption Key

128 bit (ASCII) up to 13 characters are configurable in ASCII for Encryption Key

HEX - Hexadecimal is a set of 16 characters from 0-9 and from A(a)-F(f).

ASCII - ASCII means any printable ASCII character can be typed.
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To Delete a Profile

Profiles may be deleted either from the Preferred List or from the Preferred List and Registry. To delete a profile, select (highlight) 
a profile and tap the Delete button and the following screen displays:

From the pop-up window select the option of your choice and tap Yes to confirm or No to cancel. 
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Advanced Tab
On the Settings window, tap the Advanced tab. The following screen displays: 

Power Save Mode

Disable Choosing this option disables the Power Save mode.

Always Enable Choosing this option makes the Power Save mode always enabled. This is the default setting.

Auto Enable Choosing this option means that the Power Save mode is automatically enabled when the internal 
battery powers the terminal and automatically disabled when an external power supply powers the 
terminal.

Preamble Mode

Long TX Preamble Where Sync field consists of 128 bits. 

Short TX Preamble Where Sync field consists of 56 bits.

Auto TX Preamble Automatically change between long and short preamble mode transmission based on the AP 
configurations. This is the default Preamble Mode.
A Preamble consists of a Synchronization (Sync) field and a 16-bit Start Frame Delimiter (SFD) field.

Authentication Algorithm

This drop-down list is active and configurable only when the WEP Key is enabled for the selected SSID profile.

Automatic based on WEP setting Default setting.

WECA Compliant (always use Open)Not available in this release.

Must use Shared with WEP AP must use WEP method.

Defaults Resets all the settings to default values (Always Enable for Power Save Mode, Automatic based on 
WEP setting for Authentication Algorithm, and Auto TX Preamble for Preamble Mode).

Apply Applies the change to new card setting.
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About Tab
This window provides Version Number and time of build for Network Driver, Configuration Utility, and NIC Firmware. 

On the Settings window, tap the About tab. 

The Status Icon

You access the 801.11b configuration utility by tapping and holding on the Status icon  in the task tray at the bottom of the 
screen. However, you must activate this icon before it appears. 

To Activate the Status Icon

1. Tap Start > Programs.

2. Tap the HHP WLAN Settings icon .
This icon appears on the Programs window only if an 802.11b radio is installed.

3. The Status icon is now active in the bottom tray. When you tap it, a menu of configuration options appears.
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The Status Icon Menu

When you tap the Status icon in the bottom tray, the following menu displays:

Note: The Status Icon changes to a crossed lock  as a warning that you may have entered a wrong key (WEP Key mismatch) 
for the WEP-On AP or a station.

Menu Option Selecting This Option…

Wireless Radio On Turns on the radio. LED is on and the Link Icon displays with signal strength.

Wireless Radio Off Turns off the radio. A pop-up window will ask for your confirmation. If confirmed, the LED 
will be off and the Status icon will change color from green to red on the top without signal 
strength displayed. The WLAN card/module will stop functioning. 

Remove Status Icon Removes the Status Icon from the 
bottom tray. A pop-up window asks 
you to confirm. Click Yes to confirm, 
or No to cancel. 

If confirmed, the Status icon does 
not display in the task tray, and you 
need to go to Start > Programs > 
HHP WLAN Settings to access the 
configuration utility. 

Wireless Network Status Opens the Status tab of the configuration utility; see Status Tab on page 7-2.

Configuration Opens the Config tab of the configuration utility; see Config Tab on page 7-4.

Advanced Configuration Opens the Advanced tab of the configuration utility; see Advanced Tab on page 7-9.

Version Information Opens the About tab of the configuration utility; see About Tab on page 7-10.
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Wireless Security Supplement

AEGIS Client® offers the most comprehensive IEEE 802.1X supplicant for securing wired and wireless networks. The Client is a 
standards-based implementation of IEEE 802.1X and can be configured to work with almost any network equipment - wired or 
wireless - that supports the 802.1X authentication standard. The Client is interoperable with 802.1X-capable wireless access 
points and authentication servers including Microsoft's IAS and Cisco's ACS.

Installing the AEGIS Client Software

Preparation

Installing and configuring AEGIS Client software usually takes less than 15 minutes, provided you have the required equipment, 
software, and configuration information. You need clear information from the network administrator about how the network’s 
authentication works. Worksheets are provided below.

System Requirements

You need the following equipment and software to run AEGIS Client:

• A computer with a network interface card and/or wireless network interface card that support the NDIS 5.1 standard for 802.11 
WLAN object identifiers (OID). Be sure your wireless card is installed! The AEGIS Client software installation routine 
expects to find your computer’s wireless card properly installed, even if it isn’t connected to a network. If the card isn’t in the 
computer, the installation program can’t make the proper program and protocol associations.

• The appropriate version of the AEGIS Client software package for your operating system. Contact HHP for the correct version 
for your company.

Supported Operating Systems

There are several versions of AEGIS Client software for computers using a wide variety of operating systems. However, specific 
capabilities of a particular version of AEGIS Client may vary. This is due to varying levels of support for different EAP types by 
manufacturers. Drivers for some types of network hardware and operating system combinations don’t support as many EAP 
types as others combinations.

The Windows AEGIS Client software requires Pocket PC 2002, CE.NET 4.1, or higher.

Required Network Configuration Information Worksheets

The worksheets on the following pages help you prepare to install and configure the AEGIS Client.

Each worksheet provides space to record the AEGIS Client configuration information required to set up the client software to 
match a specific Extensible Authentication Protocol (EAP). The forms are designed so that hard copies can be filled out, copied, 
and distributed.

The client software supports the following EAP authentication methods:

• MD5
• LEAP
• TLS/SmartCard
• TTLS
• PEAP

There is a worksheet for each method. Complete the worksheet for the method you choose.
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MD5 Worksheet

To configure AEGIS Client to use MD5 authentication, you need to know:

1. Will you use your Windows user name and password for network authentication? (Applies only to Windows clients.)

2. If not, what is your unique user name/password combination?

If a second set of credentials is required, you need to know the exact user name and password. These are typically case-
sensitive.

User name: _______________________________________

Password: ________________________________________

LEAP Worksheet

To configure AEGIS Client to use LEAP authentication, you need to know:

1. Will you use your Windows user name and password for network authentication? (Applies only to Windows clients.)

2. If not, what is your unique user name/password combination?

If a second set of credentials is required, you need to know the exact user name and password. These are typically case-
sensitive.

User name: _______________________________________

Password: ________________________________________

TLS/SmartCard Worksheet

To configure AEGIS Client to use TLS/SmartCard authentication, you need to know:

1. Is a client certificate required?

____ No.

____ Yes. This file needs to be installed on your machine by your network administrator.

2. Should the AEGIS Client validate the server certificate chain?

____ No. Skip Questions 3-4.

____ Yes. 

3. Will the server accept any trusted Certificate Authority (CA), or is a particular CA required?

____ Any trusted CA is acceptable.

____ A particular CA is required:________________________

4. Are intermediate certificates allowed?

____ No.

____ Yes.

5. What is the name of the server? _____________________________
This usually includes the server’s domain, for example: server.big_school.edu. 
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TTLS Worksheet

To configure with TTLS authentication, you need to know:

1. Use Windows user name and password for authentication? (Applies only to Windows clients.)

2. If not, what is your unique user name? If a second set of credentials is required, you need to know the exact user name. This 
is usually case-sensitive.

User name:_______________________________________

3. Is a client certificate required?

____ No.

____ Yes. This file needs to be installed on your machine by your network administrator.

4. What is the user name (identity) and password for the tunnel authentication?

User name:_______________________________________

Password:________________________________________

5. What is the tunnel authentication protocol?

____ CHAP (Challenge Handshake Authentication Protocol)

____ MS-CHAP (Microsoft CHAP Extensions)

____ MS-CHAP v2 (Microsoft CHAP Extensions v. 2)

____ PAP

____ EAP-MD5

6. Is a server certificate is required?

____ No.

____ Yes.

7. Should the Aegis Client validate the server certificate chain?

____ No. Skip Questions 8-9.

____ Yes.

8. Will the server accept any trusted Certificate Authority (CA), or is a particular CA required?

____ Any trusted CA is acceptable.

____ A particular CA is required: _______________________

9. Are intermediate certificates allowed?

____ No.

____ Yes.

10. What is the name of the server?

This usually includes the server’s domain, for example: server.big_school.edu. _____________________________
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PEAP Worksheet

To configure AEGIS Client with PEAP Authentication, you need to know:

1. Use Windows user name and password for authentication? (Applies only to Windows clients.)

2. If not, what is your unique user name? If a second set of credentials is required, you need to know the exact user name. This 
is usually case-sensitive.

User name:_______________________________________

3. Is a client certificate required?

____ No.

____ Yes. If it is, this file needs to be installed on your machine by your network administrator.

4. What is the user name (identity) and password for the tunnel authentication?

User name:_______________________________________

Password:________________________________________

5. What is the tunnel authentication protocol?

____ MS-CHAP v2 (Microsoft CHAP Extensions v. 2)

____ EAP TLS/SmartCard

____ Generic Token Card

6. Is a server certificate is required?

____ No.

____ Yes.

7. Should the Aegis Client validate the server certificate chain?

____ No. Skip Questions 8-9.

____ Yes. 

8. Will the server accept any trusted Certificate Authority (CA), or is a particular CA required?

____ Any trusted CA is acceptable.

____ A particular CA is required: _______________________

9. Are intermediate certificates allowed?

____ No.

____ Yes.

10. What is the name of the server?

This usually includes the server’s domain, for example: server.big_school.edu. _____________________________
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Configuring the Pocket PC Client 
Because AEGIS Client enables your terminal to access a network that is protected by the IEEE 802.1X protocol, you must 
configure EAP data communication to match your network server parameters. If the EAP configuration doesn’t match your 
network configuration, you can’t access the network. 

1. On the terminal, open the client by going to Start > Programs > Meetinghouse AEGIS Client. The Main screen opens 
displaying a list of ports on the system’s network interface cards, You manage ports on this screen.

2. Tap the Client menu and select Configure. The Configuration Authentication screen appears displaying the User tab.

3. On the User tab

Port Status icon
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• In the Identity field, enter your network login or user name.
• In the Password field, enter your network password.
• If your network requires client certificates, select the Use certificate option and complete the information.

• If the Authentication Type is PEAP or TTLS, select the Tunneled authentication option and enter the appropriate 
Identity, Password, and Protocol.

4. For most installations, you would skip the System tab, which controls system logging of network problems. Unless your set-
up requires custom logging, accept the default logging settings. For more information, see System Settings Tab on page 7-
20.

5. Tap the Server tab. 

6. Depending on your authentication type, the Server tab 

• may be entirely grayed-out (for instance, if you use MD5 authentication), or 
• you may need to enter server-related information that you’ve already gathered on your worksheet (for TLS, TTLS, and 

PEAP).

7. When you’ve entered the server information, tap OK to save the configuration and close the window.

Running AEGIS Client
After you finish the initial configuration, tap the network interface and select Start (if the port is already active, select Stop first, 
then Start to force the program to read the new configuration file). On the main screen, you should see the port color and status 
change as the port starts authentication, negotiates with the access point and/or authentication server, and then joins the 
network.

As the network interface starts or stops, the color of the port icon and the status field in the Interface List updates to reflect the 
current state of the interface.

Port Status Icon Table

Icon Color This color icon indicates that …

Gray
The port is not in use or is disabled.

Either the AEGIS Client isn’t running, or the port is not bound to 
the 802.1X protocol.
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Configuring the AEGIS Client Software
Configuration takes place at several levels:

• First, each interface that interacts with the AEGIS Client may need to be configured. 
• Second, each user account on the computer needs its own unique authentication settings. Because Pocket PC devices are 

usually small devices with a single NIC and, usually, a single user, the initial configuration is usually the only time the software 
needs to be set up. The Client will need to be reconfigured if the device is used on multiple networks, or if different users share 
the computer. 

• Third, each port may need to have its default settings changed.

The Configuration screen has three tabs: 

1. User settings tab - where you configure the authentication credentials.

2. System settings tab - where you set the level of detail that the Client will provide in the system log.

3. Server identity tab - used only for the TLS, TTLS, and PEAP authentication methods. It tells the Client what server 
credentials to accept from the authentication server to verify the server. 

Orange The port is associated, but there is no response to 802.11b 
packets.

Blue There is no 802.11b activity.

Green Authentication succeeded.

Yellow Authentication is in process.

Red Authentication failed.

Port Status Icon Table

Icon Color This color icon indicates that …
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User Settings Tab

The User settings tab defines the protocol and the credentials used to authenticate a user.

Identity The 802.1X identity supplied to the authenticator. The identity value can be up to 63 ASCII characters 
and is case-sensitive. In TTLS and PEAP, it is recommended that this field not contain a true identity, 
but instead the identity “anonymous”, and any desired realm (e.g. anonymous@myrealm.com).

Password The password used for MD5-Challenge or LEAP authentication. It may contain up to 63 ASCII 
characters and is case sensitive. 

Authentication Valid entries are MD5-Challenge, LEAP, PEAP, TLS, or TTLS authentication.

Certificate The client certificate used with TLS or if TTLS or PEAP is selected and optional client authentication 
is activated. When specifying a client certificate, do not enable strong private key protection. If you 
enable strong private key protection for a certificate, an access password must be entered for the 
certificate each time it is used. This means the 802.1X service will fail authentication because it is 
invoked by the computer before a user is logged on, which means that a password won’t be provided.

Use certificate area This box is an option for TTLS and PEAP. It causes the AEGIS Client to make the client certificate 
specified in the “Client Certificate” box available to the RADIUS server for an optional verification. 

Tunneled authentication area

The following Tunneled Authentication parameters are used by only by TTLS and PEAP protocols, in phase 2 of authentication, 
and after the secure tunnel has been established. 

Identity The user identity used in phase 2 authentication. The identity specified may contain up to 63 ASCII 
characters, is case-sensitive and takes the form of a Network Access Identifier, consisting of <name 
of the user>@<user’s home realm>. The user’s home realm is optional and indicates the domain to 
which the tunneled transaction is to be routed.

Password The password used for the tunneled authentication protocol specified. It may contain up to 63 ASCII 
characters and is case sensitive. 

Protocol This parameter specifies the authentication protocol operating within the secure tunnel. The following 
protocols are presently supported for TTLS: EAP-MD5, CHAP, PAP, MS-CHAP and MS-CHAP-V2. 
For PEAP the supported protocols are EAP-TLS, EAP-MS-CHAP-V2, and GTC.
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System Settings Tab

The System Settings tab controls logging and the port manger timeout period.

Log Level These settings control the detail of the log messages generated by the AEGIS Client. By default, all 
errors, warnings, and information events are logged. Each entry records a severity code (of one 
[debug message] to four [error] asterisks), a time stamp, and a message.

Logs fill memory quickly, especially if the Debugging level is chosen. Do not use the Debugging option 
for a significant length of time because most internal operations generate messages.

Port Manager Timeout The interval at which the client polls the ports. This is used under different circumstances, for instance 
after physical changes such as card removal or insertion have been detected. This value should not 
be changed from the 10-second default unless so advised by Meetinghouse technical support.
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Server Identity Tab

The Server identity tab defines the credentials the client uses to authenticate the server during TLS/TTLS/PEAP authentication 
message exchange. AEGIS Client uses the information entered on this screen to verify that the Client is communicating with a 
trusted server.  

Do not validate server certificate chain

When the server certificate is received during the TLS/TTLS/PEAP message exchange, it is not 
validated.

Certificate issuer must be 

The server certificate received during TLS/TTLS/PEAP message exchange must be issued by the 
certificate authority selected in this field. Both trusted intermediate certificate authorities and root 
authorities whose certificates exist in the system store are available for selection in the drop-down 
list. If Any Trusted CA is selected, any Certificate Authority (CA) in the drop-down list can be used 
during authentication.

Allow intermediate certificates

Selecting this option enables a number of unspecified certificates to be in the server certificate chain 
between the server certificate and the certificate authority indicated in the Certificate issuer must 
be field. This allows the server certificate received during negotiation to be issued directly by the 
certificate authority indicated in the Certificate issuer must be field or by one of its intermediate 
certificate authorities. If disabled, then the selected Certificate issuer must be must have directly 
issued the server certificate.

Server name must be The server name, or a domain to which the server belongs, depending on which of the two fields 
below has been checked.

Must match exactly When activated, the server name entered must match exactly the server name found on the 
certificate.

Must contain domain name

When activated, the server name field identifies a domain and the certificate must have a server name 
belonging to this domain or to one of its sub-domains (e.g., zeelans.com, where the server is 
blueberry.zeelans.com).
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Port Setting Menus
To see or manage the wireless cards or Ethernet NICs controlled by the Client, go to Start > Programs > Meetinghouse AEGIS 
Client. The Main menu contains a list of wireless and NIC adapters (ports). Tapping a port brings up a menu that allows the port 
to be enabled or disabled, configured, or deleted. 

Two menus are available from this screen: the Port menu and the Client menu.

Port Menu

To open the Port menu, tap and hold on a port on the main screen.

These commands allow the port to use 802.1X authentication, change the port configuration, and remove it from the port list. The 
Port menu commands are:

Enable and Disable These commands enable or disable 802.1X authentication on the port. The port itself is not turned off 
or on; to do that, use the Windows Network Connections control panel. 

Configure Opens the port configuration screen.

Delete Removes an adapter from the port list. When the 802.1X protocol binds to an adapter, it is added to 
the port list. This usually happens when the adapter is in the device and the Client software is 
installed, or Install Protocol is selected from the Client menu.

i

7 - 22 Dolphin® 9500/9550 Mobile Computer User’s Guide - GSM Draft



Client Menu

To open the client menu, tap Client in the command bar along the bottom of the window.

Close Closes the Client's interface, while leaving the client running. 

Start/Stop Starts or stops 802.1X authentication. 

Restart Same as a Stop followed by Start. 

Configure Opens the Configuration screen displaying the User tab. 

Install Protocol Selecting this option binds the 802.1X protocol to the WLAN adapter currently installed on the device. 
The WLAN adapter then appears in the port list. For more information about network adapters, see 
Network Adapters on page 5-28.

Exit Terminates the client, which stops the 802.1X protocol.
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Port Setting Parameters
Port settings parameters rarely need to be modified from their defaults. In most cases, you should modify these settings only if 
advised to by technical support. Port Settings are global to all ports. 

To open the Port Settings screen, select any adapter in the port list, tap and hold, then select Configure on the Port menu. The 
Port Settings screen is displayed.

Protocol Settings These are the timer intervals and retry settings defined in the 802.1X standard supplicant protocol 
specification. They determine how long the supplicant state machine will wait in a given state. These 
parameters shouldn’t be modified without an understanding of the supplicant state machine. For more 
information about the supplicant state machine, obtain its 802.1X protocol specification. 

The parameters are:

• Authentication Timeout. The period of time the Client remains in the authenticating or acquired state without 
receiving a response from the access point or switch. 

• Held Timeout. The period of time the Client remains in the held state after failing authentication. 
• Start Timeout. The period of time the Client remains in the connecting state before restarting when there is no 

response. 
• Number of Start Attempts. The number of times the Client restarts before giving up. At that point, the Client then 

defaults to the authenticated state, but there will be no network connectivity because the protocol exchange was never 
completed.

The Interface Options are:

Display EAP notifications

This specifies that the EAPOL notification message will be displayed to the user. An authenticator 
may use such notification to inform you, for example, about a near password expiration. However, 
some authenticators send chatty and annoying notifications that may, for the convenience of the user, 
be suppressed. Note that all notifications are written to the event log even if they are not displayed.

Renew IP address With this option enabled, the Client initiates a DHCP request to obtain a dynamic IP address after a 
successful authentication, but only if the client detects that the connected network (the SSID) has 
changed. The result is that renewal should not occur upon reauthentication, but does occur at boot 
or when connecting to a different network. If you have a slow authenticator, you may wish to enable 
this option when configuring the service because the slow authenticator may prevent you from getting 
a DHCP-assigned IP address upon boot-up. This option is ignored if the given adapter has a static IP 
address.
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Certificate Management
During configuration, you may have specified one or two certificates to use during the authentication process. The specified 
identity should match the Issued to field in the certificate and should be registered on the authentication server (i.e., RADIUS 
server) that is used by the authenticator. In addition, your certificate must be valid on the authentication server. This requirement 
depends on the authentication server and generally means that the authentication server must know the issuer of your certificate 
as a trusted Certificate Authority. 

If the selected certificate does require a password or pass phrase to decode the private key, enter this value in the “Certificate 
Pass Phrase” field. This value will be encrypted when the configuration is saved.

However, on some systems, there may not be a certificate. If that is the case, you can use the section below as a primer on OS 
X certificate management.

Installing Certificates with CertAdd

Pocket PC doesn’t have a native certificate store. The CertAdd utility is supplied with the AEGIS Client to select and install 
certificates on a Pocket PC device. Client or Certificate Authority certificates can be imported from .cer (same as .der), .p7b, or 
.pfx files.

To install certificates on a Pocket PC device:

1. Download the certificate to the device.The location isn’t critical, although you may want to create a standard folder for 
consistency.

2. Go to Start > Programs > Meetinghouse Certificates. The opening screen is displayed. 

3. In the Folder drop-down list, select the folder containing the certificate(s). Any files of the valid file types in the selected folder 
are listed in the lower pane of the CertAdd screen.

4. Select a certificate from the list. A pop-up will ask if you want to install the certificate.

5. Tap OK. The certificate is loaded in the correct certificate store.
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8

D

Wireless PAN Communications with Bluetooth
Overview

Dolphin 9500/9550 terminals are available with a Bluetooth radio for (Wireless Personal Area Network) WPAN usage. When the 
mobile computer is first initialized, the *.cab file and module for Bluetooth are installed.

Powering Up the Bluetooth Radio Driver
Before using the radio, make sure that the Bluetooth radio is powered up. When the radio driver is powered up, the Bluetooth 
icon appears in the task tray on the Today screen.   

Radios are powered up in the Radio Manager utility; see Powering Up a Radio on page 4-19.

Setting Up Your Bluetooth Card
Note: If you use the Get Connected! Wizard, which is recommended for normal usage, then this step is not necessary. This step 

would be used to change the friendly name of your mobile computer.

1. Tap the Bluetooth icon that appears in the task tray on the Today screen .
If you installed OBEX, the menu also lists Transfer via Bluetooth.

2. In the pop-up menu, select Advanced Features, then My Bluetooth Device.

3.  In the My Bluetooth Device screen, you can modify the Friendly Name and make any desired configuration changes. 
When done, tap OK.

• In normal phone connect operation, Discoverable mode is not needed and should be disabled.
• If you do enable Discoverable mode (e.g., for ActiveSync), note that it does not shut off by itself. To save power, remember 

to disable it when not needed. 
• Connectable, Use Authentication, and Use Encryption are also not required for printing or dial-up networking applications.
• Check Use Authentication to enable the Use Encryption option.
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Assign COM Ports

Follow these steps to view and/or modify the Bluetooth COM ports. If you are not going to use the IrDA port, you can disable it 
to free up a port for Bluetooth devices; see IrDA Config on page 5-7.

1. Tap on the Bluetooth icon on the Today screen. Select Advanced Features then My Bluetooth Device.

Note: If you installed OBEX, the menu also lists Transfer via Bluetooth.

2. The My Bluetooth Device screen appears. Tap on the COM Ports tab.

3.  As needed, view and/or enable/disable the Bluetooth COM port assignments. Tap OK. 

Note: The Bluetooth Phone port cannot be disabled. For more information about COM ports, see the Com Port Assignment 
Table on page A-12.
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Discover Bluetooth Device(s)

Follow these steps to discover other Bluetooth devices nearby, including non-phone devices. The Device Discovery Wizard is a 
more detailed alternative to using the Bluetooth “Get Connected!” Wizard or Bluetooth ActiveSync or Bluetooth LAN Access 
options. The Device Discovery Wizard allows you to discover any type of Bluetooth device.

1. If not open, launch the Bluetooth Devices folder. Tap on the Bluetooth icon on the Today screen. Select Advanced 
Features then Bluetooth Devices.

2. In the Bluetooth Devices Folder, tap on the Device Discovery icon. Or you can tap on Tools. In the pop-up menu, select 
Device Discovery.

3. Follow the Bluetooth Device Discovery Wizard to search for Bluetooth devices nearby. When prompted, select the device 
type you seek.

4.  When the search is complete, a screen reports the discovered Bluetooth devices. Check the box next to any device you wish 
to save information about, (i.e., any devices you wish to connect to). Tap Next.

5.  A service discovery phase begins, 5-10 seconds per chosen device.

6. In the next screen, tap Finish.

Bond With Discovered Device(s)
Follow these steps to bond with an already discovered Bluetooth device. In most cases, bonding is for establishing secure 
communications with a Bluetooth-enabled phone. This is a more detailed alternative to using the Bluetooth “Get Connected! 
Wizard.”

Important!

• Do not try to bond with a Motorola Timeport 270C or Nokia 6310!
• Do not use this method to bond with a printer! The third-party printing software included on the installation CD also handles 

bonding.

1. If not open, launch the Bluetooth Devices folder. Tap on the Bluetooth icon in the Today screen. Select Advanced 
Features, then Bluetooth Devices.
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2. Tap and hold your stylus on the Bluetooth device you want to bond with. In the pop-up menu, select Bond.

3. Alternatively, after selecting a device, tap on the Bond icon. Or tap on Device, then select Bond.

4. The Bluetooth Device Bonding Wizard launches. Follow the wizard to bond with your selected device. 
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5. As prompted, make sure the Bluetooth device that you want to bond with is in Bondable mode.

6. If the remote device is set up to accept bonding, a Bluetooth Passkey screen appears. To continue bonding, enter the 
correct passkey and tap Reply.

7. When you have successfully bonded with the other device, tap Finish.

View Device Properties
Follow these steps to view the properties of an already discovered device. 

1. If not open, launch the Bluetooth Devices folder. Tap on the Bluetooth icon on the Today screen. Select Advanced 
Features then Bluetooth Devices.

2. Select a device. Tap on the Properties icon, or tap on Device then select Properties. Alternatively, you can tap and hold 
your stylus on the Bluetooth device you want to view information about. In the pop-up menu, select Properties.
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3.  Use the General and Services screens to research device properties. If needed, assign a new device type icon by tapping 
on the arrow buttons in the General screen. You can also use the Device name field to rename the device. When done, tap 
OK for the setting to take effect.

Set Up Your Favorite Device
Follow these steps to set up default devices in the Bluetooth Devices folder. Please note that the Get Connected! Wizard 
automatically assigns the favorite phone.

Complete these steps:

1. Tap on Tools and select My Favorites. 

2. Tap on the tab for the type of device you would like to set a favorite for. If needed, use the arrow buttons to scroll and find the 
tab you need.

Note: Tabs appears only for COM ports you have enabled. To enable a port, refer to the “Assign COM Ports” section earlier in 
this chapter.

3. To select a favorite device, select Use the favorite selected above. In the drop-down list, select your device. Tap OK.

4. After setting a device as your favorite, its icon appears in the Bluetooth Devices folder with a heart next to it.

Change Views
You can switch between the Large Icons or Details views for the Bluetooth Devices folder.

1. In Bluetooth Devices, tap on View.
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2. In the pop-up menu, choose between Large Icons or Details.

Note: In Details view, you can see the Device Class and scroll right to see the current Bonded status.

Delete a Device From the Folder
If you no longer plan to connect with it, you can delete a device from the Bluetooth Devices folder. 

1. If not open, launch the Bluetooth Devices folder.

2. Tap and hold your stylus on the device you wish to delete. In the pop-up menu, select Delete.

3. Alternatively, after selecting a device, tap on the Delete icon. Or tap on Device then select Delete.

4. A Confirm screen appears. Tap Yes.

Large Icons Details 
Dolphin® 9500/9550 Mobile Computer User’s Guide - GSM Draft 8 - 7



Turn Radio Transmitter ON/OFF

You may want to turn off the radio transmitter to save power or if you are entering an area with radio restrictions (e.g., an airplane).

1. The Bluetooth icon should appear in the task tray on the Today screen. Tap on the icon.

2. In the pop-up menu, select Turn Transmitter OFF.

3. The Bluetooth Card radio transmitter shuts off. The Bluetooth icon in the task tray becomes gray, as well as relevant menu 
options (e.g., Get Connected!).

4. To turn the radio transmitter back on, tap on the gray Bluetooth icon. In the pop-up-menu, select Turn Transmitter ON.
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Bluetooth ActiveSync

This section explains how to use the Bluetooth ActiveSync feature. It helps you quickly and easily ActiveSync to a notebook or 
desktop computer with ActiveSync v3.x installed.

1. Tap on the Bluetooth icon. In the pop-up menu, select Bluetooth ActiveSync.

2. The next screens varies depending on if your Bluetooth Devices folder contains any computers, and if one is chosen as your 
favorite. Please refer to the appropriate scenario:

SCENARIO #1: Your Bluetooth Devices folder contains a favorite desktop computer.

(a) When you tap Bluetooth ActiveSync, your mobile computer automatically tries to connect to your favorite computer. 

(b) The Connect To screen appears, reporting that it is trying to connect to Wireless ActiveSync.

(c) After a successful connection is made, the status screen reports Connected. Now you are ready to synchronize files, if 
desired.

SCENARIO #2: Your Bluetooth Devices folder contains no favorite desktop computer.

(a) When you tap on Bluetooth ActiveSync, a screen appears that allows you to choose which computer to connect to in 
your Bluetooth Devices folder. Choose a computer from the list and tap Select, or tap Find to search for another computer.

Note: If the computer you want to connect to is not listed, tap Find to begin a search. Proceed as described in Scenario #3 on 
page 8-10.

(b) Your mobile computer attempts to connect to your selected  computer.
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(c) After a successful connection is made, the status screen reports Connected. Now you are ready to synchronize files, if 
desired.

SCENARIO #3: Your Bluetooth Devices folder contains no computers.

(a) When you tap on Bluetooth ActiveSync, a Bluetooth Device Search automatically begins.

Note: You can also start the device search by tapping Find in the Bluetooth Devices screen.

(b) After the search is complete, select the computer you wish to ActiveSync with and tap Select. If the computer is not listed, 
make sure the computer id discoverable and tap Refresh to search again.

(c) After you tap Select, a service discovery phase begins.

(d) The Connect To screen appears, reporting that it is trying to connect to Wireless ActiveSync.

(e) After a successful connection is made, the status screen reports Connected. Now you are ready to synchronize, if desired.
8 - 10 Dolphin® 9500/9550 Mobile Computer User’s Guide - GSM Draft



Bluetooth LAN Access

This section explains how to use the Bluetooth LAN Access feature to quickly and easily connect to a Bluetooth-enabled LAN 
access point.

1. Tap on the Bluetooth icon. In the pop-up menu, select Bluetooth LAN Access.

2. The next screens varies depending on if your Bluetooth Devices folder contains any access points, and if one is chosen as 
your favorite. Please refer to the appropriate scenario:

SCENARIO #1: Your Bluetooth Devices folder contains no favorite access point.

(a) When you tap Bluetooth LAN Access, a screen appears that allows you to choose which access point to connect to in 
your Bluetooth Devices folder. Choose an access point from the list and tap Select. 

Note: If your access point is not listed, tap Find and proceed as described in Scenario #3.

(b) Your mobile computer tries to connect to the selected access point.

(c) If your LAN requires a passkey, a screen appears asking for the passkey. Enter the passkey, then tap OK.

(d) After a successful connection is made, the status screen reports Connected.

(e) Now you are ready to access your LAN for Internet access, files, etc.

SCENARIO #2: Your Bluetooth Devices folder contains a favorite access point.
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(a) When you tap Bluetooth LAN Access, your mobile computer automatically tries to connect with your favorite access 
point.

(b) If your LAN requires a passkey, a screen appears, asking for the passkey. Enter the passkey, then tap OK.

(c) After a successful connection is made, the status screen reports Connected.

(d) Now you are ready to access your LAN for Internet access, files, etc.

SCENARIO #3: Your Bluetooth Devices folder has no access points. 

(a) When you tap Bluetooth LAN Access, the mobile computer automatically begins to search for new Bluetooth devices.

Note: You can also start the device search by tapping Find in the Bluetooth Devices screen. See Scenario #2 on page 8-9.

(b) After the search is complete, select the access point you wish to connect to. Tap Select. If the access point is not listed, 
tap Refresh to search again.

(c) After you tap Select, a service discovery phase begins.

(d) If the LAN requires a Passkey, a screen appears, asking for the Passkey. Enter the passkey, then tap OK.
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(e) After a successful connection is made, the screen reports Connected.

(f) Now you are ready to access your LAN for Internet access, files, etc.
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OBEX

This section explains how to use the OBEX (object exchange) application to trade business cards, contacts or files with another 
Bluetooth device that supports OBEX.

Bluetooth OBEX application supports five operations:

• Exchange Business Cards
• Send a Contact
• Send a File
• Browse Remote Device
• Receive Contact or File
• Enable File Sharing

The first four operations - exchange business cards, send a contact, send a file, and browse remote device - are client-oriented. 
They involve initiating an object exchange.

The last two operations - receive contact or file and enable file sharing - are server-oriented. They involve accepting objects in 
an exchange initiated by another Bluetooth device.

Exchange Business Cards

1. Make sure both Bluetooth devices have a business card assigned to them.

Note: If each device does not have a business card assigned to it, you cannot exchange business cards.

To assign a business card to your mobile computer, do the following:

• Tap on the Bluetooth icon. In the pop-up menu, tap Advanced Features > My Bluetooth Device.
• Tap on the Object Sharing tab. Under My business card, tap Assign

• In the next screen, select your business card and tap OK. If your business card is not listed, tap Contacts to create one.

When you return to the Object Sharing screen, tap OK.
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2. Make sure the other Bluetooth device is set up to receive a contact. The device must support the OBEX Object Push profile.

Note: If the other device is also using the Bluetooth Connection Kit, you can set it up to receive a contact by tapping the 
Bluetooth icon. In the pop-up menu, tap Transfer via Bluetooth > Receive Contact or File.

3. Now you are ready to exchange business cards. Tap on the Bluetooth icon. In the pop-up menu, tap Transfer via 
Bluetooth > Exchange Business Cards.

4. If your mobile computer has no devices in the Bluetooth Devices Folder, then it begins to search for Bluetooth devices 
nearby.

5. Select the Bluetooth device you wish to exchange business cards with. If the device is not listed, tap Find.

6. Your mobile computer begins to exchange business cards. After the exchange, the new business card should appear in your 
Contacts list.

Send a Contact

1. Make sure the other Bluetooth device is set up to receive a contact. It must support the OBEX Object Push server profile. 
Refer to the documentation that came with the device for instructions.

Note: If the other device is also using the Bluetooth Connection Kit, you can set it up to receive a contact by tapping the 
Bluetooth icon. In the pop-up menu, tap Transfer via Bluetooth > Receive Contact or File.

2. Now you are ready to send a contact. Go to your Contacts folder.
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3. Tap and hold your stylus on the contact(s) you would like to send. In the pop-up menu, select Send Via Bluetooth.

4. If your mobile computer has no devices in the Bluetooth Devices Folder, then it begins to search for Bluetooth devices 
nearby.

5. Select the Bluetooth device you wish to send the contact(s) to. If the desired device is not listed, tap Find.

6. Your mobile computer processes and send the contact(s).

Send a File

1. Make sure the other Bluetooth device is set up to receive a file. It must support the OBEX Object Push server profile. Refer to 
the documentation that came with the device for instructions.

Note: If the other device is also using the Bluetooth Connection Kit, you can set it up to receive a file by tapping the Bluetooth 
icon. In the pop-up menu, tap Transfer via Bluetooth > Receive Contact or File.
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2. Now you are ready to send a file. Tap on the Bluetooth icon. In the pop-up menu, tap Transfer via Bluetooth > Send a File.

3. If your mobile computer has no devices in the Bluetooth Devices Folder, then it begins to search for Bluetooth devices 
nearby.

4. Select the Bluetooth device you wish to send a file. If the desired device is not listed, tap Find.

5. In the next screen, tap on the file you wish to send. You can use the Folder and Type drop-down menus to search for your 
file. Also, you can scroll horizontally to view the folder, date, size, type, and location of each file.
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6. Your mobile computer sends the file.

Browse Remote Device
The Bluetooth File Explorer lets your mobile computer share files with another Bluetooth device. The other device must support 
the OBEX File Transfer server profile.

This section covers the following file transfer operations:

• Prepare for file transfer
• Send/receive file(s) or folder(s)
• Create a folder
• Delete file(s) or folder(s)
• Refresh remote view
• Connect/disconnect
• Exit the program

Note: “Local device” refers to the mobile computer you are running the OBEX from. “Remote device” refers to the Bluetooth 
device you are trying to transfer files with.

Prepare for File Transfer

1. Make sure the remote device has file sharing enabled. It must support the OBEX File Transfer server profile.

Note: If the other device is also using the Bluetooth Connection Kit, you can enable file sharing by tapping the Bluetooth icon. 
In the pop-up menu, tap Transfer via Bluetooth > Enable File Sharing.

2. Now you are ready to browse the remote device. Tap on the Bluetooth icon. In the pop-up menu, tap Transfer via 
Bluetooth > Browse Remote Device.

3. If your mobile computer has no devices in the Bluetooth Devices Folder that supports OBEX File Transfer, then it begins to 
search for Bluetooth devices nearby.
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4. Select the Bluetooth device you wish to browse. If the desired device is not listed, tap Find.

5. Your mobile computer begins to establish a file sharing connection.

6.  After the devices successfully connect, the Bluetooth File Explorer appears. Half of the screen shows contents of the remote 
device, while the other half shows contents of your device (the local device). The very bottom of the screen reports the 
connection status.

Send/Receive File(s) or Folder(s)

• Single-tap items to select them for transfer.
• Double-tap on a folders to open it and see its contents.
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1. Select the file(s) or folder(s) that you wish to transfer. You can select items from only one device per transfer session.  

2. There are two different ways to initiate the transfer:

• Tap on the File menu. Select Send to remote or Get from remote, as applicable. The inappropriate option should be gray.
• Tap on the Send to remote icon or Get from remote icon, as applicable. The inappropriate icon should be gray.
3. A screen reports the status of the transfer.

4. After the transfer, a copy of each selected item should appear in the other device.

Create a Folder

1. Tap on the File menu. Select Remote device or Local device, wherever you want to create a folder, then tap Create 
remote folder or Create local folder, as applicable.

2. On the Dolphin 9500/9550, you can also tap and hold your stylus on an item in either the remote or local device that you wish 
to put in a new folder. In the pop-up menu, select Create folder.
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3. In the next screen, enter a name for your new folder. Tap OK.

4. The new folder should be listed under the appropriate device.

Delete File(s) or Folder(s)

1. Select item(s) that you wish to delete. You can only delete item(s) from one device at a time.

2. Tap on the File menu. Select Remote device or Local device, wherever the item(s) are located, then tap Delete remote 
item(s) or Delete local item(s), as applicable.

3. Tap and hold your stylus an item in either the remote or local device that you wish to put in a new folder. In the pop-up menu, 
select Delete folder.

4. In the Confirm screen, tap Yes.

Refresh Remote View

1. Tap on the Device menu. Select Refresh remote view.

2. Your local device begins to read the contents of the remote device.

3. After a few seconds, the contents view of the remote device is refreshed.

Connect/Disconnect

To connect to the remote device, do the following:

1. Make sure the remote device has file sharing enabled.
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2. Start the connection process by either of two methods:

• Tap on the Device menu. Select Connect.
• Tap on the Connect icon.

3. In the next screen, select the device you wish to connect to. Tap Select. Your mobile computer attempts to connect to the 
device selected.

To disconnect from the remote device, do the following:

1. Start the disconnection process by either of two methods:

• Tap on the Device menu. Select Disconnect.
• Tap on the Connect icon.

2. Your mobile computer disconnects from the remote device. Afterwards, no contents are listed for the remote device.

Exit Bluetooth File Explorer

To exit the Bluetooth File Explorer, tap File > Exit. 

 Receive Contact or File

1. Tap on the Bluetooth icon. In the pop-up menu, tap Transfer via Bluetooth > Receive Contact or File.

2. The Receive Contact or File status screen appears. Your mobile computer waits two minutes for the contact or file.

3. After successfully connecting to the remote device, the screen reports Connected then disappear. The new contact or file 
should now be on your device.

4. If two minutes passes before you receive the item, tap Wait Again.

5. After you receive the file or contact, the “Receive Contact or File” feature is automatically disabled.

Enable File Sharing

1. Tap on the Bluetooth icon. In the pop-up menu, tap Transfer via Bluetooth > Enable File Sharing.
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2. The Enable File Sharing status screen appears. Your mobile computer waits two minutes for the remote device to connect.

3. After successfully connecting to the remote device, the screen report Connected.

4. If two minutes passes before you connect, tap Wait Again.

5. File sharing is enabled until you end it by tapping Cancel.
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Using the Dialer

This section explains how to assign a dialing prefix and use the Dialer to dial a number directly from your Contacts list. The Dialer 
makes it quick and easy to perform dial-up networking.

Note: The Dialer has been verified to work with Nokia and Ericcson phones and is known not to work with the Motorola 270c, 
NTT Docomo Paldio 633S or Sony au C413S phone. Results may vary with other phones that are not listed as being supported 
by the Bluetooth system.

Assign a Dialing Prefix

If you have not already assigned a dialing prefix during the install process, you can do so by following these steps:

1. Go to Start > Settings > System tab. Tap on Dialer.

2. Select the appropriate Dialing Prefix, then tap OK.

Using the Dialer

1. To use the dialer, the mobile computer must already be connected to the Bluetooth phone. You can use the Get Connected! 
Wizard to do this. Also, the Bluetooth phone must be selected as your favorite.

2. Go to Start > Contacts.

3. Tap and hold your stylus on the contact you wish to dial to. In the pop-up menu, select Dial Contact. Alternatively, you can 
tap on Tools and select Dial Contact.
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4. If you have multiple phone numbers for a contact, a screen appears listing them, including any dialing prefix you may have 
assigned. Select the phone number you wish to dial.

5. Your mobile computer connects to your phone and begins dialing.

The Dialer can dial a phone number containing any of the following non-numeric characters:

* # + . / ! @ - \ space    A    B    C     D     T      P     W

The following string can also be included in a phone number: (',')

The Dialer cannot dial a phone number containing non-numeric characters other than those listed above. HHP recommends that 
you follow the standard Microsoft Outlook format for phone numbers.
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Get Connected Wizard

The Get Connected! Wizard guides you through a one-time setup process that prepares the mobile computer and phone for 
Bluetooth connections. The wizard varies depending on what phone you want to connect to.

Ericsson, Nokia 6210, NTT DoCoMo, Sony Phones 

1. Tap on the Bluetooth task tray icon. In the pop-up menu, select Get Connected!

2. Follow the Bluetooth “Get Connected!” Wizard. In the second screen, use the drop-down list to select your Bluetooth phone. 
The wizard provides tailored instructions based on your selection.

3. Follow the next screen(s) to prepare your specific phone for Bluetooth connections. You may need to do 1, 2 or all of the 
following steps:

(a) Naming your Bluetooth phone

(b) Setting your Bluetooth phone in Discoverable mode

(c) Preparing your Bluetooth passkey. 
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4. When the search is complete, a list of the discovered Bluetooth phones appears. Choose the phone you wish to connect to, 
and tap Select. A service discovery phase begins, about 5-10 seconds.

5. As prompted in the next screen, prepare your phone for bonding. For instructions on setting your phone to “Bondable” or 
“Pairable” mode, refer to your phone manual. Have your passkey ready, then tap Next>.

6. In the next screen, enter the passkey. Tap Reply.

7. The mobile phone may then either automatically accept the passkey or ask you to enter one. If prompted for a passkey, use 
the same one you entered on the mobile computer.

Ericsson T68/T68i only: When the phone asks you if you want to bond, select 2: Add to paired devices. Do not tap ACCEPT.

8. Tap Finish. After successfully connecting, the phone appears in the Bluetooth Devices folder. On the Today screen, the 
Bluetooth icon blinks. You do not need to run the Get Connected! Wizard again unless you plan to switch between different 
phones.

Note: You may also switch between different phones by assigning a new “favorite phone” in the Bluetooth Devices folder.

Motorola Timeport 270C, Nokia 3650/6310/7650/8910/8910i 

1. Tap on the Bluetooth task tray icon. In the pop-up menu, select Get Connected!

2. Follow the Bluetooth “Get Connected!” Wizard. In the second screen, use the drop-down list to select your Bluetooth phone. 
The wizard provides tailored instructions for your phone.

Note: The screens below are for the Nokia 7650.

3. As directed on the next two screens, assign the phone a unique name, set the phone to Discoverable mode, and tap Next.
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4. The mobile computer begins to search for the phone. When the search is over, a list of the discovered Bluetooth phones 
appears.

Choose the phone you wish to connect to, and tap Select. A service discovery phase begins, about 5-10 seconds.

5. The next two screens describe procedures you can only complete outside of the wizard. Read through each screen but do 
not complete the described procedures until you exit the wizard. 

Bonding with your phone - This must be completed to establish the Bluetooth connection and involves dial-up 
networking. 

Automatic Connections - This procedure is optional but makes future Bluetooth connections more convenient. 

6. Continue to the last screen of the wizard and tap Finish. Now proceed to STEP 6 to complete the bonding process and, if 
desired, set up automatic connections.

Note: Directions for these procedures are provided in Dial-up to Your Network, starting on the next page.
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Dial-up to Your Network

Complete the following steps to create a new Bluetooth internet connection. Before setting up dial-up networking, prepare 
yourself with dial-up information and other necessary settings from your office network or ISP. 

1. Go to Start > Settings > Connections tab > Connections. In the top field, select Internet Settings and tap Modify. Then, 
tap New.

2. On the Make a New Connection screen, enter a name for the dial-up connection. For the modem, select Bluetooth Phone. 
For the Baud Rate, select 115200. Tap Advanced. 

Note: Remember what you name the connection. In the future, you will need to select it to start the connection.

3. Tap Next.

4. In the Phone number field, enter the dial-up number. Tap Next.
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5. Uncheck Wait for dial tone before dialing. Tap Finish.

6. Now you are ready to start the connection. In the Connections screen, under Internet Settings, tap Connect. In Network Log 
On, verify the dialing settings. Tap OK. 

If you want to configure Port Settings, TCP/IP, or Name Server settings, navigate to the setting and tap Advanced; see Advanced 
Settings on page 5-19.

7. ONLY FOR MOTOROLA TIMEPORT 270C OR NOKIA 3650/6310/7650/8910/8910i: 

a) After you tap Connect for the first time, the phone displays a message asking if you want to bond. On Motorola, enter 
GRANT; on Nokia, enter ACCEPT. 

b) Make up a 4-16 digit passkey, enter it on the phone, then enter it on the Dolphin 9500/9550.

Note: The Bluetooth icon on the Today screen blinks to indicate a connection.

c) After successfully bonding, you can set up the phone to automatically connect to your Dolphin 9500/9550 without requiring a 
passkey.

Automatic Connections for Motorola Timeport 270C:

• On the phone, press MENU.
• Scroll to Settings, then press SELECT.
• Scroll to Connection, then press ON.
• On Bluetooth Link, press SELECT.
• Scroll to Devices, then press SELECT.
• Choose your mobile computer, then press EDIT.
• Scroll to Access:Ask, then press CHANGE.
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• Scroll to Automatic, then press SELECT. Press DONE.

Automatic Connections for Nokia 3650/7650:

• On the phone, press MENU.
• Scroll to Connectivity, then press OPTIONS.
• The Open option should be highlighted. Press SELECT.
• The Bluetooth option should be highlighted. Press OPTIONS.
• The Open option should be highlighted. Press SELECT.
• Scroll to the right tab to access the Paired devices list. Highlight your mobile computer, then press OPTIONS.
• Scroll to Set as authorized, then press SELECT.
• In the confirmation screen, press YES.

Automatic Connections for Nokia 6310/8910/8910i:

• On the phone, press MENU.
• Scroll to 10 Bluetooth, then press SELECT.
• Scroll to 4 View Paired Devices, then press SELECT.
• Highlight the Dolphin 9500/9550, then press OPTIONS.
• Scroll to 3 Request Connection Authorization, then press NO.

To use a different Bluetooth phone for dial-up networking, you can use the same connection setup, but you must make the new 
phone your favorite. Just run the Get Connected! Wizard again, select the new phone, and make it your new Favorite when 
prompted. 

Alternatively, you can use the Bluetooth Devices folder to change your favorite phone. Refer to Using the Dolphin 9500/9550 
Mobile Computer beginning on page 4-1 for instructions.
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9

D

Wireless WAN Communications with GSM/GPRS 
Overview

Dolphin 9500 terminals can be configured with Wireless Wide Area Network (WWAN) via an integrated Siemens® GSM/GPRS 
tri-band radio module. 

Note: Dolphin 9550 mobile computers with pistol-grip do NOT support GSM/GPRS.

GSM - GSM stands for Global System for Mobile communications. It is an open, non-proprietary wireless wide area networking 
system that is constantly evolving and growing. One of its great strengths is international roaming capability, which provides 
standardized dialing in more than 170 countries. 

GPRS - GPRS stands for General Packet Radio Service. It is a non-voice value added service that allows packet switched data 
and information to be instantly sent and received across a mobile telephone network.

Powering Up the GSM/GPRS Radio Driver
When the mobile computer is first initialized, the radio driver for the GSM module is installed. Before using the radio, make sure 
that the GSM radio is powered up. For more information, see The Radio Manager on page 4-18.

Capabilities
Dolphin 9500 computers with integrated GSM/GPRS WWAN radios are optimized for the following two-way voice and data 
communications:   

• GSM data "dial-up"
• SMS (Short Message Service)
• GPRS Class 10 - data transmissions average. 40-60 Kbps (wireless network carrier dependent)

Tri-Band Antenna

Requirements
Using GMS/GPRS on a Dolphin 9500 terminal requires:

• a network subscription to a GSM/GPRS network (you need to know what service providers are in your geographic area), and
• a SIM card installed on the terminal.

DOL PHIN 9500

Dolphin 9500 terminals configured with a GSM/GPRS 
radio module also feature a tri-band antenna on the top 
panel. This antenna supports 900, 1800 and 1900 Mhz 
frequencies for worldwide mobile applications.
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SIM Card Installation

SIM stands for Subscriber Information Module. A SIM card stores the subscriber's personal information, GSM/GPRS radio 
settings, security key, contacts, etc. SIM cards can be installed and removed from any mobile device, enabling you to switch 
devices without losing your personal information. SIM cards are obtained and activated by the network provider that supports the 
GSM/GPRS network.  

On the Dolphin 9500 terminal, the SIM card door is located in the battery well on the back panel. This enables easy access to 
the SIM card while securing it under an installed battery.

To Install a SIM Card:

Note: You need a metric .05” allen head screwdriver to open the SIM card door. The SIM card must be activated by the service 
provider prior to insertion.

1. Turn off your terminal and lay it face-down on a flat surface.

2. Remove the battery pack. For details, see To Remove the Main Battery Pack on page 2-6.  

3. Unscrew the faceplate of the SIM card door. 

4. Insert your SIM card. Make sure the interface on the card is connected to the SIM Card interface in the slot; the beveled 
corner is in the upper right corner.

5. Place the SIM card door over the secured SIM card and secure the allen screws.

6. Install the battery pack. The terminal powers on.

Battery Well

SIM Card Door

Battery Interface

SIM Card Interface

Allen Screws

SIM Card Door

SIM Card
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Using uPhone

The uPhone Application Suite contains three programs that function together to provide a complete voice, data, and text 
messaging solution for a mobile device fitted with a radio modem: 

• Call Log enables you to view and manipulate a list of the most recent calls.
• Dialler emulates a mobile phone and is used to make and receive telephone calls.
• SMS Manager provides a text message handler similar to many email programs.

Accessing uPhone
Go to Start > Programs > uPhone. Tap one of the icons to launch the program. 

Phone Status
The icon in the Navigation bar at the top of the screen indicates the status of the phone. 

Status Icons

Icon This icon means… Tapping on this icon…

 A call is in progress. Switches to the Dialler screen.

 Incoming SMS message available. Switches to the SMS Manager where you can access you Inbox.
Dolphin® 9500/9550 Mobile Computer User’s Guide 9 - 3



Bubble Dialogs
If the Dialler or SMS Manager are not visible, the following bubble dialogs appear automatically:

Incoming Call 

Incoming SMS Message Available 

Displayed when an incoming call is received and the Dialler is not 
visible. The caller’s name or number displays if it is in your Phonebook. 
“No number" displays if the caller’s ID is not available. The ringtone is 
played while the phone is ringing.

• Tap Answer to answer the call and open the Dialler. 
Tapping Answer also places a current call on hold.

• Tap Reject to reject the call.

This bubble appears automatically when a new SMS message is 
received. It displays the first few words of the message and provides 
the following buttons:

• View - Displays the full message in the SMS Manager application.
• Reply - Switches to the SMS Manager Compose screen. The 'To:' 

field us auto-filled with the sender’s address.
• Save - Puts the message in the SMS Manager Inbox.
• Delete - Deletes the message. 

Tap a button to execute the command. The bubble closes 
automatically.
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Using the Dialler

To launch the Dialler, tap Start > Programs > uPhone > Dialler. The program launches and the uPhone Dialler screen opens:

Making a Call

To Enter a Number
You can:

• Enter the numbers manually using the phone keypad on the Dialler screen, the SIP, or the keyboard. 
As you enter each number, it appears on the Dialler screen in the second information line. If a contact matching the entered 
number is found in the Phonebook, the name of the contact appears in the second information line as you type; tapping on 
the name enters the rest of the number automatically.

• Use the Phonebook to choose an existing contact.
Tap Tools > Phonebook, select a name or number, and tap OK (you can also tap and hold on the entry). The number is 
automatically entered in the Dialler and appears on the screen.

• Use the Call Log.
When the phone is in Idle status, you can tap the Send button, press the ENTER key, or tap Tools > Call Log to see a list of 
the last 20 calls made or received. Tap and hold on an entry in the list and select Dial. Note that pressing the Send button or 
ENT key is available only when the phone is Idle. 

To Send a Call To a Dialed Number
You can:

• Tap the Send button on the screen .
• Press the ENTER key on the keyboard.
• Press the appropriate key combination on the keyboard.

Information lines

1. Network Operator - name of service
    provider.
2. Number/Name - number and/or name of
    dialed, incoming, and outgoing calls
3. Status - displays the status of the phone.

Tap to end a call

Phone keypad - tap the numbers 
to dial

Signal Strength -
Four bars is optimal for

transmission.

Tap to send (make) a call or
accept an incoming call

Dialler screen

Tap to clear the Dialler

Tap these buttons when * and #
are required for interactive voice

systems; also known as
touchtones.

Cingular
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When the call is connected, the three information lines display the following:

Network Operator Displays the name of the service provider you are using.

Name/Number Displays the name and/or number you called. If the number is from your Phonebook, that entry 
displays.

Status The status of the call. Idle means no calls are incoming or outgoing, In Call means a phone call is in 
progress, Incoming Call means that a a call is coming in. 

The numbers in the lower, right corner display the minutes:seconds that have elapsed.

Receiving a Call
When the Dialler screen is open and an incoming call is detected, text is displayed on the Dialler screen. If the Dialler is not visible 
at the time of the incoming call, a Navigation Bar notification appears, showing the name or number of the incoming call, with 
options to accept or reject the call; see Incoming Call on page 9-4.

When a call is coming in, the ringtone sounds and the three information lines on the Dialler screen display the following:  

Network Operator Displays the name of the service provider you are using.

Name/Number Displays the name and/or number calling in. If the number is from your Phonebook, that entry 
displays.

Status Incoming Call.

To Answer a Call
You can:

• Tap the Send button on the screen .
• Press the ENTER key on the keyboard.
• Press the appropriate key combination on the keyboard.

To Reject the Call
You can:

• Tap the End button on the screen .
• Press the appropriate key combination on the keyboard.

Ending a Call
To end or reject a call at any time, you can:

• Tap the End button on the screen .
• Press the appropriate key combination on the keyboard.

Joe Smith
9 - 6 Dolphin® 9500/9550 Mobile Computer User’s Guide



Touchtones
To transmit touchtones for interactive voice systems while in a call, you can 

• Tap the 0-9, *, and # buttons on the uPhone Dialler screen.
• Press 0-9 keys on the Dolphin keyboard; use the uPhone Dialler screen buttons for * and #.

Volume Control
Use the Dolphin keyboard to manually adjust the volume.

To raise the volume, press the Blue modifier key +  (VOL+)

To lower the volume, press the Blue modifier key +  (VOL-)

Tools Menu
The Tools menu provides the following options: 

Select this item To…

Phonebook Display the Phonebook.

Call Log Switch to the Call Log.

SMS Manager Switch to the SMS Manager Inbox.

Select Skin Allow selection of a new skin for the uPhone Dialler application.

Ringtones Switch to the ring tone selection control panel.

Exit Exit the uPhone Dialler.

Phonebook
The Phonebook contains the contacts from the SIM card and Pocket Contacts. If fixed dialing is set in the SIM, then only those 
numbers in the fixed dialing list are shown in the Phonebook, and only these numbers can be called from the Dialler. 

Keyboard Combinations To Send and End a Call
Each keyboard option contains a key combination to send and end a call using the Red modifier key. 

Keyboard To Send, Press… To End (reject), Press…

35-key keyboard Red + SP Red + DEL

43-key keyboard Red + D Red + H

56-key keyboard Red + 3 Red + 6
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You can access the Phonebook manually by opening the Dialler and going to Tools > Phonebook. 

When you tap and hold on an entry, a popup menu displays the following options:

Dial Opens the Dialler with the number entered ready for dialing.

Send SMS Opens the SMS Manager in the Compose screen with the 'To:' field populated with the number.

Settings Menu
The Settings menu provides the following options:  

Speakerphone Toggles speakerphone mode on and off. When an audio plug (for a headset) is inserted into the audio 
jack (2.5mm), Speakerphone is inactive on this menu.

Mic mute Toggles microphone mute on and off (the other party cannot hear a private conversation when the 
microphone is muted). This mode is active only during a call and automatically cancelled at the end 
of a call.

A checkmark to the left of the entry indicates that the mode is active. When the entry is grayed-out, it is unavailable and cannot 
be selected. 
9 - 8 Dolphin® 9500/9550 Mobile Computer User’s Guide



Audio Modes

The back panel of the Dolphin 9500 contains both a speaker and a microphone that you can use to send and receive audio 
signals over the GSM network. For details about the microphone and speaker on the back panel of the Dolphin 9500, see Back 
Panel Features on page 3-4.

There are three audio modes:

1. Handset

2. Headset

3. Hands-free (speakerphone)

Handset
Handset mode is when you use the use the back panel of the terminal just as you would a cell phone, holding the speaker to your 
ear to receive audio information and the your mouth over the microphone to send audio information. 

This is the default audio mode. 

Headset
Headset mode is when you plug an audio plug into the audio jack and speak into the microphone. You must use a 2.5mm plug; 
not other audio plug will fit.

Hands-Free
Hands-free mode is when you use the back panel of the Dolphin 9500 as a speakerphone. 

To switch the back panel to speakerphone, in the Dialler, tap Settings > Speakerphone. The audio levels adjust appropriately 
for speakerphone use. For more information, see Settings Menu on page 9-8.
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Ringtone Configuration

Different ringtones, with individual volume settings, can be set for the following:

Ring Tone Sounds on an incoming call.

Message Tone Sounds on an incoming SMS or Voicemail notification.

Call Waiting Tone Sounds to indicate an incoming call while you are already on a voice call.

Accessing Ringtone Configuration
You can access Ringtones two ways:

1. Go to Start > Settings > Personal tab > Ringtones icon OR

2. Open the Dialler (tap Start > Programs > uPhone > Dialler) and go to Tools > Ringtones.

The Ringtones screen opens displaying the current settings. 

Select the desired ringtone for each type of tone in the drop-down lists. Tapping OK saves any changes. Opening another screen 
without tapping OK discards any changes.

WAV Files
You can customize your ringtones with *.wav files installed on your terminal. To appear here, *.wav files must be stored in the 
Programs Files > uPhone >Ring Tones folder.

Previewing Tones
You can preview each tone by selecting the *.wav file in the drop-down list and tapping the Preview button. Use the slider to set 
the volume for each tone.

While the tone is playing, the Preview button changes to a Stop button; tap it to stop the preview.
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Call Log

The Call Log maintains a list of the last 20 calls made or received in each of the following categories:

• Voice Calls In
• Voice Calls Out
• Voice Calls Missed

Voice Call In is the default display whenever the Call Log is opened.

Opening the Call Log
You can access the Call Log two ways:

1. Go to Start > Programs > uPhone > Call Log) OR 

2. Open the Dialler (go to Tools > Call Log). 

The Call Log opens displaying the last few Voice Calls In; the most recent call always appears at the top. 

This column Displays the …

Name The phone number or the name if the call was from or to a matching entry in the Phonebook.

Time Time and date the call started. This is the local time and date. 

Duration Duration of the call (hours:minutes:seconds). The clock starts when the call connects, not when 
dialed.
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Call Log Options
Voice Calls Out and Voice Calls Missed are available from the drop-down list. Select the option you want to view.  

To see everything, select All Calls.

Tools Menu
The Tools menu in the Call Log provides you with the following options:

Select this menu option To…

Clear Delete the entire Call Log.

Exit Close the Call Log. 
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SMS Manager

Abbreviated for Short Message Service, SMS enables the transmission of short messages (140-160 characters) to and from a 
cell phone. SMS messages travel over the system's control channel, which is separate from the voice channel.

The SMS Manager on the Dolphin 9500 supports creation, sending, receiving, and storing of SMS text messages. Text 
messages sent or received can be up to 160 characters long.

Opening the SMS Manager
You can access the SMS Manager two ways:

1. Go to Start > Programs > uPhone > SMS Manager, OR

2. Open the Dialler (Start > Programs > uPhone > Dialler) and go to Tools > SMS Manager.

The SMS Manager opens displaying a list of your most recent text messages. Tap the Inbox and the SMS folders drop-down. 

Three folders are available from the Inbox menu:

Select this folder To see…

Inbox Received text messages.

Sent Sent text messages.

Outbox Text messages waiting to be sent (messages are moved to the Sent folder automatically after 
transmission).

Tap here
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When the folder is selected, the messages in it appear in the list. The name of the folder appears in the gray bar just under the 
title bar.  

To Do this…

Open a message Tap on it in the list.

Delete a message Tap and hold on it in the list. A popup menu appears that enables you to delete the message. 

Sending an SMS Message

1. In the task tray at the bottom of the screen, tap New. The new message screen opens with the cursor active in the text area.

2. Tap inside the To: field. To add the number, you can type it in or tap To: to select an entry from your Phonebook.
9 - 14 Dolphin® 9500/9550 Mobile Computer User’s Guide



• You must type a number that is in the appropriate international ISDN format for the country you are dialing. However, 
you can dial a local number without the country code.

• Destination numbers can start with a “+” sign.
3. Tap inside the text area. To write a message, you can use the SIP or the keyboard.  

The Remaining characters field displays how many characters you can type. It counts backwards from 160 as you type each 
character.

4. When finished typing, tap the Send icon to transmit the message . 
If you tap OK before tapping send, the program requests confirmation before discarding the message.

Online Help

Tapping Help > About provides information about the uPhone applications.

Icons

Tap this icon To…

At the top of the window:

Copy selected text.

Cut selected text.

Paste text.

Undo the previous action.

In the task tray at the bottom of the window:

Send all messages in the Outbox.
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GPRS Settings

After subscribing to a GPRS network and installing your SIM card, you can load the parameters of your GPRS subscription into 
the terminal. However, some subscriptions load automatically when you install your SIM card. If the GPRS settings do not load 
automatically, you must enter them manually.

uPhone includes a pre-configured GPRS connection in Internet Settings. You need to select or create GPRS settings prior to 
making a GPRS call for the first time. You can also configure GPRS settings for browsing the web via a VPN or Proxy Server.

To Select Pre-Configured GPRS Settings

1. Go to Start > System > Connections tab > uPhone GPRS. The GPRS Settings screen appears displaying the default 
setting.   

 The Current Profile drop-down list contains a number of pre-configured connection profiles. 

2. If the profile associated with your account appears in the list, select it. If it does not appear in the Current Profile list, you need 
to create one. For details, see To Add a GPRS Setting on page 9-17.

3. In the Details section

• Type in the APN number
• Type in the IP address
• Select the Protocol

4. Tap OK to save.
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To Add a GPRS Setting

1. On the GPRS Settings screen, in the Current Profile drop-down list, select Add new. 

2. Type in the Profile Name, APN, IP Address, and select the Protocol.

3. Tap OK. You return to the settings screen. The Profile Name you selected now appears in the Current Profiles list.

GPRS Connection
When a GPRS connection is required - e.g., by navigating to a web site - a Network Log On screen is automatically displayed.

Enter the Password and Domain, then tap OK to connect.
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You have the option of disconnecting by tapping on the GPRS connection icon in the navigation bar and tapping End.
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Establishing GPRS Internet Settings

Because GSM/GPRS technology uses a network connection, you need to configure Internet Settings or Work Settings to use 
GPRS parameters in the Connection Manager. 

Note: Make sure that you are not using ActiveSync when configuring the connection settings.

Note: Please note that the following instructions are a generic overview. To establish a GPRS connection, you need to review 
the information from your network service provider. Given that there can be so many different configurations, such as VPN 
or Proxy Server connections, see Connection Settings on page 5-16 for instruction about how to set up each kind of 
connection.

1. Go to Start > Settings > Connections tab > Connections. The Connection Settings screen appears. 
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2. Select Internet Settings and tap Modify. The Internet Settings screen appears displaying the current internet setting for 
GPRS on the Modem tab.  

3. Tap New. The Make a New Connection screen appears. 

4. Enter a name for the connection; something that indicates that this is the GPRS connection is recommended.

5. Select a modem from the drop-down list.

6. Select a Baud rate from the drop-down lists; 57600 is recommended for optimal performance.
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7. Tap Next. Another screen appears asking for the exact phone number.  

8. This information is available only from the network service provider you are using for GPRS. “#99*” is the generic dialing 
number for GPRS. Enter the number and tap Next.  
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9. Enter the information and tap Finish. You are returned to the Internet Settings screen with the connection you just 
established displaying in the list.   
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10
D

Applications
Microsoft Pocket Outlook includes Calendar, Contacts, Tasks, Inbox, and Notes. You can use these programs individually or 
together. For example, e-mail addresses stored in Contacts can be used to address e-mail messages in Inbox. 

Using Microsoft ActiveSync, you can synchronize information in Microsoft Outlook or Microsoft® Exchange Server on your 
desktop computer with your device. You can also synchronize this information directly with a Microsoft Exchange server. Each 
time you synchronize, ActiveSync compares the changes you made on your device and desktop computer or server and updates 
both computers with the latest information. For information about using ActiveSync, see ActiveSync Help on the desktop 
computer.

You can switch to any of these programs by tapping them on the Start menu.

Calendar: Scheduling Appointments and Meetings

Use Calendar to schedule appointments, including meetings and other events. You can check your appointments in one of 
several views (Agenda, Day, Week, Month, and Year) and easily switch views by using the View menu.

Note: You can customize the Calendar display, such as changing the first day of the week, by tapping Options on the Tools 
menu. 

To Create an Appointment

1. If you are in Day or Week view, tap the desired date and time for the appointment.

2. Tap New.

Tap to go to today.

Tap to display or edit
the appointment details.

Tap to create a new appointment.

Calendar Application
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3. Using the input panel, enter a description and a location. Tap first to select the field. 

4. If needed, tap the date and time to change them.

5. Enter other desired information. To see all available fields, hide the input panel.

6. To add notes, tap the Notes tab. You can enter text, draw, or create a recording. For more information on creating notes, 
refer to Notes on page 10-10.

7. When finished, tap OK to return to the calendar. 

Note: If you select Remind me in an appointment, your device will remind you according to the options set in Start, Settings, 
Personal tab, Sounds & Reminders. 

Tap to select a date.

Tap to select a time.

Tap to return to the calendar
(the appointment is saved
automatically).

Tap to choose from
previously entered locations.

Tap to choose from
predefined text.

Notes is a good place
for maps and directions.

Entering an Appointment
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Using the Summary Screen
When you tap an appointment in Calendar, a summary screen is displayed. To change the appointment, tap Edit.

Creating Meeting Requests
You can use Calendar to set up meetings with users of Outlook or Pocket Outlook. The meeting request is created automatically 
and sent either when you synchronize Inbox or when you connect to your e-mail server. Indicate how you want meeting requests 
sent by tapping Tools and then Options. If you send and receive e-mail messages through ActiveSync, select ActiveSync.

To Schedule a Meeting

1. Create an appointment.

2. In the appointment details, hide the input panel, and then tap Attendees.

3. From the list of e-mail addresses you’ve entered in Contacts, select the meeting attendees. 

The meeting notice is created automatically and placed in the Outbox folder.

For more information on sending and receiving meeting requests, see Calendar Help and Inbox Help on the device.

View appointment details.

View.

Tap to change
appointment.

Appointment Summary Screen
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Contacts

Contacts maintains a list of your friends and colleagues so that you can easily find the information you’re looking for, whether 
you’re at home or on the road. Using the device infrared (IR) port, you can quickly share Contacts information with other device 
users.

Note: To change the way information is displayed in the list, tap Tools > Options.

Tap and enter part of a name to
quickly find it in the list.

Tap to display or edit
the contact details.

Tap and hold to display
a pop-up menu of actions.

Tap to see additional phone
numbers and e-mail addresses.

Tap to create a new contact.

Select the category of contacts
you want displayed in the list.

Contact Application
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To Create a Contact

1. Tap New.

2. Using the input panel, enter a name and other contact information. You need to scroll down to see all available fields.

3. To assign the contact to a category, scroll to and tap Categories and select a category from the list. In the contact list, you 
can display contacts by category.

4. To add notes, tap the Notes tab. You can enter text, draw, or create a recording. For more information on creating notes, 
refer to Notes on page 10-10.

5. When finished, tap OK to return to the contact list.

There are four ways to find a contact: 

• In the contact list, enter a contact name in the box under the navigation bar. To show all contacts again, clear text from the 
box or tap the button to the right of the box. 

• In the contact list, tap the category list (labeled All Contacts by default) and select the type of contact that you want displayed. 
To show all contacts again, select All Contacts. To view a contact not assigned to a category, select None. 

• To view the names of companies your contacts work for, in the contact list, tap View > By Company. The number of contacts 
that work for that company are displayed to the right of the company name. 

• Tap , Find, enter the contact name, select Contacts for the type, and then tap Go. 

Notes is a good place
for maps and directions.

Tap to return to the contact
list (the contact is saved
automatically).

Scroll to see more fields.

Creating a Contact
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Using the Summary Screen
When you tap a contact in the contact list, a summary screen is displayed. To change the contact information, tap Edit.

View contact details.

Tap to view notes.

Tap to change contact information.

Contacts Summary Screen
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Tasks

Use Tasks to keep track of what you have to do. 

Note: To change the way information is displayed in the list, tap Tools > Options.

Tap to create a new  task.

Select the sort order
of the list.

Indicates high priority.

Select the category of tasks
you want displayed in the list.

Tap to display or edit
the task details.

Tap and hold to display
a pop-up menu of actions.

Task Application
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To Create a Task

1. Tap New.

2. Using the input panel, enter a description.

3. You can enter a start date and due date or enter other information by first tapping the field. If the input panel is open, you 
need to hide it to see all available fields.

4. To assign the task to a category, tap Categories and select a category from the list. In the task list, you can display tasks by 
category.

5. To add notes, tap the Notes tab. You can enter text, draw, or create a recording. For more information on creating notes, 
refer to Notes on page 10-10.

6. When finished, tap OK to return to the task list.

Note: To quickly create a task with only a subject, tap Entry Bar on the Tools menu. Then, tap Tap here to add a new task and 
enter your task information.

Tap to return to the task
list (the task is saved
automatically).

Tap to choose from
predefined subjects.

Notes is a good place
for maps and drawings.

Creating a Task
10 - 8 Dolphin® 9500/9550 Mobile Computer User’s Guide - GSM Draft



Using the Summary Screen
en you tap a task in the task list, a summary screen is displayed. To change the task, tap Edit.

View task details.

View notes.

Tap to show and hide additional
summary information.

Tap to change task.

Task Summary Screen
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Notes

Quickly capture thoughts, reminders, ideas, drawings, and phone numbers with Notes. You can create a written note or a 
recording. You can also include a recording in a note. If a note is open when you create the recording, it will be included in the 
note as an icon. If the note list is displayed, it will be created as a stand-alone recording.

Tap to open a note or
play a recording.

Tap and hold to display
a pop-up menu of actions.

Tap to create a new  item.

Tap to change the sort
order of the list.

Tap to show or hide the
Recording toolbar.

Tap to record.

Notes Application
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To Create a Note

1. Tap New.

2. Create your note by writing, drawing, typing, and recording. For more information about using the input panel, writing and 
drawing on the screen, and creating recordings, see Using the Dolphin 9500/9550 Mobile Computer on page 4-1.

Tap to return to the note
list (the note is saved
automatically).

Tap to write on the screen.

Tap to show or hide
the input panel.

Tap to add a recording
to the note.

Creating a Note
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Inbox

Use Inbox to send and receive e-mail messages in either of these ways: 

• Synchronize e-mail messages with Microsoft Exchange or Microsoft Outlook on your desktop computer.
• Send and receive e-mail messages by connecting directly to an e-mail server through an Internet service provider (ISP) or a 

network.

Synchronizing E-mail Messages
E-mail messages can be synchronized as part of the general synchronization process. You need to enable Inbox synchronization 
in ActiveSync. For information on enabling Inbox synchronization, see ActiveSync Help on the desktop computer.

During synchronization:

• Messages are copied from the mail folders of Exchange or Outlook on your desktop computer to the ActiveSync folder in Inbox 
on your device. By default, you will receive messages from the past three days only, the first 100 lines of each message, and 
file attachments of less than 100 KB in size.

• E-mail messages in the Outbox folder on your device are transferred to Exchange or Outlook, and then sent from those 
programs.

• E-mail messages in subfolders must be selected in ActiveSync on your desktop computer to be transferred.
Note: You can also synchronize e-mail messages with your desktop computer from a remote location. For more information, 

see Chapter 7.

Connecting Directly to an E-mail Server
In addition to synchronizing e-mail messages with your desktop computer, you can send and receive e-mail messages by 
connecting to an e-mail server.

When you connect to the e-mail server, new messages are downloaded to the device Inbox folder, messages in the device 
Outbox folder are sent, and messages that have been deleted on the e-mail server are removed from the device Inbox folder.

Messages that you receive directly from an e-mail server are linked to your e-mail server rather than your desktop computer. 
When you delete a message on your device, it is also deleted from the e-mail server the next time you connect based on the 
settings you selected in ActiveSync.

You can work online or offline. When working online, you read and respond to messages while connected to the e-mail server. 
Messages are sent as soon as you tap Send, which saves space on your device.

When working offline, once you’ve downloaded new message headers or partial messages, you can disconnect from the e-mail 
server and then decide which messages to download completely. The next time you connect, Inbox downloads the complete 
messages you’ve marked for retrieval and sends the messages you’ve composed.
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Using the Message List
Messages you receive are displayed in the message list. By default, the most recently received messages are displayed first in 
the list.

Select the sort order
for messages.

Select the service and folder
you want to display.

Tap to connect to
the selected service.

Tap to connect and to
send and receive e-mail.

Tap to open a message.

Tap and hold to display
a pop-up menu of actions.

InBox Application
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When you receive a message, tap it to open it. Unread messages are displayed in bold.

When you connect to your e-mail server or synchronize with your desktop computer, by default, you’ll receive messages from 
the last five days only, the first 100 lines of each new message, and file attachments of less than 100 KB in size. The original 
messages remain on the e-mail server or your desktop computer. 

You can mark the messages that you want to retrieve in full during your next synchronization or e-mail server connection. In the 
message list, tap and hold the message you want to retrieve. On the pop-up menu, tap Mark for Download. The icons in the 
Inbox message list give you visual indications of message status.

You specify your downloading preferences when you set up the service or select your synchronization options. You can change 
them at any time:

• Change options for Inbox synchronization using ActiveSync options. For more information, see ActiveSync Help.
• Change options for direct e-mail server connections in Inbox on your device. Tap Tools and then tap Options. On the Service 

tab, tap the service you want to change. Tap and hold the service and select Delete to remove a service.

Tap to delete this message.

Tap to view  the previous
or next message.

Tap to reply to or
forward this message.

Tap to return to
the message list.

Viewing A Message
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Composing Messages

1. Tap New. 

2. In the To field, enter an e-mail or SMS address of one or more recipients, separating them with a semicolon, or select a name 
from the contact list by tapping the Address Book button. 
All e-mail addresses entered in the e-mail fields in Contacts appear in the Address Book.

• Compose your message. To enter preset or frequently used messages, tap My Text and select a message.
• Tap Send when you’ve finished the message. If you are working offline, the message is moved to the Outbox folder and will 

be sent the next time you connect.

If you are sending an SMS message and want to know if it was received, tap Edit, Options, and select Request SMS text 
message delivery notification before sending the message.

Managing E-mail Messages and Folders
By default, messages are displayed in one of five folders for each service you have created: Inbox, Deleted Items, Drafts, Outbox, 
and Sent Items. The Deleted Items folder contains messages that have been deleted on the device. The behavior of the Deleted 
and Sent Items folders depends on the options you have chosen. In the message list, tap Tools and then Options. On the 
Message tab, select your options.

If you want to organize messages into additional folders, tap Tools, and then Manage Folders to create new folders. To move 
a message to another folder, in the message list, tap and hold the message and then tap Move to on the pop-up menu.

Tap to show or hide
the complete header.

Tap to send the message.

Tap to insert common messages.

Tap to show / hide the
recording toolbar.

Tap to display the Address Book.

Creating a Message
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Folder Behavior with a Direct Connection to an E-mail Server
The behavior of the folders you create depends on whether you are using ActiveSync, SMS, POP3, or IMAP4. 

• If you use ActiveSync, e-mail messages in the Inbox folder in Outlook will automatically be synchronized with your device. 
You can select to synchronize additional folders by designating them for ActiveSync. The folders you create and the 
messages you move will then be mirrored on the server. For example, if you move two messages from the Inbox folder to a 
folder named Family, and you have designated Family for synchronization, the server creates a copy of the Family folder and 
copies the messages into that folder. You can then read the messages while away from your desktop computer.

• If you use SMS, messages are stored in the Inbox folder. 
• If you use POP3 and you move e-mail messages to a folder you created, the link is broken between the messages on the 

device and their copies on the mail server. The next time you connect, the mail server will see that the messages are missing 
from the device Inbox and delete them from the server. This prevents you from having duplicate copies of a message, but it 
also means that you will no longer have access to messages that you move to folders created from anywhere except the 
device. 

• If you use IMAP4, the folders you create and the e-mail messages you move are mirrored on the server. Therefore, messages 
are available to you anytime you connect to your mail server, whether it is from your device or desktop computer. This 
synchronization of folders occurs whenever you connect to your mail server, create new folders, or rename/delete folders 
when connected. 
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Pocket Internet Explorer 

Use Microsoft Pocket Internet Explorer to view Web or WAP pages in either of these ways:

• During synchronization with your desktop computer, download your favorite links and mobile favorites that are stored in the 
Mobile Favorites subfolder in Internet Explorer on the desktop computer.

• Connect to an Internet service provider (ISP) or network and browse the Web. 

When connected to an ISP or network, you can also download files and programs from the Internet or intranet.

Accessing Pocket Internet Explorer
To switch to Pocket Internet Explorer, tap Start and then Internet Explorer.

You can use Pocket Internet Explorer to browse Mobile Favorites and channels that have been downloaded to your device 
without connecting to the Internet. You can also connect to the Internet through an ISP or a network connection and browse the 
Web.

Browse the Internet on Your Terminal

1. Set up a connection to your ISP or corporate network using Connections; see Using an ISP on page 6-8.

Note: If you select Pocket Internet Explorer before setting up the network connections, a screen may appear allowing you to 
proceed to the connection settings screen. After you select the settings, you return to Pocket Internet Explorer. To add a 
favorite link while using the device, go to the page you want to add, tap and hold on the page, and tap Add to Favorites.

2. To connect and start browsing, tap View and then Address Bar. 

3. In the address bar that appears at the top of the screen, enter the Web address you want to visit and then tap Go. 

4. Tap the arrow to choose from previously entered addresses.

If Mobile Favorites have been set up, you can tap one of them to start browsing. See The Mobile Favorites Folder on page 10-18.
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The Mobile Favorites Folder

Purpose

The Mobile Favorites folder was created on your desktop computer when you installed ActiveSync. It enables you to create 
Favorite Links on your desktop computer that you can transfer to your Dolphin 9500/9550 terminal. Those Favorite Links are then 
available for selection when browsing the internet on your terminal. 

Process

First, you create your Favorite Links in the Mobile Favorites folder on your desktop computer. Then, the next time you sync your 
desktop computer with your terminal, those Mobile Favorites are transferred to the Mobile Favorites folder on to your terminal. 

Only items stored in the Mobile Favorites subfolder in the Favorites folder in Internet Explorer on your desktop computer are 
synchronized with the Mobile Favorites folder on your terminal. 

Note: Unless you mark a Favorite Link as a mobile favorite, only the link downloads to your terminal, and you will need to connect 
to your ISP or network to view the content. For more information on synchronization, see ActiveSync Help on the desktop 
computer.

Creating and Synchronizing Mobile Favorites 
If you are using Microsoft Internet Explorer 5.0 or later on your desktop computer, you can download Mobile Favorites to your 
device. Synchronizing mobile favorites downloads Web content to your device so that you can view pages while you are 
disconnected from your ISP and desktop computer.

Use the Internet Explorer plug-in installed with ActiveSync to create mobile favorites

Complete these steps:

1. On your desktop computer, open Internet Explorer, click Tools > Create Mobile Favorite.

2. To change the link name, enter a new name in the Name box. 

3. Optionally, in Update, select a desired update schedule.

4. Tap OK. Internet Explorer downloads the latest version of the page to your desktop computer.

5. If you want to download the pages that are linked to this mobile favorite, in Internet Explorer on the desktop computer, right-
click the mobile favorite and then click Properties. On the Download tab, specify the number of links down that you want to 
download. To conserve device memory, go only one level down.

6. Synchronize your device and desktop computer. Mobile favorites that are stored in the Mobile Favorites folder in Internet 
Explorer are downloaded to your device.

If you did not specify an update schedule in Step 3, you will need to manually download content to keep the information updated 
on your desktop computer and device. Before synchronizing with your device and desktop computer, in Internet Explorer on your 
desktop computer, click Tools and then Synchronize. You will see the last time content was downloaded to the desktop 
computer, and you can manually download content if needed.

You can add a button to the Internet Explorer toolbar for creating mobile favorites. In Internet Explorer on your desktop computer, 
click View, Toolbars, and then Customize.
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View Mobile Favorites and Channels on the Terminal

1. Access Pocket Internet Explorer.

2. Tap the Favorites button to display your list of favorites . 

3. Tap the page you want to view. 

You’ll see the page that was downloaded the last time you synchronized with your desktop computer. If the page is not on your 
device, the favorite will be dimmed. You will need to synchronize with your desktop computer again to download the page to your 
device, or connect to the Internet to view the page.

Saving Memory On Your Terminal

Mobile favorites take up storage memory on your device. 

To minimize the amount of memory used:

• In the settings for the Favorites information type in ActiveSync options, turn off pictures and sounds, or stop some 
mobile favorites from being downloaded to the device. For more information, see ActiveSync Help.

• Limit the number of downloaded linked pages. In Internet Explorer on the desktop computer, right-click the mobile 
favorite you want to change and then Properties. On the Download tab, specify 0 or 1 for the number of linked pages 
you want to download.

Using AvantGo® Channels
AvantGo is a free interactive service that gives you access to personalized content and thousands of popular Web sites. You 
subscribe to AvantGo channels directly from your device. Then, you synchronize your device and desktop computer, or connect 
to the Internet to download the content. For more information, visit the AvantGo website: http://avantgo.com/frontdoor/index.html.

To Sign Up for AvantGo 

1. In ActiveSync options on the desktop computer, turn on synchronization for the AvantGo information type.

2. In Pocket Internet Explorer on your device, tap the Favorites button to display your list of favorites .

Tap to add or delete
a folder or favorite link.

Tap the favorite you
want to view.
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3. Tap the AvantGo Channels link.

4. Tap Activate.

5. Follow the directions on the screen. You will need to synchronize your device with your desktop computer and then tap the 
My Channels button to complete the AvantGo setup.

When synchronization is complete, tap the AvantGo Channels link in your list of favorites to see a few of the most popular 
channels. To add or remove channels, tap the Add or Remove link.

10
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Companion Programs

The companion programs for Pocket PC installed on Dolphin 9500/9550 terminals are

• Pocket Word and 
• Pocket Excel. 

Windows® Media Player™ for Pocket PC, Microsoft® Money, MSN® Messenger, Microsoft® Reader are NOT installed on the 
Dolphin 9500/9550 when shipped but may be installed from the Microsoft Companion CD.

Pocket Word

Pocket Word works with Microsoft Word on your desktop computer to give you easy access to copies of your documents. You 
can create new documents on your device, or you can copy documents from your desktop computer to your device. Synchronize 
documents between your desktop computer and your device so that you have the most up-to-date content in both locations.

Use Pocket Word to create documents, such as letters, meeting minutes, and trip reports. 

To create a new file, tap Start >  Programs > Pocket Word > New. A blank document appears. Or, if you’ve selected a template 
for new documents in the Options dialog box, that template appears with appropriate text and formatting already provided. You 
can open only one document at a time; when you open a second document, you’ll be asked to save the first. You can save a 
document you create or edit in a variety of formats, including Word (.doc), Pocket Word (.psw), Rich Text Format (.rtf), and Plain 
Text (.txt). 

Using Pocket Word   
Pocket Word contains a list of the files stored on your device. Tap a file in the list to open it. To delete, make copies of, and send 
files, tap and hold a file in the list. Then, select the appropriate action on the pop-up menu.

You can enter information in Pocket Word in one of four modes (typing, writing, drawing, and recording), which are displayed on 
the View menu. Each mode has its own toolbar, which you can show and hide by tapping the Show/Hide Toolbar button on the 
command bar.

You can change the zoom magnification by tapping View and then Zoom. Then select the percentage you want. Select a higher 
percentage to enter text and a lower one to see more of your document.

Tap to change the sort
order of the list.

Tap to open a document.

Tap and hold an item to see
a pop-up menu of actions.

Tap to create a new document.

Select the type of folder you
want displayed in the list.
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If you’re opening a Word document created on a desktop computer, select Wrap to Window on the View menu so that you can 
see the entire document.

Typing Mode
Using the input panel or Dolphin keypad, enter typed text into the document. For more information on entering typed text, see 
Using the Dolphin 9500/9550 Mobile Computer on page 4-1.

To format existing text and to edit text, first select the text. You can select text as you do in a Word document, using your stylus 
instead of the mouse to drag through the text you want to select. You can search a document to find text by tapping Edit and 
then Find/Replace.

Tap to change
formatting options.

Tap to format text.

Tap and hold to see a
pop-up menu of actions.

Tap to show or hide
the toolbar.

Tap to return to the
document list (changes are
saved automatically).
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Writing Mode
In writing mode, use your stylus to write directly on the screen. Ruled lines are displayed as a guide, and the zoom magnification 
is greater than in typing mode to allow you to write more easily. 

For more information on writing and selecting writing, see Using the Dolphin 9500/9550 Mobile Computer on page 4-1. 

Writing on the Screen in Pocket Word     

If you cross three ruled lines in a single stylus stroke, the writing becomes a drawing, and can be edited and manipulated as 
described in the following section.

Written words are converted to graphics (metafiles) when a Pocket Word document is converted to a Word document on your 
desktop computer.

With Space button selected,
drag to insert space. An arrow
appears showing the space
direction and size.

Tap to highlight selected text.

Space button.

Tap to select formatting options,
such as pen weight and line color.

Pen button.
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Drawing Mode
In drawing mode, use your stylus to draw on the screen. Gridlines appear as a guide. When you lift your stylus off the screen 
after the first stroke, you’ll see a drawing box indicating the boundaries of the drawing. Every subsequent stroke within or touching 
the drawing box becomes part of the drawing. 

For more information on drawing and selecting drawings, see Using the Dolphin 9500/9550 Mobile Computer on page 4-1.

For more information on using Pocket Word, tap Start and then Help.

Select Shape on the
pop-up menu to convert
objects to proper shapes.

Resize an object by dragging
the selection handles.

Tap an arrow  to
see your choices.

Tap to select formatting options,
such as line weight, fill color, and line color.

Pen button.
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Pocket Excel

Pocket Excel works with Microsoft Excel on your desktop computer to give you easy access to copies of your workbooks. You 
can create new workbooks on your device, or you can copy workbooks from your desktop computer to your device. Synchronize 
workbooks between your desktop computer and your device so that you have the most up-to-date content in both locations.

Use Pocket Excel to create workbooks, such as expense reports and mileage logs. 

To create a new file, tap Start > Programs > Pocket Excel >  New. A blank workbook appears. Or, if you’ve selected a template 
for new workbooks in the Options dialog box, that template appears with appropriate text and formatting already provided. You 
can open only one workbook at a time; when you open a second workbook, you’ll be asked to save the first. You can save a 
workbook you create or edit in a variety of formats, including Pocket Excel (.pxl) and Excel (.xls).

Pocket Excel contains a list of the files stored on your device. Tap a file in the list to open it. To delete, make copies of, and send 
files, tap and hold a file in the list. Then select the appropriate action from the pop-up menu.

Pocket Excel provides fundamental spreadsheet tools, such as formulas, functions, sorting, and filtering. To display the toolbar, 
tap View > Toolbar. 

If your workbook contains sensitive information, you can protect it with a password. To do so, open the workbook, tap Edit, and 
then Password. Every time you open the workbook, you will need to enter the password, so choose one that is easy for you to 
remember but hard for others to guess.

Tips for Working in Pocket Excel
When working in large worksheets in Pocket Excel:

• View in full-screen mode to see as much of your worksheet as possible. Tap View and then Full Screen. To exit full-screen 
mode, tap Restore.

• Show and hide window elements. Tap View and then tap the elements you want to show or hide.
• Freeze panes on a worksheet. First select the cell where you want to freeze panes. Tap View > Freeze Panes. You might 

want to freeze the top and left-most panes in a worksheet to keep row and column labels visible as you scroll through a sheet.
• Split panes to view different areas of a large worksheet. Tap View > Split. Then drag the split bar to where you want it. To 

remove the split, tap View > Remove Split.
• Show and hide rows and columns. To hide a hidden row or column, select a cell in the row or column you want to hide. Then 

tap Format,> Row or Column > Hide. To show a hidden row or column, tap Tools > Go To, and then type a reference that 
is in the hidden row or column. Then tap Format > Row or Column > Unhide.

For more information on using Pocket Excel, tap Start > Help.

Cell contents appear here
as you enter them.

AutoSum button.

Format button.

Zoom button.
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11
D

Dolphin 9500/9550 HomeBase
Overview

As the hub of your Dolphin 9500/9550 system, the Dolphin HomeBase charging and communication cradle supports both RS-
232 and USB communications, which make it able to interface with the majority of PC-based enterprise systems. When a terminal 
is seated in the HomeBase, its main battery pack charges in less that four hours. 

Power 

The HomeBase provides power to the intelligent battery charging system that prevents over- and undercharging incorporated 
into Dolphin terminals. The base senses when a full charge has been achieved and switches to a trickle charge. The HomeBase 
completes a full charge of the main battery pack in less than four hours.

Communications

Reliable data communications at speeds of up to 115k baud can be transmitted by the HomeBase through the RS-232 serial 
port. Using the full-speed USB port, the data transmission rate is12 Mbps. 

HomeBases cannot be physically connected to each other - sometimes referred to as “daisy-chained” - but can be networked 
together via a serial or USB hub.

Convenient Storage 

Intelligent battery charging makes the Dolphin HomeBase a safe and convenient storage receptacle for your Dolphin terminal. 

Capacity

The Dolphin HomeBase holds one terminal and features an auxiliary battery well behind the terminal well that can charges a 
battery pack independently of the terminal well. This means that one HomeBase can charge two batteries: the one installed in 
the terminal and a spare. 

Use only Dolphin 9500 series peripherals, power cables, and power adapters. Use of peripherals, cables, or power 
adapters not sold/manufactured by HHP will void the warranty and may damage the terminal.

Use only the Li-ion battery packs provided by HHP. The use of any battery pack not sold/manufactured by HHP in the 
Dolphin 9500/9550 terminal will void your warranty and may result in damage to the Dolphin terminal or battery.

!

!
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Dolphin 9500/9550 HomeBase Parts and Functions

Front Panel 

Terminal Well  

Place the Dolphin terminal in this well both to communicate with a host device. If the host device is a desktop computer 
that uses ActiveSync, synchronization begins immediately. While seated in the terminal well, the main battery installed 
in the terminal charges. The HomeBase completely charges a battery pack in less than four hours. 

Auxiliary Battery Well

See Auxiliary Battery Well on page 11-4.

DOCK LED   

Turns solid green when the Dolphin terminal is properly seated in the Dolphin HomeBase. When this light is on, the 
terminal is connected to the base.

AUX Battery LED 

Indicates status of the battery charging in the auxiliary battery well.   

To see the auxiliary battery well, see Rear Panel on page 11-4.

This color means…

Orange The auxiliary battery is charging. 
Green The auxiliary battery has completed charging and is ready for use.

DOCK

AUX BATTERY

COMM

Terminal Well

DOCK LED

Auxiliary Battery Well

AUX Battery LED COMM 
LED
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For information about charging a battery in the auxiliary battery well, see page 11-7.

COMM LED   

This is the communication LED. It indicates the status of data transfer between the Dolphin terminal and the host device. 
The color of this LED differs if the HomeBase is using the serial or USB port connection.

If using the serial port:    

If using the USB Port:

This color means…

Red Serial data is being sent from the Host Device to the Dolphin HomeBase. 
Green Serial data is being sent from the Dolphin HomeBase to the Host Device.
Orange Serial data is being sent at high data rates.

This color means…

Green LED A USB Connection is established with the host computer.
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Rear Panel 

Auxiliary Battery Well 

The HomeBase enables you to charge an additional Li-ion battery pack independently of the terminal well. This feature 
ensures that you can always have a fully-charged battery for your Dolphin terminal. See Powering the HomeBase on 
page 11-6.

USB Port

This USB Port is full-speed and 2.0 compliant. Using a USB cable, you can connect the HomeBase to a peripheral 
device, such as a desktop computer or printer. When the Dolphin 9500/9550 is seated in the terminal well, it is 
connected to the peripheral device via the HomeBase.

The USB port on the HomeBase requires that you use ActiveSync 3.7 or higher.

RS-232 Port 

Use a 9-pin, RS-232 cable from HHP to connect this port to a peripheral device for RS-232 data communication. For 
more information, see HomeBase Serial Connector on page 11-5.

DC Power Jack 

Use a power cable from HHP to supply power to this power jack. For more information, see Powering the HomeBase 
on page 11-6.

Note: Please contact HHP for communication and power cable pricing and part numbers.

Auxiliary Battery Well

DC Power JackRS-232 PortUSB Port
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HomeBase Serial Connector

The following diagram displays the serial connector of the HomeBase.  

Note: Signals referenced are for a DTE device. The Home Base is at a right-angle to the printed circuit board (PCB). The ninth 
pin has a ring indicator (RI).
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Powering the HomeBase

The terminal requires 9.5 Volts DC input for communications and battery charging; the HHP power cable converts the power 
source voltage accordingly.

1. Connect the HHP power cable to the DC jack on the rear of the HomeBase. 

2. Connect the HHP power cable to the power source.

HHP recommends that you leave the Dolphin HomeBase connected to its power source at all times, so that it is always ready to 
use.
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Charging the Main Battery

The Dolphin HomeBase powers the terminal and fully charges its main battery pack in less that four hours. The HomeBase 
contains an intelligent battery charging system that protects the battery from being damaged by overcharging; the unit senses 
when a battery pack is fully charged and automatically switches to maintain the battery at full capacity indefinitely. Therefore, 
Dolphin terminals may be stored in the HomeBase indefinitely without damage to the terminals, battery packs, or peripherals.

To check battery power, use the Power system setting; see Power on page 5-11.

For more information about HHP Li-ion batteries, see Batteries on page 3-10.

To Power a Terminal and Charge its Main Battery

1. Install the battery pack in the terminal; see Install the Main Battery Pack on page 2-6.

1. Connect the HomeBase to the power supply provided by HHP.

2. Slide the terminal into the terminal well until the Dock LED lights green to indicate that the terminal is 
properly seated.

3. The battery pack begins charging. 

Charging a Spare Battery Using the Auxiliary Battery Well 
The auxiliary battery well located on the back of the HomeBase charges a spare battery independently 
of the terminal well. The Aux Battery LED on the front panel indicates the status of the battery in this well. 

Charge time is less than four hours. 

To see this well, see Auxiliary Battery Well on page 11-2. 

1. Insert the end of the battery without the locking tab into the bottom of the auxiliary well opening.

2. Snap the battery into place with a hinging motion. The Aux Battery LED lights orange.

3. Use the AUX Battery LED to monitor charging progress.
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Communications

Communications Types

RS-232

The HomeBase supports RS-232 communications via the RS-232 Communications Port located on the back of the device. Tis 
port enables the Dolphin terminal to communicate to a personal computer, modem, or any RS-232 device using a standard serial 
cable and communications software.

USB

The HomeBase also supports USB communications via the USB port located on the back. The HomeBase acts as a USB device 
by interfacing the USB signals of the Dolphin 9500/9550 to the USB of the host computer. Using a standard USB cable, the 
HomeBase’s USB interface allows the Dolphin terminal to communicate with a personal computer or to be networked through a 
USB hub.

Note: The HomeBase should have only one type of interface cable connected at a time, either USB or RS-232. You must be 
using ActiveSync, version 3.7 or higher.

Equipment Requirements
To install and use the HomeBase, you need the following equipment:

• HomeBase connected to the appropriate power supply
• For RS-232 communications, a Serial cable 
• For USB communications, a USB cable 

CAUTION! Use only the power and communication cable from HHP. 

Setting up the HomeBase for RS-232 Communications

Connecting the Cables
Connect the HomeBase to the host computer or other device by plugging an RS-232 serial cable into the RS-232 
Communications Port on the rear of the HomeBase. The wiring of your cable depends on whether the other device is set up as 
a Data Communications Equipment (DCE) or Data Terminal Equipment (DTE) device. 

The HomeBase Communication Port is configured as a DCE device. To communicate with a DCE device, use either a null 
modem adapter in line with a standard RS-232 cable, or a null-modem serial cable. To communicate with a DTE device such as 
a computer, use a standard (or straight-through) RS-232 cable.  

You can make your own cables by following the pin configuration in the chart below. To do so, you must determine if your host 
RS-232 device is 9-pin or 25-pin, and whether it is configured as a DCE or DTE device.

Note: The HomeBase cannot be daisy-chained.

HomeBase /Host Port 
(DCE)

IBM AT DB9 
(DTE)

IBM XT 
DB25 (DTE)

Modem DB25 
(DCE)

Pin /  Input Signal

2   /  (RD) 2 3 2

3   /  (TD) 3 2 3

5   /  (SG) 5 7 7

4   /  (DTR) 4 20 6

6   /  (DSR) 6 6 20

7   /  (RTS) 7 4 5

8   /   (CTS) 8 5 4
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Setting up the Terminal
The Dolphin terminal may be configured for communications using the ActiveSync options as described in Chapter 2 or manually 
as described below.

To set Communications Properties, complete these steps:

1. Select Start > ActiveSync > Tools > Options. 

2. Select the PC tab.

3. Check the Enable synchronization box and select the desired option from the pull-down list; 115200 Default is 
recommended for an RS-232 connection. 

4. Tap OK.

5. Place the Dolphin in the cradle. The Dolphin 9500/9550 attempts to start an ActiveSync connection with the desktop 
computer automatically.

Setting up the Desktop Computer
ActiveSync must be installed and configured for RS-232 on the desktop computer to sync successfully with a Dolphin 9500/9550 
device that is configured for RS-232 communication. 
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The following graphic displays the correct ActiveSync Connection Settings on the desktop computer for an RS-232 connection.

Note: You can have the USB connection box checked in addition to the serial cable box without affecting processing. However, 
you would most likely use one or the other.

Setting up the HomeBase for USB Communication
The Dolphin 9500/9550 terminal is defaulted to support USB communications out of the box.

Required Equipment:

• HomeBase with power supply
• USB Cable
• ActiveSync v3.7 or above
• Windows® 98 second edition*, Windows® Me, Windows® 2000, or Windows® XP computer. 
Note: The HomeBase does not support Windows NT® when using a USB connection. This is because Windows NT does not 

support USB. 

*Windows® 98 second edition provides full USB support.

To Install the HomeBase Using USB
Note: You must be using ActiveSync 3.7 or higher.

Complete these steps:

1. Plug in the power supply and connect it to the back of the HomeBase. 

2. Plug the USB cable into the back of the HomeBase.

3. At this point, the hardware is installed and operating. You may need to reboot your PC to complete the installation process.  
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Setting up the Terminal 
To select ActiveSync options:

1. Select Start > ActiveSync > Tools > Options. 

2. Select the PC tab.

3. Check the Enable synchronization box and select ‘USB Connection from the drop-down list. 

4. Tap OK.

5. Place the Dolphin in the cradle. The Dolphin 9500/9550 attempts to start an ActiveSync connection with the desktop 
computer automatically.

Setting up the Desktop Computer
After the USB HomeBase is installed, you can use ActiveSync to connect to a Dolphin 9500/9550 terminal that is properly seated 
in the HomeBase. These instructions assume that ActiveSync v3.7 is installed on your PC. 
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The ActiveSync Connection Settings must be set as the following graphic indicates.

The Allow USB connection with this desktop computer box must be checked. Do not check the serial cable box.

Communicating with the Dolphin 9500/9550 Terminal
To initiate communications between the Dolphin 9500/9550 and its peripheral, complete these steps:

1. Insert the Dolphin 9500/9550 into the terminal well of the HomeBase. 

• The DOCK LED illuminates green. If the DOCK LED does not illuminate, make sure that the terminal is properly seated. 
You may need to remove and re-insert the terminal.

• The Dolphin terminal activates; if the power is off, the terminal automatically powers on. If the terminal does not power on, 
verify that the HHP power supply is properly connected to the cradle and plugged into a functioning outlet.

• The Dolphin 9500/9550 terminal automatically opens ActiveSync to establish a connection.

2. The HomeBase can now transfer data between the terminal and the host device. If communication does not occur, check the 
port connections to ensure that the cradle is correctly configured. 

Verifying Communication
You can verify that the USB driver is functioning by watching the COMM LED on the USB HomeBase. When the COMM LED 
illuminates solid green, the HomeBase is communicating with the host device.

Verifying Data Transfer
The COMM LED flashes when data is being transferred via the HomeBase. For an RS-232 connection, the COMM LED flashes 
red and green. For a USB connection, the COMM LED flashes green.
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Mounting the HomeBase

Set the Dolphin HomeBase on a dry, stable surface, such as a desktop or workbench near an electrical outlet. Be sure to provide 
enough workspace with good lighting for the user to view and operate the Dolphin terminal while it is in the HomeBase.

When choosing a location, bear in mind that: 

• the mounting location must allow users easy access to the Auxiliary Battery Well, and
• the serial and USB ports as well as the power jack face straight out of the rear panel, and you will most likely want easy access 

to them in the future.

Desk Mounting
Dolphin charging/communication cradles have a DIN rail (7.5 X 35 mm) slot on the bottom to allow for secure desk attachment 
of the unit if desired.   

To mount the HomeBase, you slide the DIN rail slot along the bottom panel and secure it. Then, using the appropriate nuts and 
bolts, secure the DIN rail to the desk or flat surface. 

Auxiliary Battery Well
Serial and USB port location (not in view) 

DIN rail (7.5 X 35 mm)
Dolphin® 9500/9550 Mobile Computer User’s Guide - GSM Draft 11 - 13



Wall Mounting
The following diagram displays how to wall-mount a Homebase: 

The back wedge of the mounting bracket contains an open slot for the power and communications cables. There is an extra 
space between this slot and the rear panel of the HomeBase to allow easy access to the power and communications ports. For 
more details on both ports, see Rear Panel on page 11-4.

Secure screws to  
the bottom panel 
by sliding them 
into the available 
slots

Fasten the 
screws to secure 
the HomeBase to 
the mounting 
bracket

Turn the secured 
HomeBase right 
side up.

Attach the 
bottom panel to 
the mounting 
bracket - match 
the holes to the 
secured screws

Using the 
appropriate 
screws, secure 
the mounting 
bracket to the 
wall or vertical 
surface as 
shown.

1.

4.

2.

3.

5.

Back wedge Open slot for cords and connectors
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12
D

Dolphin 9500/9550 Mobile Base
Overview

The Dolphin Mobile Base charging and communication cradle is designed specifically for in-premise and in-transit data collection 
applications. It features a flexible mounting bracket, a cigarette lighter adapter, and a power cable to adapt it to your environment. 

When a terminal is seated in the Mobile Base, its main battery pack charges in less than four hours. The serial connector supports 
RS-232 communication and power out to peripheral devices, such as hand held scanners.

As the hub of your Dolphin 9500/9550 mobile data collection system, the Mobile Base performs three important functions: 1) 
charging, 2) communications, and 3) storage. 

Charging

The Dolphin Mobile Base provides power to the intelligent battery charging system that prevents over- and undercharging 
incorporated into Dolphin terminals. The base senses when a full charge has been achieved and switches to a trickle charge. 
The Mobile Base completes a full charge of the main battery pack in less than four hours.

Communications

The Mobile Base transmits data to other devices at speeds of up to 115K baud via its RS-232 serial port.

Convenient Storage 

Intelligent battery charging makes the Dolphin Mobile Base a safe and convenient storage receptacle for your Dolphin terminal. 

Capacity

The Dolphin Mobile Base holds one terminal.

Use only Dolphin 9500 series peripherals, power cables, and power adapters. Use of peripherals, cables, or power 
adapters not sold/manufactured by HHP will void the warranty and may damage the terminal.

Use only the Li-ion battery packs provided by HHP. The use of any battery pack not sold/manufactured by HHP in the 
Dolphin 9500/9550 terminal will void your warranty and may result in damage to the Dolphin terminal or battery.

!

!
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Mobile Base Parts and Functions

Front Panel
The front panel of the Mobile Base has one slot. The following graphic features the Mobile Base with the Dolphin 9500 inserted 
into the Terminal Well.

Terminal Well Place the terminal in this well to communicate with a host device and charge the main battery pack. 

Mounting Brackets Use these to mount the Mobile Base to a fixed location.

DOCK LED Illuminates solid green when the Dolphin terminal is properly seated in the terminal well.

COMM LED   Indicates the status of data transfer between the host device and the Dolphin terminal

COMM LED color Indicates that…

Red Data is being sent from the Host Device to the Dolphin Mobile Base. 

Green Data is being sent from the Dolphin Mobile Base to the Host Device.

Orange Data is being sent at high data rates.

DOCK

COMM

Terminal Well

COMM LED

Mounting 
Brackets

DOCK LED
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Bottom Panel
The power supply and RS-232 connectors are located on the bottom of the unit.

Power Supply Connector

Use this connector to attach an HHP power cable to the Dolphin 9500/9550 Mobile Base. The Mobile Base can be 
powered by an external DC power source of between 11 VDC to 48 VDC.  The optional HHP cigarette lighter adapter 
cable allows the Mobile Base to be powered from a standard 12 VDC cigarette lighter outlet in a vehicle. 

You can also power the unit using the supplied pigtail power cable to “hard-wire” into the vehicle power bus.

Verify that the power source is always within the specified range and observe correct input voltage polarity. An improper 
input voltage range (above the 48 VDC maximum) or reverse polarity could damage the power conversion circuitry.

RS-232 Communications Port 

Use a standard serial cable to connect the unit to a host device via RS-232; see Mobile Base Serial Connector on page 
12-8. 

RS-232 Communications PortPower Supply Connector

!
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Powering the Dolphin Terminal

When seated in a Mobile Base that is connected to the appropriate power source, the Dolphin terminal receives the power to 
charge its main battery and run its internal circuitry. Keep the Mobile Base plugged into the power source so that the Dolphin 
terminal battery pack stays fully charged.

For more information about powering the Mobile Base, see Powering the Dolphin Mobile Base on page 12-6.

Charging the Dolphin Terminal
The Mobile Base supplies charging power to the Dolphin terminal so that the terminal can monitor the charging of its battery pack. 
This charging method protects the battery from being damaged by overcharging. Therefore, the Dolphin terminal may be stored 
indefinitely in the Mobile Base without damage to the terminal, the battery pack, or the Mobile Base.

To charge a Dolphin terminal, complete these steps:

1. Insert a battery pack into the Dolphin terminal.

2. Slide the terminal, imager window up and the LCD visible, into the terminal well of the Mobile Base until it stops. 

3. When the Dolphin terminal is properly seated, the DOCK LED on the Mobile Base illuminates solid green. The terminal 
begins charging automatically.
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Installing the Dolphin Mobile Base

To install the Dolphin Mobile Base, you need to mount it securely to an appropriate location and supply it with power.

Mounting the Mobile Base
The adjustable mounting bracket holds the terminal securely in place and gives the user a variety of options for mounting the 
Mobile Base. When selecting a location, keep in mind that the power supply and serial connectors point straight out the bottom 
panel.

Back Panel and Brackets 

Complete these steps:

1. Loosen the turnscrew.

2. Insert the ball joint of the mounting bracket to the back of the bracket.

3. Insert the ball joint on the back of the Mobile Base into the other side of the bracket.

4. Tighten the turnscrew to secure both ball joints.

5. Secure the mounting bracket to the appropriate location.

Back Panel

Latch

The latch sits on top of the spring arm assembly and holds the back of the terminal securely in place. The graphic above 
displays the mounting of a Dolphin 9500 terminal. There is a special latch available for the Dolphin 9550 that 
accommodates the pistol-grip handle.

Turnscrew

Power supply and RS-232 
connectors (not in view)

Mounting Bracket

Locking tabs

Ball Joint

Bracket

Latch

Spring Arm Assembly

Ball Joint
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Locking Tabs

When positioned as shown in the above graphic, the locking tabs secure the spring arm assembly, latch, and terminal 
in place. When seating a terminal, turn both arms up to allow the spring arm to move as necessary while the terminal 
is being inserted. After the terminal is seated, turn both arms toward the center to lock them.

Spring Arm Assembly

The spring arm assemble is the column that connect the latch to the back of the Mobile Base.

Ball Joints

There are two ball joints: one on the back of the Mobile Base and one on the mounting bracket. Both ball joints are 
inserted into the bracket and secured to mount the Mobile Base.

Connectors

The power and RS-232 connectors are located on the bottom panel. For more information, see Bottom Panel on page 
12-3.

Brackets

Bracket

The bracket contains the turnscrew and two slots. Ball joints are inserted into each slot and secured with the turnscrew.

Turnscrew

The turnscrew is located on the top of the bracket. Rotate the turnscrew to secure or loosen the ball joint slots.

Mounting Bracket

The mounting bracket is what you attach to the mounting surface. It is comprised of a ball joint and flat disk. The disk 
contains drill holes you use to secure the Mobile Base to the mounting surface.

Powering the Dolphin Mobile Base
Note: HHP recommends that you leave the Mobile Base connected to its power source at all times. 

The Mobile Base is powered via the power connector on the bottom panel; see Bottom Panel on page 12-3. Both the power and 
serial connectors are straight out, not at an angle.

The Mobile Base must be powered by a 12 to 48 volt DC source. 
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Setting the Mobile Base Up for Communications 

The Mobile Base RS-232 interface allows the Dolphin terminal to communicate to a personal computer, modem, or any standard 
RS-232 device using a standard serial cable and communications software.

Connecting the Cables
Connect the Mobile Base to the host computer or other device by plugging an RS-232 serial cable into the RS-232 
Communications Port on the bottom of the Mobile Base. Plug the other end of the RS-232 serial cable into the correct port on 
the host RS-232 device. 

The wiring of your cable depends on whether the other device is set up as a Data Communications Equipment (DCE) or Data 
Terminal Equipment (DTE) device. 

The Mobile Base Communication Port is configured as a DCE device. To communicate with a DTE device such as a computer, 
use a standard (or straight-through) RS-232 cable. To communicate with a DCE device, use either a null modem adapter in line 
with a standard RS-232 cable, or a null-modem serial cable. 

RS-232 Pin Configuration 

Refer to this table if you want to make your own cables. To do so, you must determine if your host RS-232 device is 

• 9-pin or 25-pin and 
• configured as a DCE or DTE device.

Mobile Base /Host Port 
(DCE)

IBM AT DB9 
(DTE)

IBM XT DB25 
(DTE)

Modem DB25 
(DCE)

Pin /  Input Signal

2   /  (RD) 2 3 2

3   /  (TD) 3 2 3

5   /  (SG) 5 7 7

4   /  (DTR) 4 20 6

6   /  (DSR) 6 6 20

7   /  (RTS) 7 4 5

8   /   (CTS) 8 5 4
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Mobile Base Serial Connector
The following diagram displays the serial connector of the Mobile Base.  

Note: Signals referenced are for a DTE device.

The Mobile Base connector is straight to the printed circuit board (PCB). The ninth pin sends 500mA at 5V power out. This can 
power a peripheral device, such as a mobile printer, provided that that peripheral device can accept 500mA at 5V.

Configuring the Dolphin Terminal
Communications Properties must be configured appropriately on the Dolphin 9500/9550 terminal for it to communicate with the 
Mobile Base.

To set Communications Properties:

1. Tap Start > ActiveSync > Tools > Options. 

2. Tap the PC Connection tab

3. Check the Enable Synchronization check box.
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4. Select the appropriate baud rate for connecting to the RS-232 Host Device; ‘11520 is the default.   

5. Tap OK and close the ActiveSync window on the Dolphin 9500/9550 terminal.

6. Place the Dolphin in the Mobile Base. Synchronization begins immediately.
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13
D

Dolphin 9500/9550 ChargeBase
Overview

The Dolphin ChargeBase is a four-slot charging cradle that can charge four Dolphin terminals, each in less than four hours. 
provides intelligent battery charging for Dolphin 9500/9550 terminals with Li-ion battery packs installed.  

Capacity

The ChargeBase can hold up to four Dolphin 9500/9550 terminals.  Each charging slot works independently to control the 
charging of each terminal.

Compatibility

The ChargeBase is compatible only with the batteries for all models in the Dolphin 9500/9550 family of mobile computing devices.

Charging process

As battery packs charge, the charging circuitry follows the two-step charging process (CC-CV) that is recommended for Li-Ion 
batteries. The process monitors changes in temperature, current, and voltage. 

Use only Dolphin 9500 series peripherals, power cables, and power adapters. Use of peripherals, cables, or power 
adapters not sold/manufactured by HHP will void the warranty and may damage the terminal.

Use only the Li-ion battery packs provided by HHP. The use of any battery pack not sold/manufactured by HHP in the 
Dolphin 9500/9550 terminal will void your warranty and may result in damage to the Dolphin terminal or battery.

!

!
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Dolphin ChargeBase Parts and Functions

Front Panel 

Terminal Wells

The ChargeBase contains four terminals wells. Each well 

• Holds and charges the main battery pack of one Dolphin 9500/9550 terminal. 
• Contains the companion to the industrial-grade, 17-pin connector on the bottom panel of Dolphin 9500/9550 

terminals.
• Has two LEDs on the front: the Dock LED and the Charge LED.

Dock LED

Each terminal well displays a Dock LED on the front that lights solid green when a terminal is properly seated, which 
means that the terminal and the base are connected.

Charge LEDs

Each terminal well displays a Charge LED on the front that lights green to indicate charging. For details, see Charging 
Terminals in the ChargeBase on page 13-5.

Back Panel

Power Supply Connector

This connector receives input from the power adapter. Plug the power connector cable from the power adapter into this 
connector. 

Note: There is no ON/OFF switch on the back panel of the ChargeBase. The power switch is on the power adapter.

Charge LEDDock LED

Terminal Wells

Power Supply Connector
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Power Supply
The ChargeBase includes a power supply that contains a power adapter to ensure the proper voltage. The power adapter is 
plugged into standard AC/DC outlets.

Supplying Power to the ChargeBase

Using a non-HHP power adapter voids your warranty and could result in serious damage to the circuitry of the Dolphin 
ChargeBase.

1. Be sure the power switch on the power adapter is in the OFF position. 

2. Plug the power cord into the power adapter.

3. Plug the power connector cable into the power connector on the back panel of the ChargeBase.

4. Plug the power cord into a standard wall outlet.

5. On the power adapter, turn the power switch to the ON position. The LEDs illuminate as the ChargeBase powers up.

6. The ChargeBase is ready to begin charging terminals.

Power Cord

ON/OFF
Switch

ON Position

Power Adapter

Power
Connector
Cable

!
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Inserting and Removing Terminals 

Inserting

1. Hold the terminal with the bottom panel perpendicular to the base. 

2. Slide the terminal into the well until the Dock LED lights solid green.  

3. Charging begins immediately.

Removing
To remove a terminal, grasp it firmly in your hand and lift it up and out of the terminal well. The LEDs for the terminal well turns off.
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Charging Terminals in the ChargeBase

The Dolphin ChargeBase charges the main  battery of each terminal in less than four hours. The ChargeBase uses the intelligent 
battery charging system incorporated into all Dolphin terminals that prevents overcharging. This means that Dolphin terminals 
may be stored in the ChargeBase indefinitely without damage to the terminals, battery packs, or the ChargeBase.

1. Power the ChargeBase; see Supplying Power to the ChargeBase on page 13-3.

2. Insert a terminal into a terminal well; see Inserting and Removing Terminals on page 13-4.

3. The Charge LED lights green to indicate that the terminal is powered and charging.
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Mounting the ChargeBase

The Dolphin ChargeBase should be on a dry, stable surface. To easily adapt the ChargeBase to your environment, it can be 
mounted on a flat, horizontal surface such as a desktop or workbench, or a flat, vertical surface such as a wall. 

When choosing a location, always bear in mind that 

• The mounting location must allow users easy access to the power connector.
• The ChargeBase should be oriented so that users can easily read the labels.

Bottom Panel
The bottom panel of the Dolphin 9500/9550 ChargeBase offers two mounting options: insert a DIN Rail in the available slot for 
desk mounting or secure two mounting brackets with the available screw slots.

Using the DIN Rail
All Dolphin charging/communication cradles have a DIN rail (7.5 X 35 mm) slot on the bottom panel to enable secure mounting. 

1. Slide the DIN Rail into the DIN Rail slot on the bottom panel. 

DIN Rail Slot

Screw Slots
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2. Turn the ChargeBase and DIN Rail right side up.

3. Secure the DIN Rail to a stable, flat horizontal surface. 
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Using the Mounting Brackets
Use the screws and the mounting brackets to mount the ChargeBase to a wall or other vertical surface. The wall mount kit 
contains two mounting brackets to secure both ends of the ChargeBase. Each mounting bracket contains an open slot in the 
back to accomodate the connector cables.

1. Secure the screws into the four screw slots on the bottom panel. Insert the heads into the round end and slide towards the 
narrow end until the screw is secure.

2. Attach the bottom panel to the two mounting brackets.

Screws in slots

Nuts and BoltsOpen Slot for Connector Cables Mounting Brackets
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3. Using the nuts and bolts, secure the mounting brackets to the bottom panel.

4. Secure the mounting brackets to an appropriate horizontal surface.
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Dolphin 9500/9550 QuadCharger
Overview

The Dolphin QuadCharger is a four-slot charging station that provides intelligent battery management for Dolphin 9500/9550 
battery packs. It can charge each battery in less than four hours. The fourth slot features a battery analyzer that completely resets 
and re-calibrates a battery and displays its resulting capacity.

Compatibility

The QuadCharger is compatible with the Li-ion batteries that power the Dolphin 9500 series of mobile computing devices.

Charging Process

Each charging slot works independently of the other three. 

As battery packs charge, the charging circuitry follows the two-step charging process (CC-CV) that is recommended for Li-Ion 
batteries. The process monitors changes in temperature, current, and voltage. The charger also resets and calibrates battery 
pack data to accurately show battery status on the Dolphin display.

Use only Dolphin 9500 series peripherals, power cables, and power adapters. Use of peripherals, cables, or power 
adapters not sold/manufactured by HHP will void the warranty and may damage the terminal.

Use only the Li-ion battery packs provided by HHP. The use of any battery pack not sold/manufactured by HHP in the 
Dolphin 9500/9550 terminal will void your warranty and may result in damage to the Dolphin terminal or battery.

Dolphin QuadCharger Parts and Functions

Front Panel 

Charging Slots

The QuadCharger contains four charging slots. Each holds one Dolphin 9500/9550 battery. When a battery is placed 
in each slot, it immediately begins charging.   

!

!

O

SLOT 4BATTERYCAPACITY

100%

0%
ANALYZE

CHARGE/ANALYZE

1

2

3

4

Charging Slots

Status LEDs

Charge/Analyze Slot

Battery Capacity Indicator LEDS

Analyze Button
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Charge/Analyze Slot

This is the fourth slot and the only one that can be used to charge or analyze a battery. When a battery is placed in this 
slot, it begins charging just as it does in the other three slots. However, if you press the ANALYZE button, it runs the 
battery in the slot through the complete Analyze cycle. For more information, see Using the Battery Analyzer on page 
14-4.

Battery Capacity Indicator LEDS

Indicates the progress of the Analyze cycle of the battery in the Charge/Analyze slot.

Analyze Button

Press this button to start a battery analyze cycle. For more information, see Using the Battery Analyzer on page 14-4.

Status LEDs

A status LED is located above each of the four battery slots. The color of the LED indicates the charge status of the 
batteries in its slot. 

Rear Panel

Battery Analyzer

This is Charge/Analyze slot from the rear view.

Power Switch

Toggle the power switch to turn the QuadCharger on and off. 

Power Supply Connector

Use this connector to attach the power supply to the QuadCharger. The universal power supply accepts input voltages 
between 90-265 volts.

Status LED color This color indicates that the battery in the slot…

Green Has completed its charge cycle and is ready for use.

Orange Is being charged at a maximum charge rate.

Red Encountered and error during the most recent charge cycle.

1234

Swc

OCHARGE/ANALYZE

0%
ALYZE

LOT 4
TTERY
PACITY

0%

Power Supply ConnectorPower Switch

Battery Analyer

Status LED
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Supplying Power to the QuadCharger

The charger must be connected to the appropriate power source for any type of operation. 

1. Locate the AC power cord that came with the Dolphin QuadCharger. 

2. Plug the cord into the power supply connector on the back of the unit and then plug the power cord into a wall socket. 

3. Press the power switch to the ON position.
The power LED illuminates green, and the charger performs a self-diagnostic test that lasts approximately five seconds.

Inserting and Removing Battery Packs 

Inserting

To insert a battery pack, place the end of the battery without the locking tab into the bottom of the charging pocket and snap the 
battery into place with a hinging motion. The Status LED for that particular slot illuminates orange when the battery has been 
properly inserted.

Removing

To remove a battery pack, push the locking tab down and pull the battery out from the charging slot with a hinging motion.

Storing Batteries

Recommendations

To maintain top performance from batteries, follow these storage guidelines:

• Avoid storing batteries outside of the specified temperature range of -4 to 104° F (-20 to 40°C) or in extremely high humidity.
• For prolonged storage, do not keep batteries stored in a charger that is connected to a power source. 

Charging Batteries in the QuadCharger

For best results, battery packs should be at room temperature before recharging them; temperature has a marked effect on 
charging. The recommended temperature range is 50° to 95° F (10° to 35° C). 

Complete these steps:

1. Set up the QuadCharger.

2. Supply the QuadCharger with power and turn the power switch on.

3. Insert batteries into the appropriate slots. The Status LED for each slot turns orange to indicate that the battery has begun a 
charge cycle.

4. When the Status LED turns green, the battery in the slot has completed charging.
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Using the Battery Analyzer 

Location

The battery analyzer is located in the fourth slot of the ChargeBase. Only batteries in this slot can be analyzed.

Analyze Cycle

The Analyze cycle is initiated when a battery is placed in the Charge/Analyze slot and the ANALYZE button 
is pressed. In an Analyze cycle, batteries are completely discharged, then recharged to capacity, as well as 
completely reset and re-calibrated. 

The length of time it takes for a battery to complete the Analyze cycle varies depends on initial state of the 
battery’s charge. Minimum time is 8 hours, maximum time is 12 hours.

Battery Capacity Indicator LEDs

The Battery Capacity Indicator LEDs are located along the right side of the Charge/Analyze slot. These LEDs 
display the capacity of the battery at the end of the Analyze cycle. Battery capacity is displayed as a 
percentage of measured capacity/rated capacity. Each LED equates to 10% battery capacity.   

Purpose

Using the Charge/Analyze slot helps you monitor the charge capacity of Li-ion batteries over time. The LEDs 
in this slot provides a readout of the battery’s capacity after a complete discharge and full charge. They tell 
you the maximum charge level the battery can hold. 

Status LED

The Charge/Analyze slot also contains a standard status LED in the upper, left corner of the slot. When this slot is used for regular 
charging, this LED operates in the usual manner; see Status LEDs on page 14-2.

When this slot is being used to analyze a battery, the status LED functions as follows:

To Analyze a Battery
Complete these steps:

1. Insert the battery into the Charge/Analyze slot (the fourth).

2. Press the ANALYZE button. The Status LED flashes orange to indicate that the analyzing cycle has begun.

3. Upon completion of the Analyze cycle, the Status LED lights solid green, and the Battery Capacity Indicator LEDs display the  
battery’s capacity.

The Dolphin QuadCharger is accumulating battery pack information during the entire Analyze cycle. Do NOT remove the 
battery until the cycle has been completed. 

Status LED color Indicates that the battery in the slot…

Solid Green Has completed the Analyze cycle. 

Flashing Orange Is being analyzed. 

Solid Red Encountered an error during the Analyze cycle.

!
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Mounting the QuadCharger

The Dolphin QuadCharger should be on a dry, stable surface. To easily adapt the QuadCharger to your environment, it can be 
mounted on a flat, horizontal surface such as a desktop or workbench, or a flat, vertical surface such as a wall. 

When choosing a location, always bear in mind that 

• the mounting location must allow users easy access to power switch and power connector:
• the QuadCharger should be oriented so that users can easily read the labels, especially for the Battery Analyzer.

Mounting with the DIN Rail

All Dolphin charging/communication cradles have a DIN rail (7.5 X 35 mm) slot on the bottom panel to enable secure mounting. 

To mount the QuadCharger, you slide the DIN rail slot along the bottom panel and secure it. Then, using the appropriate nuts 
and bolts, secure the DIN rail to the desk or wall.    

Desk Mounting
The following graphic displays how to mount the QuadCharger to a desk:    
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Wall Mounting
The following graphic displays how mount a QuadCharger to a wall: 

Troubleshooting

If you encounter problems with your Dolphin QuadCharger, refer to chart below for possible solutions. If problems persist, please 
contact HHP Technical Support. 

Problem Issue

The Status LED does not come on when I 
insert a battery pack into the Dolphin 
QuadCharger

Check the power connections on the Dolphin QuadCharger; make sure 
the POWER switch is ON and the battery pack is properly seated.

The Status LED lights red during charging. Try to charge the battery in one of the other charging slots. If the red 
Status LED comes on again, then the problem is associated with the 
battery pack. If the red status stays with the charging slot, the problem is 
associated with the charging circuity.

The Status LED lights red and stays on 
without a battery in the charging slot.

An error occurred during the self-diagnostic test for that particular 
charging pocket. Call HHP Product Service and request an RMA. 

For additional warranty and return information, see Warranty, Support, 
and Service on page 15-1.
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Warranty, Support, and Service
Limited Warranty

Hand Held Products, Inc., d/b/a HHP (“HHP“) warrants its products to be free from defects in materials and workmanship and to 
conform to HHP’s published specifications applicable to the products purchased at the time of shipment. This warranty does not 
cover any HHP product which is (i) improperly installed or used; (ii) damaged by accident or negligence, including failure to follow 
the proper maintenance, service, and cleaning schedule; or (iii) damaged as a result of (A) modification or alteration by the 
purchaser or other party, (B) excessive voltage or current supplied to or drawn from the interface connections, (C) static electricity 
or electro-static discharge, (D) operation under conditions beyond the specified operating parameters, or (E) repair or service of 
the product by anyone other than HHP or its authorized representatives.

This warranty shall extend from the time of shipment for the duration published by HHP for the product at the time of purchase 
(“Warranty Period”). Any defective product must be returned (at purchaser’s expense) during the Warranty Period to HHP’s 
factory or authorized service center for inspection. No product will be accepted by HHP without a Return Materials Authorization, 
which may be obtained by contacting HHP. In the event that the product is returned to HHP or its authorized service center within 
the Warranty Period and HHP determines to its satisfaction that the product is defective due to defects in materials or 
workmanship, HHP, at its sole option, will either repair or replace the product without charge, except for return shipping to HHP.

EXCEPT AS MAY BE OTHERWISE PROVIDED BY APPLICABLE LAW, THE FOREGOING WARRANTY IS IN LIEU OF ALL 
OTHER COVENANTS OR WARRANTIES, EITHER EXPRESSED OR IMPLIED, ORAL OR WRITTEN, INCLUDING, WITHOUT 
LIMITATION, ANY IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE.

HHP’S RESPONSIBILITY AND PURCHASER’S EXCLUSIVE REMEDY UNDER THIS WARRANTY IS LIMITED TO THE 
REPAIR OR REPLACEMENT OF THE DEFECTIVE PRODUCT. IN NO EVENT SHALL HHP BE LIABLE FOR INDIRECT, 
INCIDENTAL, OR CONSEQUENTIAL DAMAGES, AND, IN NO EVENT, SHALL ANY LIABILITY OF HHP ARISING IN 
CONNECTION WITH ANY PRODUCT SOLD HEREUNDER (WHETHER SUCH LIABILITY ARISES FROM A CLAIM BASED 
ON CONTRACT, WARRANTY, TORT, OR OTHERWISE) EXCEED THE ACTUAL AMOUNT PAID TO HHP FOR THE 
PRODUCT. THESE LIMITATIONS ON LIABILITY SHALL REMAIN IN FULL FORCE AND EFFECT EVEN WHEN HHP MAY 
HAVE BEEN ADVISED OF THE POSSIBILITY OF SUCH INJURIES, LOSSES, OR DAMAGES. SOME STATES, PROVINCES, 
OR COUNTRIES DO NOT ALLOW THE EXCLUSION OR LIMITATIONS OF INCIDENTAL OR CONSEQUENTIAL DAMAGES, 
SO THE ABOVE LIMITATION OR EXCLUSION MAY NOT APPLY TO YOU.

All provisions of this Limited Warranty are separate and severable, which means that if any provision is held invalid and 
unenforceable, such determination shall not affect the validity of enforceability of the other provisions hereof.

The limited duration of the warranty for the Dolphin 9500 and Dolphin 9550 terminals is as described below:

• Terminals with an integrated imager are covered by a two-year limited warranty.   
• Touch screens are covered by a one-year limited warranty.
• The limited duration of the warranty for the Dolphin HomeBase, Mobile Base, Mobile Charger, and QuadCharger is one year. 
• The limited duration of the warranty for batteries is one year. Use of any battery not sold/manufactured by HHP may damage 

the terminal and/or the battery and will void the warranty. Batteries returned to HHP in a reduced state may or may not be 
replaced under this warranty. Battery life will be greatly increased when following the battery instructions in this user’s guide.

• Use of any peripheral with the Dolphin terminal not manufactured/sold by HHP will void the warranty. This includes but is not 
limited to: cables, power supplies, cradles, and docking stations. 

• Use only power adapters approved for use by HHP. Failure to do so may result in improper operation or damage to the unit 
and will void the warranty.

Hand Held Products, Inc. extends these warranties only to the first end-users of the products. These warranties are non-
transferable.

How to Extend Your Warranty
HHP offers a variety of service plans on our hardware products.  These agreements offer continued coverage for your equipment 
after the initial warranty expires.  For more information, contact your HHP sales representative, customer account representative,  
the Product Service Marketing Manager, or your Authorized Reseller. 
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Return Information

Should your unit or any of the peripherals prove to be defective within the stated warranty period from the date of purchase, return 
the product, as described in the Repair Maintenance Authorization (RMA) procedures below, and we will, at our option, repair or 
replace the product, to whatever extent HHP deems necessary to restore the product to proper operating condition, without any 
charge to you.

You must obtain an RMA number to receive service from any of HHP’s repair facilities. Failure to obtain an RMA number before 
shipping your product to this repair facility can delay the processing of your repair request.  Please contact the Product Service 
facility (numbers listed below) nearest you to receive an RMA number.  

If you purchased the product from an Authorized HHP Reseller, contact the Reseller with the unit's serial number.  Your Reseller 
will contact HHP, on your behalf, to arrange for the unit to be serviced.

Calling for an RMA Number
If you purchased the product directly from HHP, or have been instructed by your Reseller to contact HHP directly, call the Product 
Service Department in your area to request an RMA number. 

You can also access product service and repair online at : http://www.hhp.com/hhp/service/contactservice.tpl.

Requirements

When calling for service at any of our repair facilities, please be prepared to give the following information:

• Product type and serial number 
• Brief description of problem 
• Dated proof-of-purchase

If your equipment is still covered under the initial end-user's product warranty, please notify the Product Services Representative 
when you call.

Service and Repair Locations.

Shipping
Please make note of the RMA number (if required) and the product's serial number before shipping. 

If you must return your unit, place the product in its original packaging with a copy of your original invoice (this helps avoid 
possible service delays) and ship the product prepaid to the appropriate address below. For your protection, we recommend you 
insure any equipment being sent to HHP.

Write the RMA number on the mailing label under the address.\

Repair
After repair or replacement of the equipment, HHP will ship the product, at our cost, to your location. Non-warranty repairs will 
be returned, at the customer's expense, unless otherwise requested.  Units currently under a service agreement will be shipped 
per the service agreement.

North America/Canada

HHP Corporate Offices
Telephone: (800) 782-4263, option 3
Fax: (704) 566-6015
E-mail: ProductService@hhp.com

Latin America

HHP Latin America
Telephone:   +1 239-263-7600
Fax:   +1 239-263-9689
E-mail: LASupport@hhp.com

Asia Pacific

HHP Asia/Pacific
Telephone:   +852-2511-3050 
Fax:   +852-2511-3557
E-mail: chuie@hhp.com

Europe, Middle East, and Africa 
(EMEA)

HHP Europe
Telephone:+ 31 (0) 40 29 01 633
Fax: + 31 (0) 40 2901631
E-mail: EuroService@hhp.com

Brazil

HHP Brazil
Telephone: +55 (21) 2494-7060
Fax: +55 (21) 2494-5033
E-mail: suporte@hhp.com.br

Japan

HHP Japan
Telephone: +813 5842 6325
Fax: +813 5842 6335 
E-mail: KobayashiT@hhp.com
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Technical Assistance

If you have a question or problem with your unit, you can obtain technical assistance from HHP’s Application Support department.

North America/Canada:

Telephone: (800) 782-4263, Option 4 (8 a.m. to 6 p.m.  EST)
Fax number: (315) 685-4960
E-mail: support@HHP.com

Europe, Middle East, and Africa:

Telephone 
European Ofc: +31 (0) 40 29 01 600
U.K. Ofc: +44 1925 240055
E-mail: euro_support@HHP.com

Asia:

Telephone: +852-2511-3050
E-mail: asia_support@HHP.com

Latin America:

Telephone: (239) 263-7600
E-mail: la_support@HHP.com

Assistance Online
You can also access technical assistance online at: http://www.hhp.com/hhp/service/contacttech.tpl.

FTP Server
Downloads are available at: ftp://hhpftp.handheld.com/Pub/AppSupport/.
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 Appendix A - Keyboards

Overview

This appendix provides useful tools for programming and managing your Dolphin 9500/9550 terminal. 

General Windows Keyboard Shortcuts
Use the keyboard shortcuts in the chart below to navigate the Dolphin 9500 and Dolphin 9550 terminal keyboards. These are 
standard keyboard shortcuts for Windows applications.    

Press these keys, To…

CTRL + C Copy

CTRL + X Cut

CTRL + V Paste

CTRL + Z Undo

DELETE Delete

CTRL + RIGHT ARROW Move the insertion point to the beginning of the next word.

CTRL + LEFT ARROW Move the insertion point to the beginning of the previous word.

CTRL + DOWN ARROW Move the insertion point to the beginning of the next paragraph.

CTRL + UP ARROW Move the insertion point to the beginning of the previous paragraph.

SHIFT with any of the arrow keys Select more than one item in a window or on the desktop, or select text 
within a document.

CTRL+A Select all.

ALT+ENTER View properties for the selected item.

ALT+TAB Switch between open items.

ALT+ESC Cycle through items in the order they were opened.

ALT + Tap on Touch screen Right-click

CTRL+ESC Display the Start menu.

ALT+Underlined letter in a menu name Display the corresponding menu.

Underlined letter in a command name on an open 
menu

Carry out the corresponding command.

BACKSPACE View the folder one level up in My Computer or Windows Explorer.

ESC Cancel the current task.

A
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43-Key Alpha/Numeric Keyboard   

Blue Key Functions and Characters 
The following table displays the special functions performed and characters inserted using the blue key. 

Key Combination Function/Special Character

Blue key +  D - (minus)

Blue key +  H _ (underscore)

Blue key +  L =

Blue key +  P +

Blue key +  Q ;

Blue key +  R :

Blue key +  S *

Blue key +  T /

Blue key +  U @

Blue key +  X \

Blue key +  Y START
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Red Key Functions and Characters 
The following table displays the special functions performed and characters inserted using the red key.  

* Exit the mouse utility prior to adjusting the contrast.

Key Combinations 
Use the key combinations listed below to access certain keyboard functions or to use special characters that are not defined on 
the 43-key version of the Dolphin 9500/9550 keyboard.   

Key Combination Function/Special Character

Red key +  ESC Lightens Contrast*

Red key +  TAB Darkens Contrast*

Red key + SFT Toggles on Caps Lock

Red key +  Q F1

Red key +  R F2

Red key +  S F3

Red key +  T F4

Red key +  U F5

Red key +  V F6

Red key +  W F7

Red key +  X F8

Red key +  Z INS (insert)

Red key +  SP BKSP (backspace)

Red key +  BACKLIGHT KEY DEL (delete)

Key/Key Combination Function/Special Character

NUM + SFT + A !

NUM + SFT + B @

NUM + SFT + C #

NUM + SFT + E $

NUM + SFT + F %

NUM + SFT + G ^

NUM + SFT + I &

NUM + SFT + J *

NUM + SFT + K (

NUM + SFT + M >

NUM + SFT + N )

NUM + SFT + O <
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Key Combinations Using Blue + Sft Keys 

Miscellaneous Key Combinations  

Key/Key Combinations Function/Special Characters

SFT + Blue + T ?

SFT + Blue + X >

Key/Key Combinations Function/Special Characters

NUM + ALT + 3 + 9 ‘

NUM + ALT + 3 + 4 “
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35 Key Numeric/Alpha Keyboard

Blue Key Functions and Characters   

Key Combination Function/Special Character

Blue key +  . +

Blue key +  , -

Blue key +  F1 ;

Blue key +  F2 :

Blue key +  F3 /

Blue key +  F4 \

Blue key +  SP +

Blue key + DEL -
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Key Combinations 
Use the key combinations listed below to access certain keyboard functions or to use special characters that are not defined on 
the 35-key version of the Dolphin keyboard. 

Key Combinations Using Alpha + SFT Keys   

ALT Key Combinations    

Key/Key Combination Function/Special Character

ALPHA + SFT + 1 !

ALPHA + SFT + 2 @

ALPHA + SFT + 3 #

ALPHA + SFT + 4 $

ALPHA + SFT + 5 %

ALPHA + SFT + 6 ^

ALPHA + SFT + 7 &

ALPHA + SFT + 8 *

ALPHA + SFT + 9 (

ALPHA + SFT + 0 )

Key/Key Combinations Function/Special Characters

Hold the ALT key down as you type in the numbers.

ALT + 3 + 9 ‘

ALT + 3 + 4 “
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56 Key Full Alpha Numeric

Blue Key Functions and Characters  

Red Key Functions and Characters    

Key Combination Function/Special Character

Blue key +  . +

Blue key +  , -

Blue key +  A ;

Blue key + B @

Blue key +  E _

Blue key +  F :

Key Combination Function/Special Character

Red key +  ESC Lightens Contrast*

Red key +  TAB Darkens Contrast*

Red key + SFT Toggles on Caps Lock

Red key +  A F1

Red key +  B F2

Red key +  C F3

Red key +  D F4
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* Exit the mouse utility prior to adjusting the contrast.

Red key +  E F5

Red key +  F F6

Red key +  G F7

Red key +  H F8

Red key + I F9

Red key + J F10

Red key + K F11

Red key + L F12

Red key + M F13

Red key + N F14

Red key + O F15

Red key + P F16

Red key + Q F17

Red key + R F18

Red key + S F19

Red key + T F20

Red key + U F21

Red key + V F22

Red key + W F23

Red key + X F24

Red key + Y Z

Key Combination Function/Special Character
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Key Combinations 
Use the key combinations listed below to access certain keyboard functions or to use special characters that are not defined on 
the 56-key version of the Dolphin keyboard.

SFT Key Combinations   

ALT Key Combinations   

Key Combination Function/Special Character

 SFT + 1 !

SFT + 2 @

SFT + 3 #

SFT + 4 $

SFT + 5 %

SFT + 6 ^

SFT + 7 &

SFT + 8 *

SFT + 9 (

SFT + 0 )

SFT + .  (period) >

SFT + , (comma) <

Key Combinations Function/Special Characters

Hold the ALT key down as you type in the numbers.

ALT + 3 + 9 ‘

ALT + 3 + 4 “
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Com Port Assignment Table 

Com Port Assignment

Com Port 1 Serial port. This is the 17-pin connector on the bottom panel of  
Dolphin 9500/9550 terminals.

Com Port 2 Bluetooth Module

If there is no Bluetooth hardware installed on the terminal, this com 
port is unassigned.

Com Port 3 Raw Infrared

Com Port 4

Com Port 5 USB virtual serial port

Com Port 6 IrDA, if IrDA is enabled. 

If IrDA is disabled, this com port becomes available. See To 
Disable the IrDA Port on page 5-7.

Com Ports 7-9 Unassigned. 

These are available for selection only when connecting to devices 
that use virtual com ports, such as Bluetooth.
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